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In This Guide…
In This Guide…

Agilent OpenLab ChemStation provides great flexibility for research and method 
development laboratories by supporting advanced features and workflows of 
Agilent GC, LC and CE instruments with add-on software and advanced method 
development. This guide describes all the concepts of OpenLab ChemStation in 
detail.

This manual also explains the efficient use of the data acquisition, analysis, and 
reporting functions in ChemStation to boost your lab’s productivity.

1 Basic Concepts of ChemStation

This chapter explains the principles of working with ChemStation, including 
remote control, the graphical interface and the ChemStation views.

2 Working with Methods

Methods are a vital part of how OpenLab ChemStation works. OpenLab 
ChemStation is a chromatography data system with great flexibility for method 
development. This chapter explains the concepts of methods in detail.

Table 1 Terms and abbreviations used in this document

Term Description

AIC Agilent's Analytical Instrument Controller

ChemStation OpenLab ChemStation

Control Panel OpenLab Control Panel

Microsoft Control Panel Part of the Microsoft Windows operating system

LTS Long-term Support

Single Run Individual analysis of a single sample that is 
triggered by running a method or queueing a 
method. Single runs may also be submitted as a 
series of method runs defined in the sequence 
table.
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In This Guide…
3 Data Acquisition

OpenLab ChemStation offers seamless instrument control of Agilent LC, GC, CE, 
CE/MS, and LC/MS systems. It supports advanced features and workflows of 
Agilent GC and LC instruments with add-on software and provides flexibility for 
research and method development laboratories. This chapter contains an 
introduction to the process of acquiring analytical data.

4 Automation/Sequences

This chapter describes the concepts of automation. It explains how to work with 
sequences in ChemStation, what happens when a sequence is run and how to 
customize sequences.

5 Run Control

This chapter explains the concepts of Run Queue and Queue Planner. It explains 
how to add single samples, sequences, pauses, or commands to the Run Queue. 
It also describes the Command Scheduler in which you can schedule events to 
make your everyday lab work easier.

6 Data Analysis and Review Concepts

You can analyze and review your data with ChemStation. This chapter outlines 
the ChemStation data analysis and data review options.

7 Calibration

This chapter explains the concepts of calibration.

8 Reporting

This chapter describes the concepts of Intelligent Reporting and Classic 
Reporting.

9 CE specific Concepts and Functions

This chapter is relevant only if you use ChemStation to control CE instruments.
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1 Basic Concepts of ChemStation
Introduction
Introduction

ChemStation provides full instrument control of Agilent's LC, GC, CE, CE-MS and 
LC-MS instrumentation. It offers tools for data acquisition, analysis and 
interpretation using a multi-technique, multi-vendor instrument control. Start the 
chromatography software from the OpenLab Control Panel, where you access all 
functions provided by OpenLab Shared Services.
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1 Basic Concepts of ChemStation
About the ChemStation Software
About the ChemStation Software

Data Integrity
ChemStation files such as data, methods, or sequences are stored in various 
local folders. To ensure data integrity, ChemStation offers the Secure File I/O 
function. If you enable this function, all folders will be protected against 
modifications from outside ChemStation or in Open or Save As dialogs.

For more information, refer to the Folder Protection with Secure File I/O chapter in 
the OpenLab ChemStation Configuration Guide (CDS_CS_configure.pdf).

Central Data Storage
A central data storage system can hold all kinds of electronic data independent 
of any proprietary data formats. ChemStation raw data (and other 
human-readable documents, such as workbooks) are stored together with 
metadata; this allows the data to be searched very easily. ChemStation methods, 
sequence templates, report templates, and data files (sequences and single runs) 
can be uploaded to the central repository, and later downloaded back into the 
ChemStation if required.

Agilent provides two systems for central data storage:

• OpenLab Server is available as a single-server solution providing centralized 
data management for small to medium laboratories with up to 30 
instruments. It provides the necessary security in support of regulatory 
compliance. Please see OpenLab Server documentation for further 
information.

• OpenLab ECM is available as a single-server solution or a multi-server, 
distributed solution for comprehensive data management needs for 
laboratories with a few instruments to 100s of instruments. It also provides 
the necessary security in support of regulatory compliance. Please see 
OpenLab ECM documentation for further information.

For more information on the concepts of ChemStation with central data storage, 
refer to the OpenLab ChemStation with Content Management Systems - 
Administrator's Guide.
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1 Basic Concepts of ChemStation
About the ChemStation Software
Methods and Sequences
The analytical method fully describes how a particular separation is performed. It 
contains all parameters for instrument control, data acquisition and evaluation, 
including integration, quantification and reporting. The system may be set up to 
acquire data from a number of samples by different methods. The control file for 
this sort of operation is called a sequence. It holds the individual sample 
information, references to the appropriate methods, automatic recalibration 
specifications, and reporting instructions for a summary report across all runs in 
the sequence. For further information on methods and sequences, see 
“Automation/Sequences” on page 78 and the online help system.

System Configuration
The configuration of the instrument system is done through the OpenLab Control 
Panel which starts the configuration editor program. It allows you to define your 
instruments, their LAN addresses, the directories for your data, sequences and 
methods and the initial screen size of the ChemStation software. In addition, you 
can activate or deactivate Intelligent Reporting and 3D Spectral Evaluation, and 
you can define the method download options.

Acquisition Method Viewer
With the Acquisition Method Viewer, you can check the acquisition parameters 
stored in a method, independently of the current instrument configuration. You 
can choose to either apply this method in its original version to the instrument, or 
to resolve this method against the current instrument configuration.
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1 Basic Concepts of ChemStation
About the ChemStation Software
Method Download Options
The method download options define the behavior of ChemStation, if the last 
selected method from the previous instrument session differs from the current 
instrument settings. You can choose among the following options:

• Download method to instrument

The last selected method is downloaded to instrument. The instrument 
settings will be overwritten. This behavior corresponds to ChemStation 
revisions C.01.03 or lower.

• Upload method from instrument

The instrument settings are uploaded into the last selected method. The 
method will be marked as modified.

• New method from instrument

The instrument settings are uploaded into a newly created ChemStation 
method.

• Always ask user to choose an option

At ChemStation startup, a dialog is shown where you can choose on of the 
options described above. In this dialog, you can also compare the instrument 
settings for each module with the settings in the last selected method.

When comparing the differences, you can either display the entire list of 
settings, or display only the differences.

Data Model
The ChemStation software is designed around a data model based on a memory 
structure called a register. Registers are multipurpose structures that can hold 
analytical data and information for both two-dimensional information (for 
example, time/intensity) and three-dimensional information (for example, 
time/intensity/wavelength).

ChemStation provides commands and functions to construct, expand, extract 
and, where it does not alter primary data, edit registers. For further information, 
see the online reference in ChemStation under Help >Commands.
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1 Basic Concepts of ChemStation
About the ChemStation Software
File Naming Conventions

File Names and Tokens

In most of the ChemStation dialogs where you enter a path name or file name, 
you can use tokens to dynamically generate suitable names. Depending on the 
file or path name that is set in a given dialog, different tokens are available. In the 
following screens, several tokens are used as examples.

The control for file names has the following appearance:

The control for path names has the following appearance:

In each corresponding dialog, the resulting file name or path name is displayed 
additionally.

You have the following options to work with this type of fields:

• Add static text.

• Click the Arrow button ( ) to choose a token from the list.

Press the Arrow Down key to choose a token from the list.

• Right-click one of the tokens already used to replace it by another token from 
the list.

• Click the X button to delete the current content of the field.

• Click the button with the three dots ( ) to browse for the required path.

 Choose token    

 Delete content    

 Tokens are displayed in blue color and with an underline    

Tokens are displayed in blue color and with an underline

Delete content

Choose token

Browse for location
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1 Basic Concepts of ChemStation
About the ChemStation Software
Naming Conventions

Make sure you only use the following characters for ChemStation items such as 
file or directory names, names of sequence templates, or names of ChemStation 
methods:

Check your names for leading or trailing blanks. They are not allowed, but are 
easily overlooked.

The following reserved device names cannot be used as the name of a file. Also 
avoid these names followed by an extension (e.g. Nul.txt):

• CON, PRN, AUX, NUL

• COMx (where x is a number from 1 to 9)

• LPT1x (where x is a number from 1 to 9)

A-Z, a-z, 0-9, _ (underscore), - (hyphen)

NOTE If you use tokens, file names or directory names are automatically created based 
on information such as instrument names, operator names, or sample names. 
Make sure that these names follow the same naming convention.

NOTE Automatically created file names may include specific characters for Front and 
Back injector location. These characters may be localized. They are valid even if 
they are not part of the characters listed above.

NOTE English, Japanese, and Chinese operating systems are used to test naming 
conventions. Agilent cannot give a support statement for non-English operating 
systems and their special characters.
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1 Basic Concepts of ChemStation
About the ChemStation Software
Maximum Length of ChemStation file names and subdirectories

The Agilent ChemStation specifications for file names and subdirectories are 
listed below:

All ChemStation logbooks report system messages in an extended format and 
information strings are printed over multiple lines. Certain reports, e.g. Sequence 
report, may truncate filenames to fit all information onto the report template.

All paths are limited to 260 characters by the Windows operating system. Some 
of the characters are invisibly used by the operating system. Therefore you may 
need to use shorter names even all specifications listed above are met.

Table 2 Maximum length of ChemStation file names and subdirectories

DataFile/Subdirectory/Path Max. Input 
Length

Auto 
append

Example

Data file name of single sample 60 .D Demodad.d

Data file name in a sequence, using 
prefix/counter

60 .D longname000001.d

Data file name in a sequence, using a 
name pattern

60 .D 05-1-sampleA.d

Method
Sequence
Libraries
Customized Report Templates

60 . M
. S
. UVL
. FRP

def_lc.m
def_lc.s
demodad.uvl
areapct.frp

Data file subdirectory 40 demo (in sample information)

Data sequence subdirectory 40 demo (in sequence 
parameters)

Data Path
Method Path
Sequence Path
Libraries Path
Customized Report Template Path

149 C:\Users\Public\Documents\
ChemStation\1\data
C:\Users\Public\Documents\
ChemStation\1\methods
C:\Users\Public\Documents\
ChemStation\1\sequence
C:\Users\Public\Documents\
ChemStation\speclib
C:\Users\Public\Documents\
ChemStation\repstyle
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Data Files
A data file comprises a group of files, by default stored in the DATA directory or in 
a subdirectory of this folder as a subdirectory with a data file name and a .D 
extension. A data file name can be defined manually using up to 42 characters 
(including the extension). Each file in the directory follows a naming convention 
(see “File Naming Conventions” on page 13). Additional data directories can be 
added using the Preferences settings.

Table 3 Data files

Name Description

*.CH Chromatographic/electropherographic signal data files. The file name 
comprises the module or detector type, module number and signal or 
channel identification. For example, ADC1A.CH, where ADC is the module 
type, 1 is the module number and A is the signal identifier and .CH is the 
chromatographic extension.

*.UV UV spectral data files. The file name comprises the detector type and device 
number (only with diode array and fluorescence detector).

*.ms LCMS spectral data files

REPORT.TXT, 
REPORT.PDF

Report data files for the equivalent signal data files.
Note: the PDF filename can be different if you use Unique PDF file naming.

Acq.MACAML The file contains information on the method used during data acquisition. 
The information is stored in the ACAML format. ACAML files are used by 
Intelligent Reporting.

Sequence.ACAM_ The file contains the single injection results. The information is stored in the 
ACAML format. ACAML files are used by Intelligent Reporting.

SAMPLE.MAC or 
SAMPLE.XML

This file is used to store the sample values

SAMPLE.MAC.BAK or 
SAMPLE.XML.BAK

Backup of the original sample.mac. The .bac file is created during 
reprocessing, when the sample parameters (like multipliers) are updated 
the first time. It stores the original sample values used during acquisition.

RUN.LOG Logbook entries which have been generated during a run. The logbook 
keeps a record of the analysis. All error messages and important status 
changes of ChemStation are entered in the logbook.

LCDIAG.REG For LC only. Contains instrument curves (gradients, temperature, pressures, 
etc.), injection volume and the solvent descriptions.

ACQRES.REG Contains column information. For GC it also contains the injection volume.
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1 Basic Concepts of ChemStation
About the ChemStation Software
Software User Interface
The ChemStation user interface is designed into views that group software 
functionality according to typical analytical tasks. The following standard views 
are present in all software configurations:

• the Method and Run Control view for controlling and acquiring data from the 
instrument

• the Data Analysis view for reevaluating data that has been acquired

• the Review view for reviewing the data using specific report templates

• the Report Layout view for designing specific report layouts

Additional views are present if additional data evaluation modules have been 
ordered or for certain instrument configurations that support instrument 
diagnostics and verification procedures.

The Navigation Pane contains the Navigation Buttons, to allow rapid switching 
between the ChemStation views, and the tree-based ChemStation Explorer. The 
contents of the ChemStation Explorer are view-dependent, giving access to 
different ChemStation elements.

Each view consists of a set of standard user elements including menus and 
toolbars. The standard toolbar provides rapid access to the common system 
specification information such as methods and sequences. The Method and Run 
Control view additionally incorporates a system status bar, a sample information 
area, which may be configured for single runs or automated runs, and a 
schematic instrument interface diagram for GC, CE and LC configurations. The 
schematic instrument interface diagram uses hot spots to allow rapid access to 
instrument parameters and an animated graphical overview of the status of each 
analysis as it proceeds. The schematic instrument diagram may be turned off if it 
is not required, to save memory and other Windows resources. The Run Queue 
tab also integrated in this view displays all sequences, samples and commands 
that are scheduled for the instrument and also allows you to organize and 
process this worklaod (see “Using the Run Queue” on page 145).

GLPSAVE.REG Part of the data file when Save GLP Data is specified.

M_INTEV.REG Contains manual integration events.

Table 3 Data files

Name Description
ChemStation Concepts and Workflows 17



1 Basic Concepts of ChemStation
About the ChemStation Software
The Data Analysis view extends the standard toolbar to specific data analysis 
modes including recalculation, reprocessing, integration, calibration, reporting, 
annotation, signal comparison and additional specialized modes if the modules 
are installed. Each of these separate data analysis modes are supported with a 
mode-specific toolset.

The Review view is available if Intelligent Reporting is selected for the instrument. 
This view allows you to review the data in a very flexible way. You can select any 
combination of data files as a basis for the review, and apply any existing report 
template to the selected data. The selected report template defines the way in 
which the data is shown and which type of information is included in the 
generated report. The toolbar provides functions for printing and exporting the 
generated reports.

The Report Layout view allows you to define the layout of a specific report 
template or report style. It also uses a set of toolbars specific to this task. The 
type of Report Template editor shown in this view depends on the type of 
reporting that is configured for the instrument. You can either use Classic 
Reporting or Intelligent Reporting (see “Reporting” on page 189).

Navigation Pane

A Navigation Pane, available on the left side of all ChemStation views, is designed 
to speed access to many key ChemStation elements, as well as enabling quick 
switching between views. The Navigation Pane contains the tree-based 
ChemStation Explorer and a configurable button area. It also includes an 
autohide feature so that the ChemStation workspace is not compromised, and 
offers standard features such as resizing, and re-arranging of the navigation 
button area.

Navigation Buttons

The Navigation Buttons allow the ChemStation view to be switched by clicking on 
the specific Navigation Button. The Navigation Button section can be minimized, 
expanded and re-arranged.

ChemStation Explorer

The contents of the Navigation Pane are view-dependent. For Method and Run 
Control, Data Analysis, Review, and Report Layout, the ChemStation Explorer 
allows you to navigate to the different ChemStation elements. By default, these 
elements for data, methods and sequences are based on the configuration editor 
settings. New nodes for methods, sequences, data location can be specified 
using the “Preferences” option in the view menu.
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Data Acquisition
The status of the instrument is continually monitored and updated on the display, 
along with the elapsed run time of the analysis both when the software is a 
visible window and when it is iconized. The transactions that occur during the 
analysis, including any errors and the instrument conditions at the start and the 
end of the analysis, are recorded in the system’s logbook, an extract of which is 
stored with every data file.

The instrument conditions, such as flow, temperature, pressure and solvent 
composition for liquid chromatographs may be recorded and stored with each 
data file. These instrument parameters can be displayed and plotted to testify to 
the quality of each analysis. The exact nature of the parameters recorded 
depends both on the technique and the capabilities of the configured instrument.

All regular data acquisitions - single samples as well as sequence runs - are first 
added to the Run Queue and then started from there. For more information, see 
“About the Run Queue” on page 143.

One or more display windows may be used to monitor the data being acquired by 
the instrument in real time. The data are displayed in real measurement units 
such as mAU, Volts, degrees or bar. The windows may each show multiple 
overlaid chromatographic/electropherographic signals or instrument 
parameters, such as pressure. The display default settings may be adjusted and 
are remembered by the system so users can set their own preferred settings as 
the instrument default. The window has zoom capability and the cursor may be 
used to display a specific signal’s response at any point in time.

Table 4 Navigation Pane items

Navigation Buttons ChemStation Explorer Elements

Method and Run Control Sequence templates / Master methods, Result Set 
methods

Data Analysis Data / Master methods, Result Set methods

Review Data / Report templates

Report Layout Classic Reporting: Master methods
Intelligent Reporting: Report Templates

Verification (LC and LC/MS) Verification view-specific shortcuts

Diagnosis (LC/MS) Diagnosis view-specific shortcuts

Tune (LC/MS) Tune view-specific shortcuts
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During an analysis, the complete functionality of ChemStation can be used 
through the offline copy. While acquisition is running, the Data Analysis part of 
the online session of an instrument is not accessible, and data review has to be 
performed in the offline copy.

A snapshot function is available for users who wish to start processing data 
before the analysis is completed. The snapshot has to be taken in the offline 
copy of the instrument sessions and is immediately present for review.

The layout of the signal and status information windows, including the 
components of the schematic instrument interface diagram is saved 
automatically.

For further information on Data Acquisition, see “Data Acquisition” on page 69 
and the online help system.

Retention Time Locking
A retention time is the fundamental qualitative measurement of chromatography. 
Most peak identification is performed by comparing the retention time of the 
unknown peak to that of a standard. It is much easier to identify peaks and 
validate methods if there is no variation in the retention time of each analyte. 
However, shifts in retention time occur frequently. Routine maintenance 
procedures such as column trimming alter retention times. In a multi-instrument 
laboratory running duplicate methods, the retention times for each instrument 
can differ from each other, even when run under nominally identical conditions. 
These differences in retention times will require at a minimum a recalibration 
with update of the retention time and may mean that each instrument session 
must have a separate calibration and integration event table, making it 
time-consuming to transfer methods from one system to another. Differences in 
retention time can require additional work when comparing data between 
instruments over time.

Retention time locking (RTL) allows a close match of retention times on one GC 
system to another system with the same nominal column type (same stationary 
phase, column diameter, length, and phase ratio (film thickness)). Using the 
retention time/pressure calibration from the initial Retention Time Locking setup, 
RTL determines the new inlet pressure needed to update (relock) the GC's 
method inlet pressure when an analyte peak has shifted. This locked method can 
now be loaded on another GC to update the inlet pressure to match retention 
times.
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Data Analysis

Data Analysis — Options

"Classic" Data Analysis is a feature in ChemStation. An overview is provided on 
the next pages. For more details, see “Data Analysis” on page 153.

Data Analysis — Display

The ChemStation Data Analysis view extends the standard tool bar with 
task-grouped data analysis functions including recalculation, reprocessing, 
integration, calibration, reporting, annotation, and signal comparison toolsets. 
The following key graphical operations are possible:

• single or multisignal displays selectable when loading the 
chromatogram/electropherogram,

• overlays of chromatogram/electropherogram from different samples,

• subtraction of one chromatogram/electropherogram from another,

• graphical vertical and horizontal alignment of signals to help visual 
comparison,

• signal inversion or mirroring to help visual comparison,

• displays of extended peak performance characteristics for specific integrated 
peaks,

• graphical zoom and scrolling functions,

• adjustment of display attributes including selection of tick marks, baselines, 
axes, retention/migration times and compound names (you can also select 
the font for the retention time (RT) and compound labels, adjust the size and 
orientation of the display, select the display as overlaid or separated and 
select scaling factors),

• the chromatogram/electropherogram display may include graphical overlays 
of instrument parameters depending on the capability of the configured 
instrument,

• user-defined annotations may be interactively added to the display, with the 
selection of font, size, text rotation and color (once defined, the annotations 
may be graphically moved, edited or deleted),

• copy the display to the Windows clipboard in both metafile and bitmap 
format,
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• a pick mode function to display the values of individual data points in detector 
units, and

• export of time/intensity digitized points to the Microsoft Windows clipboard.

Data Analysis — Integration

The ChemStation integrator algorithm is the second revision of a new generation 
aimed at improved ruggedness, reliability and ease-of-use.

Data Analysis — Quantification

The ChemStation’s calibration mode of the data analysis view allows 
simultaneous display of:

• the signal or signals being calibrated with an indication of the current 
compound’s retention/migration time window,

• the calibration table whose display may be configured from a comprehensive 
selection of calibration parameters, and

• the calibration curve for the compound being calibrated.

All the calibration mode windows are linked so that changes in one are 
automatically reflected in all the others. This mode allows graphical selection and 
modifications of the calibration data.

Quantification is based on %, Normalized %, External standard, External standard 
%, Internal standard and Internal standard % calculations calculated on either 
peak area or height. Calibrations may be multilevel and include multiple internal 
standard definitions. Calibration histories are automatically saved and can be 
used to weight the recalibration calculations.

For information on calibration and quantitation, see “Calibration” on page 174.

Data Analysis — Batch Review 

The Batch Review report can be used to review results for each compound for 
each sample. It offers the following key graphical operations:

• define automatic or manual review and reprocess of (calibrated) data files

• recalibration of calibration table

• review compound tables of calibrated methods

• create specific batch reports
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The Navigation Table offers several key graphical operations:

• standard table configuration features, such as sorting, drag-and-drop options, 
column selection, item grouping to specify a preferred navigation table 
configuration

• right mouse click functions to load a signal, overlay a signal, export data, print 
reports

• review signal details by expanding a line in the navigation table

• review signals and create ChemStation reports using a specific method

Batch Review allows saving manual integration events per run. It is possible to 
save manual events with the data file outside of Batch Review. To avoid conflicts 
with two sets of manual integrations, any manual events that have been stored 
with the data file will not be applied in Batch Review.

There are a few points to watch out for:

• The recalibration methodology in Batch Review differs from the recalibration 
in the original sequence. Pressing the update calibration button on the batch 
review toolbar causes the system to recalibrate with all calibration runs in the 
batch, creating a recalibrated calibration table. Pressing the Start button on 
the Batch Review toolbar will then recalculate amounts for each calibrated 
compound. The amounts for all samples will be calculated from the 
recalibrated calibration table.

• Clicking a line on the Batch Review sample table causes the associated data 
file to be loaded. Some large data files may take a significant amount of time 
to load. This is no different than using Load Signals to load the same data file.

• The Batch Review report gives results for each compound for each sample. 
Because some calibration tables have large numbers of compounds this may 
lead to quite large Batch Review reports.

• Batch Review allows saving manual integration events per run. It is also 
possible to save manual events with the data file outside of Batch Review. To 
avoid conflicts with two sets of manual integrations, any manual events that 
have been stored with the data file will not be applied in Batch Review.

If you use ChemStation with central data storage, the Batch view is by default 
disabled. It can be enabled by an entry in the [PCS] section of the ChemStation.ini 
file: [PCS] _BatchReview=1. The ChemStation.ini file is located in the C:\
ProgramData\Agilent Technologies\ChemStation directory.
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Data Analysis — Recalculation

The functions in the recalculation mode allow you to quickly generate results or 
reports for any subset of data shown in the Navigation Table. You can easily 
generate results for self-assembled data sets, independent of the sequences the 
samples were originally acquired in. You can use any method for recalculation. 
The method used will be copied to the single data files (DA.M). No calibration is 
done during recalculation.

Data Analysis — Reprocessing

The functions in the reprocessing mode allow you to reprocess one entire 
sequence, using the methods defined in the sequence table and using the results 
of the calibration samples to calculate the sample results.

Data Analysis — Last Results

In this mode, the data file method (DA.M) for each run is loaded. DA.M is an exact 
copy of the method which was used for the last data analysis (during acquisition, 
reprocessing, or recalculation). The Last Result mode allows you to reproduce 
the results of the last data analysis, even if the sequence method has been 
changed in the interim.

Reporting
With ChemStation, you can choose for each instrument the type of reporting you 
want to use:

• Classic ChemStation Reporting that is unchanged compared to ChemStation 
B reporting. For details, see “Classic Reporting” on page 203.

• Intelligent Reporting: With Intelligent Reporting, you can ...

• create report templates with drag and drop ("What you see is what you get" 
model)

• generate reports in the new Review view by just choosing the data and the 
report template

• use interactive reports for data review: define the search criteria to select 
the information that is relevant for you

• generate cross sequence reports

For more details, see “Intelligent Reporting” on page 196.
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Data Export and Import

ANDI

ChemStation can import and export data files in the andi (Analytical Data 
Interchange) chromatography format of the Analytical Instrument Association 
(AIA), revision 1.0, copyright 1992. Data import is supported at compliance level 
one (sample information and signal data) and data export at compliance level 
two (sample information, signal data and integration results).

DDE

ChemStation includes commands and functions to support the dynamic data 
exchange (DDE) standard of the Microsoft Windows platform as both a DDE 
client and a DDE server. The command set includes commands to establish and 
terminate connections, transfer information in both directions and execute 
remote functions.

ADF

The ADFExport for OpenLab tool allows you to export ChemStation data into the 
Allotrope Data Format (ADF). The tool is only available if the corresponding 
Add-on is installed.

A detailed description of the ADFExport for OpenLab tool is available in the 
ChemStation ADF Export online help.

Customization
ChemStation can be customized using a powerful command set. These 
commands may be grouped to execute automatically a specific function; such a 
group is called a macro.

Users writing macros may define their own variables, build in conditional or 
looping constructs, perform physical I/O including file handling and user 
interaction, nest their macros and schedule and exchange data with other 
Microsoft Windows applications.
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Using Custom Commands or Macros in ChemStation

In ChemStation, custom commands can be used at the following locations:

• Run Queue

see “Using the Run Queue” on page 145

• Queue Planner

see “Using the Queue Planner” on page 149

• Run Time Checklist

see “Run Time Checklist” on page 49

• Sequence Parameters

see “Sequence Parameters” on page 82

• Command Scheduler

see “Schedule Commands” on page 150

From each location you can also access the dialog to create or change 
commands and macros.
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Create Custom Commands

ChemStation offers several built-in commands that can be used by any user. If 
you have the required privilege, you can create your own custom commands and 
macros.

Prerequisites You need the privilege ChemStation:Security >Command Line. Privileges are 
configured in the Control Panel.

1 From any location where commands can be used, select Set up Custom 
Command Template ....

The Custom Command Templates dialog lists all built-in commands and 
custom commands that are available for the current instrument type.

2 Select the required command, then cick Edit....

A dialog opens that allows you to set up the command properties.

• Display name that is shown in ChemStation to all users.

• Location where the command will be available (Run Queue, Command 
Scheduler, Post-Sequence command/macro, Run Time Checklist of the 
method).

• Instrument types for which the command applies.
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3 Confirm your changes.

For more information on customization, see the ChemStation online help on 
commands or macros.

NOTE Command definitions are saved separately with a method's run-time checklist, 
sequence template or a queue plan. That means, if you change or delete a 
definition, this is effective only within the scope of where you called the Custom 
Command Templates dialog. To apply the change to the dialog in another scope, 
you must explicitely update the relevant method checklist, sequence template or 
a queue plan.
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Automation
ChemStation can plan and execute both single samples and multi-method 
sequences.

The sequence parameter set may be defined to use automatically generated files 
or sequentially numbered files with a user-defined prefix of up to fifteen 
characters. The user may select to run full analyses or data reprocessing only 
sequences and can also select one of a series of technique specific shutdown 
commands (for examples about built-in commands, see “Postsequence 
Operation” on page 122) or a user-defined shutdown macro that runs when the 
sequence terminates either by error or after all the analyses are completed.

The sequence table, or list of analyses to run, is built in a spreadsheet-like user 
interface that allows users to specify vial numbers and sample names, sample 
types, analysis methods, sample quantification parameters including sample 
amount, a multiplier and dilution factor, calibration specification, data exchange 
parameter LIMSID and the number of repeat injections. Depending on the 
configured instruments and modules, more fields will be accessible, for example, 
if an Agilent 1100/1200 LC system includes a fraction collector, the Fract. Start 
column will appear in the sequence table. The appearance of the sequence table 
can be configured by the user. The user can jump between individual cells in the 
table and copy, cut or paste individual cells or entire rows or series of rows in 
order to build sequences efficiently and quickly.

Samples may be identified in the sequence table as unknown, calibration, blank, 
or control sample types. The sample type determines any special data evaluation 
treatment of the sample:

• Unknown samples are evaluated and reported according to the method 
specification.

• Calibration samples are used to recalibrate the quantification component of 
the method as described below.

• Blank samples are used to evaluate the reference signal for specific peaks, as 
defined by European Pharmacopeia. You can print the signal-to-noise ratio in 
customized reports. Please refer to the Reference Guide for details on the 
calculation and the required data fields. 

• Control samples are evaluated against the limits for each component defined 
in the method. If the results lie outside any specified parameter range the 
execution of the sequence will be halted.

Calibration samples may be defined as simple, cyclic or bracketed. Simple 
recalibrations mean a recalibration occurs each time a calibration sample is 
defined in the sequence. Cyclic recalibrations occur at defined intervals during 
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analysis of a series of unknowns. In bracketing a series of unknown samples, two 
calibration sets are analyzed. The quantitative reports for the unknown samples 
are then calculated using a calibration table averaged between the two 
calibration sets.

The Sequence Preview functionality allows users to see the order of execution of 
the sequence. As soon as the sequence is queued, the sequence table also 
shows all samples run by run. The user can select individual sample entries to 
rerun or re-evaluate. When re-evaluating data that was already acquired, users 
can specify whether reprocessing uses the original sample quantification data or 
new data entered in the sequence’s sample table.

Sequences may be paused to run single injection priority samples by another 
method, then restarted without disrupting the automation. Samples can be 
added to the sequence table while the sequence is executing.

Both the sequence and partial sequence tables may be printed.

For more information on sequences, see “Automation/Sequences” on page 78, 
and the online help system.

Run Queue and Queue Planner
The Run Queue allows you to automatically run several single samples or 
sequences one after another. The first item added to the queue starts when the 
data system is ready, unless paused from the queue. You can add single 
samples, sequences based on Easy Sequence templates, classic ChemStation 
sequences, or pauses to the queue. Also each Run Method or Run Sequence 
command automatically adds an item to the Run Queue, and automatically starts 
this item in the queue.

Using the Queue Planner, you can prepare a series of single samples or 
sequences and save the plan to the file system. To start these planned samples 
and sequences, you simply open the plan and add it to the Run Queue. This 
function allows you to start lengthy tasks such as overnight or weekend jobs.

For more information, see “About the Run Queue” on page 143.
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Sample Locations
A graphical control allows you to pick the vial locations for your injections and for 
fraction collection.

Instead of typing the sample location manually, which requires a deep knowledge 
of the correct addressing format, you simply choose the drawer location, tray 
type, and vial location with a mouse click.

The graphical control to select sample locations is integrated in the following 
dialogs and toolbars:

• Sample Info

• Sequence Table

• Filldown Options

• Fraction Collector (Start Position)

• Purify taskbar in the Data Analysis view

The control contains the following elements:

Figure 1 Sample location picker in the Sample Info dialog

1 Initial input field for the sample location. Click the arrow or press F4 to open the graphical 
control, or enter the location string manually.

2 Graphic that visualizes the layout of the sample container device (injector or fraction 
collector). If several container locations are available, click to select one.

3 Visualization of the selected sample container. Click a sample location to select it and 
close the graphical control.
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There are primarily the following workflows:

• Use current configuration

This is the default approach. When the sample or sequence is executed, the 
system automatically detects the device.

• Assign container to be applied on acquisition

This workflow is for definable containers that cannot be detected by the 
system, for example, plates. You specify which container has to be used when 
the sequence or sample is executed.

• Assign container to be validated

This workflow is for non-definable containers that are automatically detected 
by the device, for example, trays. When the sequence or sample is executed, 
the system validates the specified container. If the physical container does 
not match the specified one, the run will be aborted. This ensures that the 
correct container type is used.

• Prepare unassigned container

This workflow is for containers that are filled in advance but are not yet 
inserted into the sampler. They are assigned to a drawer and position at a 
later point in time.

The graphical sample locations control is supported, for example, by the Agilent 
LC RC.Net drivers.

4 Additional locations, as defined by the driver. For example, Blank for samplers, or Next 
Location, Next Plate, Pooling for fraction collectors. Click to select the location and close 
the graphical control.

5 List of containers that are compatible to the selected device location.
Use Current Configuration selects the container as determined by the device/driver 
configuration at the time of injection.
Use <empty>, for example, for fraction collector layouts to ensure that a container is not 
considered in the collection order during execution.
ChemStation Concepts and Workflows 32



1 Basic Concepts of ChemStation
About the ChemStation Software
Good Laboratory Practice
ChemStation is developed to internationally recognized design and development 
standards and has a number of features specifically to help users operating in a 
regulated environment. These features are in the area of complete method 
specification and verification that the methods are fit for their intended use, to 
check the operation of their system and ensure the traceability, originality and 
quality of the data.

Development Process

The Certificate of Validation shipped with each software package documents the 
software development and testing steps executed as part of the development 
cycle. The development process is registered to the ISO 9001 quality standard.

Method Specification and Use

• Global methods — the complete instrument and data analysis specification is 
stored in one place. Methods include individual compound range 
specifications to check that quantification results are not applied outside the 
calibrated range.

• The method change history log allows users of a validated method to 
automatically record how and when a method was changed. Users may 
optionally add a comment reason to the change history log. The change 
history log is automatically stored as part of the method in a binary format. To 
prevent unauthorized access to the records, it is protected by the user access 
scheme, described below. The change history log may be viewed and printed.

• Limits may be assigned on a compound-by-compound basis in each method 
for a number of chromatographic/electropherographic and system 
performance parameters, as described in the data analysis quantification 
section. Results exceeding these parameter ranges are used to control the 
execution of automated sequences as described in the automation section. 
They are indicated on the appropriate analysis report.

• System performance or suitability reports (see the Reporting section above) 
provide detailed analysis of the separation quality.

You can set up different roles and privileges in OpenLab Shared Services. The 
pre-configured roles ChemStation Administrator, ChemStation Lab Manager, 
ChemStation Analyst, and ChemStation Operator offer a basis for the roles in your 
environment.
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Method Robustness

Sequence summary reports (see “Classic and Intelligent Reporting” on page 195) 
provide a means to test methods for robustness. With classic reporting, the 
extended format reports for user selected criteria are reported as trend charts 
and may be used to determine the realistic operation limits. With intelligent 
reporting, you can create your own templates for sequence summary reports 
including trend charts with limit lines. These limits can then be incorporated in 
the method to ensure, through the analysis of control samples, that the method 
is operating within specifications.

System Operation

The ChemStation verification kit, which is part of the standard software, 
automatically checks for the correct installation and operation of the data 
evaluation parts of the software by comparing results generated when the test is 
executed against prerecorded known values. The verification kit allows users to 
define their own data files and methods to be the basis of the test.

Data Traceability, Originality and Quality

The run time logbook provides a transaction log of the complete system. It also 
records any unusual events (such as errors or parameter changes made during a 
run) as well as the instrument conditions before and after each analysis. A copy 
of the relevant logbook extract is saved with each data file.

The actual instrument conditions, such as pressure, flow, and temperature, that 
occurred during each analysis are also recorded if the configured instrument 
supports this capability. This data can be subsequently displayed graphically with 
the chromatogram/electropherogram to show the actual instrument conditions 
during that particular analysis, as well as being included on the report.

Methods saved with the data file record the actual method at the time of the 
analysis and allow the complete reconstruction of the reported data at a later 
date. The method is saved at the completion of all the analytical steps.

By default, all reports have time stamps and traceable page numbering (page x of 
y pagination style). The user may select the level of detail in each report ranging 
from simple summary reports to complete system details.

GLP Save register files, specified as part of the method configuration, save all the 
original data, including sample information, data analysis method, 
chromatographic/electropherographic signals, instrument conditions, integration 
and quantification results, report data and the run logbook in one checksum 
protected binary file. This is an uneditable binary format that ensures the 
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originality of the results. The file includes a revisioning scheme that indicates if 
data has been reprocessed.

Control sample types may be defined in the sequence table and used to 
automatically check the instrument performance against quality control sample 
results when the instrument is running unattended. Results that are outside the 
user-specified acceptable range will stop the automatic execution of the 
instrument.
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Preparative Liquid Chromatography
ChemStation supports the automation of purification and preparation workflows. 
The typical workflow includes using a fraction collector with fraction pooling.

 Crude product and sample information    

 Target confirmation and analytical scouting    

 Purification    

 Purity determination of collected fractions    

 Fraction pooling and reformatting    

 Purity determination of pooled fractions    

 Archive or screening    
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Purity determination of collected fractions

In order to check the purity of your collected fractions, you can convert them into 
samples and add them to a sequence for re-injection. The list of fractions for the 
re-analysis is created in the Collect fractions for re-injection dialog accessible via 
the Purify toolbar in the Data Analysis.

In the dialog table, you set up the list of fractions for generating the sequence, 
and you can specify the method and the sample location.

Depending on the setup, the sequence can now be executed, or edited again in 
the Sample List of the Sample Entry tab. For more information, see “Graphical 
Sample Entry” on page 84.

Fraction list Fractions can be added by selecting them from the chromatogram, 
the fractions table, or the sample container graphic.

Method A drop-down list shows all methods stored on the computer. If your 
method is on another instrument that you will use for re-injection, 
you can type the method name in the field, or keep it blank for later.

Sequence You can create a new sequence using the Create from new 
sequence template option. You can also append the fractions to an 
existing sequence using the Create from existing sequence template 
option.

Location If you intend to transfer the sample container to a different 
instrument for re-injection of the fractions, select the Convert 
sample locations to parking lot locations check box.
This converts the locations in the table to neutral parking lot 
locations that can be used on a different sampler.
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Fraction Pooling

Pooling is the collection of multiple fractions into the same collection vessel. 
ChemStation supports different pooling options:

• Inject several times from the same sample position, and collect into the same 
vessel(s)

In the Sample Info dialog, choose the required number of runs for the single 
sample, and select a fixed fraction start location for the first run.

• Inject from different sample positions, but collect into the same vessel(s)

To configure pooling, set the fraction collector start location for the first run and, 
if required, for the following runs.

Fraction Collector Delay Calibration

The time a compound needs to travel between the point of detection in a detector 
and the point of collection in a fraction collector is called delay time. It can be 
determined by performing a delay time calibration.

The Delay Calibration Wizard guides you through this process of performing and 
evaluating a fraction collector delay calibration. The wizard is accessible in 
Instrument menu of the Method and Run Control view.

First, set up and run the delay calibration using Perform Delay Calibration Run. 
Then evaluate the results of the delay calibration using Evaluate Delay Calibration 
Data. The delay calibration is summarized in the Delay Calibration Summary 
report.

The data evaluation assists with working out the delay between the peak 
detector(s) and fraction collector module(s). Delay times are determined based 
on detector signals and the fraction collector's delay sensor signal of a 
calibration run data file. Delay volumes are calculated based on flow information.

For more information, refer to the ChemStation online help.
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ChemStation Data Structure

In order to strengthen the association between data files and methods, the usage 
of result sets has been introduced with ChemStation B.02.01 (result sets have 
been called sequence containers then):

• The data is stored with all necessary information needed for data analysis: 
copies of the sequence file, of all methods, and in case of Intelligent Reporting 
also of the report templates employed with the sequence. The sequence 
methods can be changed with sequence specific input and do not influence 
the original master method. The result set concept thus strengthens the 
meaning of a sequence as a set of data files and methods belonging together 
for result creation.

• Sequence data are not overwritten. Each sequence acquisition stores the 
resulting data files in its own result set with unique name.

• Data recalculation and reprocessing are both available in Data Analysis view 
via the Navigation Table.

• If you use a central data storage system (OpenLab ECM 3.x, OpenLab ECM XT, 
or OpenLab Server), the complete result set (sequence/methods/data 
files/report templates) is transferred to the central repository as one entity.
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Figure 2 Sequence Acquisition

The methods in the folder ChemStation\x\methods1 serve as master methods. 
They remain unchanged during acquisition and data analysis.

Similarly, the sequences in the public documents folder ChemStation\1\
sequence serve as sequence templates that can be used to rerun (but not 
reprocess) a sequence several times.

Report Templates in the public documents folder ChemStation\REPSTYLE serve 
as a starting point for developing your own report templates.

1 x is the instrument number. The folder is under public documents by default but can be configured 
during installation.
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The data storage pattern varies depending on whether single run data or 
sequence data is acquired:

1 When a sequence is executed, a new folder is automatically created (result 
set) with a unique name in the specified subdirectory. When a single sample is 
run, the data file (*.d) is written to the specified subdirectory.

2 For sequence data, the executed sequence template (*.s) and all the methods 
(*.m) involved are copied into the result set. The copies of the methods are 
called the sequence methods in order to distinguish them from the original 
master methods. If you use Intelligent Reporting, all involved report templates 
(*.rdl) are copied into the result set as well.

All sequence-related tasks (for example, acquisition and data analysis) are 
performed on the copies of the sequence and the methods. Therefore, the 
sequence template and the master methods remain unchanged for future 
sequence execution.

Any changes performed on the sequence during sequence acquisition, for 
example, adding lines to the sequence table, are performed on the copy of the 
sequence file in the result set. The sequence template remains unchanged.

Similarly, any changes in the method, for example, updates in the calibration 
table in case of calibration runs, are reflected in the sequence methods, but 
not in the master methods.

While executing the sequence, all generated data files (*.d) are stored in the 
sequence data folder, along with the corresponding batch file (*.b) and 
sequence log file (*.log).

3 Each data file contains a copy of the method used to create the run. The 
following method information is stored:

• To view the original method parameters for each specific data file, right 
click the relevant line in the navigation table, then select View ACQ Method.

• ChemStation offers to save a copy of the complete method (RUN.M) after 
each run (see “Save Copy of Method with Data” on page 68).

• A copy of the data analysis parameters (DA.M) is always saved (see “Save 
Copy of Method as DA.M with Data (ChemStation Default)” on page 68).
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Remote Instrument Control

With a distributed system configuration, you can configure and launch your 
ChemStation instruments from any OpenLab Control Panel that is connected to 
the OpenLab Shared Services server.

Launch Instruments

To configure or launch your instruments, you can use the Configure Instrument, 
Launch online, and Launch offline buttons in the OpenLab Control Panel. As in 
workstation or networked workstation configurations, the instrument 
configuration dialog runs on the local PC. However, with a distributed system 
configuration, the ChemStation application itself runs on an Analytical 
Instrument Controller (AIC) machine, and you access the application via a 
Remote Desktop connection to the AIC machine.

The remote ChemStation windows are shown independently of the OpenLab 
Control Panel; you can launch an instrument, close the Control Panel, and 
continue working with the instrument. Also you can run multiple instances of 
OpenLab Control Panel on the same client using different logon credentials. The 
different credentials will be propagated to the instruments you launch from the 
corresponding OpenLab Control Panel.

You can identify the instruments running on a remote AIC machine by the 
window title, which contains both the instrument name and the AIC name.

Session Disconnect

Instruments running on an AIC are independent of the client from which you 
opened the Remote Desktop connection. If the client disconnects, for example, 
due to network failure, a sequence running on the instrument continues 
unaffected. To regain control over the instrument session once the network has 
recovered, simply click the Launch online or Launch offline button again.

To disconnect intentionally, click on the Close button or select File >Exit. The 
Close dialog offers an additional Disconnect button. By disconnecting, you cut off 
the Remote Desktop connection while leaving the instrument running.

NOTE You can disconnect the Remote Desktop connection while a sequence is 
running.
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To reconnect to this instrument session, simply click the Launch online or Launch 
offline button again in the OpenLab Control Panel. You can reconnect from any 
OpenLab Control Panel that is connected to the OpenLab Shared Services server.

If you click Launch offline to reconnect to an online instrument, or vice versa, you 
will get two instrument windows, one for the online instrument and one for the 
offline instrument.

Session Takeover

You can take over an existing session by clicking the Launch online or Launch 
offline button in the OpenLab Control Panel on a different PC:

• If you launched an instrument from the OpenLab Control Panel on PC 1, then 
log on to an OpenLab Control Panel on PC 2 with the same user credentials 
and launch the same instrument there, you simply take over your existing 
session and continue on PC 2 with whatever you started on PC 1.

• If another user has launched the instrument from the OpenLab Control Panel 
on a different PC, and you have the required privileges, you can also take over 
that session. You must have the Take over ChemStation Remote Session 
privilege, and if the other user has privately locked the ChemStation, you must 
also have the Break Session Lock privilege. For more information on user 

NOTE No warning is shown if the new user and former user have the same credentials.
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management, privileges, or session lock configuration, refer to the OpenLab 
ChemStation Configuration Guide (CDS_CS_configure.pdf).

The current lock status of an instrument/session is shown by an icon to the 
left of the user name in the used by field of the Instrument panel and the used 
by column in the Instruments table:

If you take over the session, the other user receives a message stating which 
user has taken over the session.

The report displays both the Acquisition Operator who is logged on as the 
current user and the Sample Operator who submitted the single sample or 
sequence to the Run Queue.

Online and offline instruments are included in the same session and are therefore 
always transferred together. If an online instrument and an offline instrument are 
already launched in a session, the takeover transfers control of both instruments, 
regardless of whether you clicked the Launch online or Launch offline button. If 
you click Launch offline and the session comprises only an online instrument, or 
vice versa, you will get two instrument windows, one for the online instrument 
and one for the offline instrument.

Force Shutdown

To shut down non-responsive instruments that cannot be used anymore, you can 
right-click the instrument in the OpenLab Control Panel, and select Force 
Shutdown from the Control Panel on the ChemStation Client.

You must have the Instrument Administration privilege to use this function.

Forcing a shutdown will not immediately update the instrument status, leading to 
a temporary inconsistent status display until the status is automatically reset to 
"not started". It is recommended that you wait at least two minutes before 
launching a new ChemStation session.

The instrument/session is being used by another user; do not take it over.

The instrument/session is locked privately; do not take it over.

The instrument/session is either locked non-privately or is disconnected; it is available for 
another user to take over.
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Methods are a vital part of how OpenLab ChemStation works. OpenLab 
ChemStation is a chromatography data system with great flexibility for method 
development. This chapter explains the concepts of methods in detail.
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What is a Method?

A method comprises all the parameters for acquisition and data analysis 
together with pre- and post-run tasks for a given sample, if they are needed.

The available methods (*.m) files are visible in the ChemStation Explorer. For 
quick and easy navigation, you can add additional method locations to the 
ChemStation Explorer selection tree using the Paths tab of the Preferences dialog 
box.

There are different types of methods. Depending on the storage location, 
methods are either used as master methods, as a reference within the result set 
of a sequence, or as an actual record of the settings used during data acquisition.

Master Methods
These are methods stored on the computer disk. Stored methods have a name 
with up to forty alphanumeric characters followed by the extension *.M. The 
master method directories are configured in the Preferences (see “Path 
Selection” on page 70).

The Master Method is stored in a methods subdirectory, available in a Methods 
node of the ChemStation Explorer, and is not directly associated with any result 
set.

Sequence Methods
When a sequence is run, copies of all the master methods used in the sequence 
are stored in the result set along with the sequence data files. These methods are 
directly linked to the sequence, and are also used when the sequence is 
reprocessed. Changes to these methods are by default not automatically 
propagated to the master methods. Changes take effect as soon as the 
sequence run starts or continues after a pause. Changes are also propagated to 
the data file methods (DA.M) when the sequence is reprocessed, and on any 
report generation.
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Data File Methods
A copy of the data analysis parameters is stored as the data file method DA.M 
with the data files. The data file method DA.M is automatically updated after 
each result generation (data acquisition, recalculation or report generation). It is 
also loaded by ChemStation when you recalculate results in the Last Result 
mode (see “Last Result Mode” on page 158).

If you use the Save method with Data option in the run time checklist, the method 
is stored additionally as run.m in the data file.

In the ChemStation Explorer, you can easily load either a master method or a 
sequence method by double-clicking on the method item.
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A method is identified by a name of up to forty alphanumeric characters. The file 
name always has the .M extension to identify it as a method. Methods are stored 
as directories that contain individual files relating to the components of the 
method.

Each method comprises four components:

• method information,

• instrument control,

• data analysis, and

• run time checklist.

Method Information

This section is used to define descriptive information about the method.

Instrument Control

Defines parameters that control the instrument or its components. With an LC 
instrument, parameters, such as mobile phase composition, flow rate, injection 
volume, detector wavelength, and so on, control the pump, the injector and the 
detector. With a GC instrument, parameters such as inlet temperature, inlet 
pressure, packed column flow setting, and so on control the instrument.

Data Analysis 

Defines parameters that control the data processing.

• Signal Details

Defines signals and their properties used for data evaluation.

• Integration Events

Defines timed events that will occur at specific retention/migration times on a 
chromatogram/electropherogram. These timed events can be used to 
change the way the signal is integrated.

• Peak Identification

Defines data processing parameters associated with the identification of 
peaks in the chromatogram/electropherogram.
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• Peak Quantification

Defines data processing parameters that affect the quantification 
calculations which determine the amount or concentration of sample 
component corresponding to each peak.

• Calibration and Recalibration

Defines data processing parameters that affect the calibration and how often 
calibration is done.

• Custom Fields

Defines the properties of sample or compound related custom fields that are 
available for the method. The custom fields allow you to add custom 
information to a sample or a compound in a sample.

• Report

With Classic Reporting: defines the format of the report that is printed after a 
run.

With Intelligent Reporting: specifies the report template used to generate the 
report after a run.

Run Time Checklist

Defines which parts of the method are executed when the method is run.

You can use the run time checklist to:

• acquire, store and process data to produce a report,

• execute only a portion of the method,

• acquire and store data without analyzing it,

• reanalyze existing data files,

• use your own commands for data analysis, pre- and post-run processing,

• save the analysis results in a register for GLP purposes, and

• save your method together with the data.

For more information about custom commands and how to set them up, see 
“Using Custom Commands or Macros in ChemStation” on page 26.
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Creating a new method always means modifying a master method or sequence 
method and saving the modifications. You can either overwrite an existing 
method, or save a method as a new master method. Be aware that when you 
change a method, the disk version remains unchanged until you save your 
changes.

You have a choice of how to create a method. You can create a method to do 
either one or all parts of an analysis. For example, you can create a method to do 
only data acquisition. When you are ready to analyze the data and generate a 
report, you can then modify the method to do these data processing tasks.

NOTE Do not delete the default method (DEF_LC.M, DEF_CE.M or DEF_GC.M). These 
method files are used as templates to create new methods.
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You can edit an existing method using the Edit Entire Method item of the Method 
menu. You are guided through all the method dialog boxes and at the end you 
can save the method. This process is shown below:

Figure 3 Editing Method

Method on disk

Load Method

Edit Method

Save Method [As]

Save to same name

Creates new method
on disk

Select 'Edit Entire Method' from the Method menu

Method loaded into memory, becomes current method

Overwrites current method

Save to new name
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Method Parts to Edit
Each method comprises four components that can be edited separately.

Some of the following subsections refer to specific dialog boxes, and some are 
generalized descriptions.

• Method Information comprises:

• a text description about the method.

• Instrument Control depends on the configuration, and can comprise, for 
example:

• oven parameters,

• injector parameters, and

• detector parameters.

• Data Analysis comprises:

• signal details,

• integration parameters,

• quantification parameters,

• calibration parameters,

• custom field setup parameters, and

• reporting parameters.

• Run Time Checklist comprises:

• the parts of the method that will be executed.

Method Directory Structure

Folders

A method comprises a group of files stored in the method directory (*.M). By 
default, master methods are stored in the instrument's method directory. This 
directory is, for example, in the public documents folder C:\Users\Public\
Documents\ChemStation\x\METHODS, where x is the instrument number.

The path to the instrument can be defined during installation. Additional paths for 
master methods can be added using the preference settings.
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Use ChemStation menu File >Open Windows Explorer... to open the instrument's 
data directory (for example, C:\Users\Public\Documents\ChemStation\1). 
Alternatively, use the shortcut to Instrument Data in the Start menu.

Sequence methods are stored in the result set, and data file methods are stored 
as DA.M in the data file subdirectory.

Files

Method files with the .MTH extension contain parameter sets and are in 
UNICODE format. The file INFO.MTH comprises the method control parameters.

Method files containing the instrument parameters have the name of the related 
analytical module. For example:

Table 5 Method file examples

HPCE1.MTH Comprises the acquisition method for the Capillary Electrophoresis.

ADC1.MTH Comprises the Agilent 35900 acquisition method. If two identical 
instruments are configured, the method files are called ADC1.MTH, 
ADC2.MTH.

DAMETHOD.REG For data evaluation.

LALS1.REG Comprises parameters for the Agilent 1100/1200 Series 
autosampler when a classic modular LC system is configured. The 
method files for the other Agilent 1100/1200 Series modules follow 
the same convention Lxxx1.reg where xxx is the module acronym.

AgilentSamplerDriver1.RapidC
ontrol.xxx.xml

Comprises parameters for the Agilent 1100/1200 Series 
autosampler when a modular LC system is configured. Several .xml 
files are present for the various parts of the parameters (indicated 
by the xxx part of the file name). Similar .xml files are available for 
the other modules.
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Editing Methods in Online Mode 
When an online ChemStation is idle, you can edit all parts of a sequence method. 
When a sequence is currently running, you can edit all acquisition parameters 
and some of the Data Analysis parameters, such as the settings under Specify 
Report.

The changes are saved and immediately set into effect for the current run and all 
following sequence lines that include the same method. This means that you can 
also change the method during a sequence pause or a partial sequence.

Editing Methods in Offline Mode
You can edit a sequence method in an offline ChemStation, while the same 
method is used for a run in an online ChemStation. In this scenario, you can edit 
the Data Analysis part in the offline session. Once you save the changes in the 
offline session, the changed DA settings will be used for the next Data Analysis of 
the current sequence run within the online session.

Method updates concerning calibration are not taken into account. Also history 
entries are not merged, that is, if a method is running in an online session, and 
you change it in both online and offline session, the audit trail of the method will 
only contain the changes made in the offline ChemStation.

NOTE If the same master method is loaded in online and offline ChemStation of the 
same instrument, you can only edit the method in the online ChemStation.
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Methods Tree in ChemStation Explorer
The Methods Tree in the ChemStation Explorer is divided into two parts. The 
upper part shows the methods contained in the currently loaded result set. The 
lower part shows the methods in the master method directories, which you 
configure in the Preferences dialog.

The currently loaded method is always shown in bold.
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By Drag & Drop you can easily copy master methods to sequence methods. The 
entire method (DA parameters and ACQ parameters) will be copied to the result 
set.

Viewing the Acquisition Method
You can access the Acquisition Method Viewer via the menu 
Instrument >Acquisition Method Viewer... in the Method and Run Control view. The 
Acquisition Method Viewer is available for both Online and Offline ChemStation 
sessions.

With the Acquisition Method Viewer, you can check the acquisition parameters 
stored in a method, independently of the current instrument configuration. The 
dialog shows the instrument configuration at the time when the method has 
been saved in ChemStation. Data analysis parameters are not shown in this 
viewer. The Acquisition Method Viewer does not allow the user to make any 
changes to the loaded ChemStation method.

The Acquisition Method Viewer shows the method settings in read-only mode. It 
does not provide functionality to edit and save methods.

Figure 4 Acquisition Method Viewer dialog
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In the method browser (1), the preferred method path is shown by default. Click 
Change Root... in the toolbar to select a different directory.

The toolbar (2) offers the following View Method options:

• View with Original Configuration...: Load the settings as stored in the method to 
the instrument.

• View with Instrument Configuration...: Apply the stored method to the current 
instrument configuration. This option is available for Online instruments only. 
The stored method might not be consistent with the current instrument 
settings; if possible, the settings are then automatically adapted, otherwise, 
you can check the details in the Method Resolution Info dialog. This dialog 
shows the list of inconsistencies and the differences between unresolved and 
resolved method.

1 Method browser

2 Toolbar

3 Module tabs (It shows method settings, pretreatment settings in a tab-control for all found 
modules in the used instrument configuration)

4 Method viewer area

5 Method Name, Injection Source Info

6 Status bar
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Figure 5 Method Resolution Info dialog

Updating DA Parameters in the Master Method
The Update Master Method option is available from the Method menu and from 
the context menu of the sequence method in the ChemStation Explorer. The 
availability and exact behavior of this function depends on the current mode. In 
all cases, this function updates the data analysis parameters of the target 
method.

NOTE It is important to note that this feature updates the data analysis parameters only 
of the target method, and that it overwrites all data analysis parameters.
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Updating a Master Method in Reprocess or Recalculate Mode

In this mode, the Update Master Method command is only active for sequence 
methods of a result set. You can update the master method that you referred to 
when creating the sequence. The precondition is that the master method still 
exists in the master methods directory (the master method must have the same 
name as the sequence method).

You can also configure the sequence parameters to automatically execute this 
function during each sequence acquisition or reprocessing. For more 
information, refer to “Administrating Methods” on page 55.

Updating a Master Method in Last Result Mode

In this mode, the Update Master Method command is active for both sequences 
and single samples. You can transfer the current data analysis parameters to the 
master method last used for data analysis. This method is shown in the Analysis 
Method column of the Navigation Table.

The command is available under the following conditions:

• The method file exists in the given location (that is, the name and the entire 
path must match).

• For sequences: The sequence run has been manually analyzed with a master 
method (not with the sequence method).

Updating Any Master Method in Last Result Mode

In Last Result Mode, you can transfer the data analysis parameters to any master 
method, independently of the master method related to the current sequence or 
single run. To update any master method, select Menu >Update any Master 
Method ..., and select a method from the Choose Master Method to update dialog. 
The data analysis parameters will then be copied to the selected master method.

Updating Methods
With the Update Methods dialog (see figure below), you can copy methods from 
the master method directory to the result set and vice versa. In both cases, the 
entire method is copied (DA parameters and ACQ parameters).

You can open the dialog from the Method >Update Methods... menu or from the 
context menu of the sequence method in the ChemStation Explorer. The function 
is available for result sets in Recalculate and Reprocess mode.
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Figure 6 Update Methods dialog

1 On the left side, you see the methods in all master method directories (as configured in the 
Preferences).

2 On the right side, you see the methods in the currently loaded result set.

3 For each method, you see the date when it was last saved. The tooltip of the date shows the 
method's last history entry.

4 Methods can also be stored in subfolders of the master method directory.

5 Read-only methods have an [R] prefix. The currently loaded sequence method is shown in 
italics.

6 Methods that are common for the sequence result set and the master method pool are 
shown in a bold font. The methods are matched only by name; if a method name exists in 
more than one pool each of the instances will be considered common.

7 You can copy methods between a master method pool and the sequence result set either by 
using Drag&Drop or by using the < and > buttons. You cannot overwrite methods that are 
marked as read-only.
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Saving a Method as New Master Method
You can save the data analysis parameters from DA.M as a new master method. 
However, the DA.M does not contain acquisition parameters. To provide a valid 
set of acquisition parameters for the new master method, you must therefore 
select another method as a template for the acquisition parameters (see figure 
below). The new master method will then contain your current data analysis 
parameters from the DA.M, and the acquisition parameters from the selected 
template method. The new method will be created in the folder where the 
acquisition template method is located.

Figure 7 Save as New Master Method dialog
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What Happens When a Method is Run?

The Run Time Checklist dialog box specifies the parts of the method to execute 
when a run is started.

There are the following parts to the run time checklist:

• pre-run command or macro,

• data acquisition,

• standard data analysis,

• analysis method for second signal (GC only),

• update custom fields values,

• customized data analysis,

• save GLP data,

• post-run command or macro, and

• save copy of method with data (RUN.M).

When running a method the specified parts of the method defined in the Run 
Time Checklist dialog box are executed. Use the menu Method >Run Time 
Checklist... to display or edit the specified parts of the Run Time Checklist.

For more information about commands and how to set them up, see “Using 
Custom Commands or Macros in ChemStation” on page 26.
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Method Operation Summary
The following list shows the flow of the method operation when all parts of the 
Run Time Checklist are selected. 

1 Prerun Command Macro

Does a task before the analysis is started.

2 Data Acquisition

Does injector program.

Injects sample.

Acquires raw data.

Stores data.

Saves the acquisition parameters in the ACQ.TXT file.

3 Optional, as directed by the Run Time Checklist: Save Copy of Method with 
Data as RUN.M.

4 Data Analysis (Process Data)

Loads data file.

Integrates data file.

Identifies and quantifies peak.

Searches spectral library if available.

Checks peak purity if available.

Saves a copy of the method (DA.M).

Prints reports (after updating custom fields values, if selected).

5 Update Custom Fields Values

Executes your macros to update custom fields values before reports are 
printed.

6 Customized Data Analysis

Executes your macros after reports have been printed.

7 Save GLP Data

Saves binary register GLPSave.Reg

8 Postrun Command Macro

Does a task after completion of the analysis, for example, generates a 
customized report.
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Figure 8 Method operation

The figure below shows an overview of the ChemStation status during the 
method operation, where all parts of the Run Time Checklist are selected.

Pre-run Command or Macro (Run Time Checklist)
If a pre-run command or macro is specified, it is executed before the analysis is 
started. This part is typically used for system customizing in conjunction with 
other software packages.
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Data Acquisition (Run Time Checklist)
• All parameters are set to the initial conditions specified in the current method.

• If specified the injection program is executed and an injection is made from 
the currently defined vial.

• The monitor display shows the progress of the analysis including 
chromatographic/electropherographic information, and spectral data if 
available.

• Data are acquired and stored in a data file.

• When the Data Acquisition is finished, the acquisition parameters of the 
currently executed method are stored as ACQ.txt for the data file by default.

Data Analysis (Run Time Checklist)
When the stop-time has elapsed, the analysis is finished and all raw data is 
stored on the computer’s hard disk. The data analysis part of the software starts 
when all the raw data is stored.

Integration 

• Chromatogram/electropherogram objects in the signal are integrated as 
specified in the Integration Events dialog box.

• The start of the peak, the peak apex, retention/migration time and the end of 
the peak are determined.

• Baselines are defined under each peak to determine final peak height and 
area.

• The integration results are created as an Integration Results list.

Peak Identification and Quantification 

• Using retention/migration times and optional peak qualifiers, the software 
identifies the peaks by cross-referencing them with known components 
defined in the calibration table.

• By using peak heights or peak areas the software calculates the amount of 
each detected component using the calibration parameters specified in the 
Calibration Table.
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Spectra Library Search (for LC 3D, CE, CE/MS and LC/MS Systems Only, 
Available With Classic Reporting) 

For all peaks that have UV-Visible spectra available, an automated search of a 
predefined spectral library may be done to identify the components in the sample 
based on the UV-Visible spectra. See Understanding Your Spectral Module for 
details.

Peak Purity Checking (for LC 3D, CE, CE/MS and LC/MS Systems Only)

For a peak with UV-Visible spectra, you can calculate a purity factor for that peak 
and store it in a register. Peak purity may be determined automatically at the end 
of each analysis as part of the method, if the Check Purity box is checked when 
specifying an automated library search or when selecting an appropriate report 
style. See Understanding Your Spectral Module for details.

Print Report

A report is generated with identities and amounts of components detected in the 
run.

Update Custom Fields Values
ChemStation allows to define custom fields for a sample and for specific 
compounds. These custom field values can be included in your reports. By 
default, the values are static. Update Custom Fields Value enables you to modify 
the custom fields values before reports are generated. The updated fields are 
available in both Classic and Intelligent Reporting.

An exmaple macro is available in the Disk2 >UCL folder.

Your Update Custom Fields macro will be executed as follows:

1 as a part of a Standard Data Analysis, shortly before reports are created

2 every time on creating a report/report preview in the Data Analysis view (even 
if Standard Data Analysis is not selected in the Run Time Checklist)

NOTE If you run an Update Custom Fields macro, reports will be generated after this 
macro has been executed.
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Customized Data Analysis
Enables you to run your own customized macros to evaluate your analytical data.

With Standard Data Analysis enabled, these macros run after reports have been 
generated. Results are therefore not available for reporting (neither Classic nor 
Intelligent Reporting). With Standard Data Analysis disabled, they run after data 
acquisition.

Save GLP Data
Saves the binary register GLPSave.Reg together with the data analysis method in 
the data directory. This feature is designed to help prove the originality of the 
data and the quality of the individual analysis.

The GLPSave.Reg binary file contains the following information in a non-editable, 
checksum-protected, register file:

• key instrument set points (can be graphically reviewed),

• chromatographic or electropherographic signals,

• integration results,

• quantification results,

• data analysis method, and

• logbook.

These data are saved only if the Save GLP Data feature is activated by checking 
the check box in the runtime checklist. You can review, but not edit, GLP data in 
the data analysis menu of ChemStation.

NOTE During reprocessing, the custom fields values are always overwritten with the 
static values defined in the sequence/sample. The custom fields will be modified 
only shortly before reports are generated. Therefore, if you reprocess a sequence 
with a different method that does not contain the Update Custom Fields macro, 
the values will be reset to the defined static values.
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Postrun Command or Macro
If a postrun command or macro is specified it is executed after the data 
evaluation, for example, copying data to a disk for data backup.

Save Copy of Method with Data
This is done after data acquisition, and only if Save method with Data is activated 
in the Run Time Checklist. It copies the method used for acquisition to the data 
directory, named as RUN.M. RUN.M contains DA and ACQ parameters. It is 
read-only and thus provides a means for you to reconstruct the analysis in the 
future even if the method changes in the meantime. You can see how changes in 
the method or in selected parameters have influenced your analysis, which can 
help you to optimize it.

Save Copy of Method as DA.M with Data 
(ChemStation Default)
Independently of the marked items in the Run Time Checklist, a copy of the data 
analysis parameters of the executed method is saved as DA.M along with the 
report in the data file. This is done at the end of the Standard Data Analysis part, 
and also when you create a report in the Data Analysis view.
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OpenLab ChemStation offers seamless instrument control of Agilent LC, GC, CE, 
CE/MS, and LC/MS systems. It supports advanced features and workflows of 
Agilent GC and LC instruments with add-on software and provides flexibility for 
research and method development laboratories. This chapter contains an 
introduction to the process of acquiring analytical data.
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What is Data Acquisition?

During data acquisition, all signals acquired by the analytical instrument are 
converted from analog signals to digital signals in the detector. The digital signal 
is transmitted to ChemStation electronically and stored in the signal data file.

Path Selection
Flexible data storage for single runs and sequences allows you to specify various 
saving locations without reconfiguration. The Paths tab in the Preferences dialog 
box in the View menu gives you the opportunity to add multiple paths in addition 

to the default path1C:\Users\Public\Documents\ChemStation\x\DATA (where x 
is the instrument number). Using the Add and Remove buttons, existing paths 
can be deleted, or you can navigate to a selected location and add the path into 
the Preferences.

The default path cannot be removed from the list, but it can be changed in the 
Configure Instrument dialog from the Control Panel. For more information on 
changing the default paths, refer to the OpenLab ChemStation Guide for 
Administrators.

The ChemStation menu File >Open Windows Explorer... povides easy access to 
the actual instrument's data directory (for example, C:\Users\Public\Documents\
ChemStation\1). Alternatively, use the shortcut to Instrument Data in the Start 
menu.

1 Path can be defined during installation.
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Figure 9 Paths tab in the Preferences dialog

All newly specified Data Paths are then available for selection in the Sample Info 
and Sequence Parameters dialog boxes when performing runs.

Figure 10 Data path selection in the Sequence Parameters dialog
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Online Signal Monitor 
The online signal monitor allows you to monitor several signals and, if supported 
by the associated instrument, instrument performance plots in the same 
window. You can conveniently select the signals you want to view and adjust the 
time and response axes. For detectors that support this function a balance 
button is available.

You can display the absolute signal response in the message line by moving the 
cross hair cursor in the display.

Online Spectra Monitor
The online spectra monitor shows absorbance as a function of the wavelength, 
or m/z for mass spectra. You can adjust both the displayed wavelength range 
and the absorbance scale.
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Logbook 

The logbook displays messages that are generated by the analytical system. 
These messages can be error messages, system messages or event messages 
from a module. The logbook records these events irrespective of whether they 
are displayed or not.
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ChemStation Status
The ChemStation Status window shows a summary status of the ChemStation 
software.

When a single analysis is running:

• the first line of the ChemStation Status window displays run in progress,

• the second line in the status window displays the current method status, and

• the raw data file name is shown in the third line together with the actual run 
time in minutes (for a GC instrument, files for front and back injector are also 
displayed).

The Instrument Status windows provide status information about the instrument 
modules and detectors. They show the status of the individual components and 
the current conditions where appropriate, for example, pressure, gradient and 
flow data.

Status Bar
The graphical user interface of the ChemStation system comprises toolbars and 
a status bar in the Method and Run Control View of ChemStation. The status bar 
comprises a system status field and information on the currently loaded method 
and sequence. If they were modified after loading they are marked with a yellow 
asterisk or cogwheel, depending on the instrument. A yellow EMF symbol points 
to usage limits that exceed the setpoints set for LC consumables (for example, 
the lamp). The status bar also shows the status of the Run Queue, which can be 
Resumed, Paused, or Blocked.
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System Diagram
If supported by the configured analytical instruments (for example, the 
Agilent 1200 Infinity LC Series modules, or the Intuvo 9000 GC system) you can 
display a graphical system diagram for your ChemStation system. This allows 
you to quickly check the system status at a glance. Select the System Diagram 
item from the View menu of the Method and Run Control View to activate the 
diagram. It is a graphical representation of your ChemStation system. Using the 
color coding described below the current status is displayed.

Figure 11 System diagram, for example for a GC

Table 6 Colors used to indicate the status of the module or instrument

Color Status

gray offline

green idle

orange not ready

red error

cyan standby (for example, lamps off)

purple pre-run, post-run
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Status Information
In addition, you can display listings of actual parameter settings. Apart from a 
status overview, the diagram allows quick access to dialog boxes for setting 
parameters for each system component.

See the instrument part of the online help system for more information on the 
system diagram.

magenta injecting

blue running or post-run

Table 6 Colors used to indicate the status of the module or instrument

Color Status
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Rules and Alerts
Rules and Alerts

For instrument drivers that support this feature (for example, 8890 GC), you can 
choose Instrument >Manage Rules and Alerts... to configure how the ChemStation 
will react to specific events during acquisition.

For example, a missing vial or vessel is a common error in chromatography. The 
ChemStation may, for example, continue, pause, stop, or abort a sequence.

NOTE The covered events and the possible behaviors depend on the instrument driver.
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Rules and Alerts
Specifying Recalibrations 125
Recalibration Parameters in the Sequence Table and Sample Info Dialog 125

Types of Sequences 128
Explicit Calibration Sequences 128
Cyclic Single-Level Calibration Sequences 128
Cyclic Multiple-Level Calibration Sequences 129
Explicit and Cyclic Calibrations Together 132
Cyclic Calibration Sequences with Bracketing 134
Cyclic Recalibration Sequences with Multiple Vials Containing the Same Dilution of a Standard 138

This chapter describes the concepts of automation. It explains how to work with 
sequences in ChemStation, what happens when a sequence is run and how to 
customize sequences.
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What is Automation?
What is Automation?

Automation is the unattended analysis of more than one injection.

The sequence part of the ChemStation software allows you to automate 
acquisition, data evaluation, and report generation.
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What Are Sequences and Sequence Templates?

A sequence is a series of instructions that automates the analysis of samples. It 
can be used to automatically inject each sample, and to acquire and analyze the 
data according to the method specified for that sample. Each sample vial in a 
sequence may be analyzed with a different analytical method and, thus, use 
different sets of chromatographic/electropherographic conditions and 
evaluation parameters.

Sequence files (*.s) are“sequence templates” that can be used to run an 
acquisition multiple times; however, these templates are not used for 
reprocessing in Data Analysis. When the sequence template is run, a result set is 
created, containing all related files. If you reuse the sequence template, 
ChemStation creates a new result set for each reuse. For backward compatibility 
reasons, it is also possible to run sequences as a series of single runs. For 
details, see “Sequence Execution Mode” on page 115.

The available sequence templates are visible in the ChemStation Explorer. For 
quick and easy navigation, you can add additional sequence template locations 
to the ChemStation Explorer selection tree using the Paths tab of the Preferences 
dialog box.

It is possible to set up multiple sequences for an instrument and schedule them 
in an appropriate order. The Run Queue tab displays the total workload for the 
instrument (sequences as well as single samples, pauses, etc.). You can define 
the order of items to be processed directly in the Run Queue tab. For more 
information about the Run Queue, see “About the Run Queue” on page 143.
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Sequence Parameters

The Sequence Parameters dialog box contains information common to all sample 
vials in a sequence. To open it, select the Sequence menu in the Method and Run 
Control view.

Figure 12 Sequence Parameters dialog
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Sequence Parameters
Use this dialog box to:

• select the data directory using the Path combo box,

• specify how the sequence processing should be done by choosing particular 
part of Methods and Run parameters, and

• specify what happens when the sequence is finished, for example, by using a 
Shutdown command macro. For more information about custom commands 
and how to set them up, see “Using Custom Commands or Macros in 
ChemStation” on page 26.

For example, you can choose to either:

• execute the run time checklist,

• do acquisition only, or

• do reprocessing only (for data acquired till ChemStation Rev. B.01.03. or for 
data acquired with the legacy option Unique Folder Creation OFF).

If the reprocess option is selected, you have the choice to use the sample data 
defined when the sample was originally analyzed, or by activating the Use 
Sequence Table information check box, you can use updated sample data by 
entering new data in the sequence table:

• specify if the barcodes should be used in the sequence and how to handle a 
barcode mismatch, assuming that a barcode reader is installed on the 
system.

NOTE Sequence data acquired with ChemStation revisions up to B.01.03 or acquired 
using the legacy option Unique Folder Creation OFF needs to be reprocessed 
using the reprocess option in the Method and Run Control view.

Sequence data acquired with ChemStation revisions B.02.01 and higher need to 
be reprocessed using the reprocess option in the Data Analysis Navigation table.
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Graphical Sample Entry

The graphical sample entry offers an intuitive visual display of the Sample 
Container and the loaded samples. You can either manually create new samples, 
or load existing sequences for which you want to assign parameters that do not 
yet exist, such as a method or a container location (for example, for re-injection 
sequences generated from collected fractions).

Sample Containers refer to instrument trays or plates that hold samples/vials. 
Sample containers have different dimensions and different vial capacity 
depending on the instrument. Sample Container types describe the physical 
properties of a specific tray or plate in an XML format. Custom Sample Container 
types can be centrally stored and made available across the lab by importing an 
XML file containing the sample container type definition. The Import Sample 
Container Type button in the OpenLab Control Panel is used to import the custom 
Sample Container types.

You can choose a sample container in the Sample Entry tab. You can easily create 
new sample entries in the graphical user interface, simply by clicking in the 
container visualization. The sample locations will be color coded corresponding 
to the sample type.

Figure 13 Sample entry tab
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The Selection Properties ( ) allow you to define the pattern for multiple samples. 
Using these options, you can display the ordering arrow. Simply drag the mouse 
over several locations.

Figure 14 Ordering arrow

For all autosamplers that physically allow rearranging of plates, you can even 
drag entire plates to other positions or drawers . The vial locations are 
automatically adjusted in the sample list. The container configuration can be 
saved with the sequence template, or exported to PDF.

You can also prepare plates that are not associated with any specific position or 
drawer. These parking lots correspond to the plates you prepare on your bench. 
They are saved together with the other settings in the sequence template. You 
can load this sequence template at a later point in time for the relevant 
instrument, and then assign the prepared plates to the correct position and 
drawer.
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Graphical Sample Entry
Figure 15 Multisampler in the Sample entry tab

The Sample List table offers many functions that help you editing the table, such 
as:

• Copy cell ranges

• Append copied cells or lines

• Group samples by specific information

• Filldown with intelligent auto-increment

• Re-order single or multiple selected rows

• Copy individual cell content or selected table regions to the clipboard
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In the sample list, you prepare the same information as in the Sequence Table 
(see “Sequence Table” on page 88). When finished, submit the sample list as a 
sequence to the Run Queue.

NOTE Once the sequence runs, you cannot edit the sample list anymore. Online editing 
is only possible in the Sequence table.

NOTE To continue editing this sequence template in ChemStation, first save it using the 
Save button in the Sample Entry tab. Then load the sequence template again 
using the File or Sequence menu.

NOTE The container configuration is not updated in the graphical hotel presentation in 
the instrument dashboard.
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Sequence Table

The sequence table determines which methods are used to process the sample 
vials and the order in which the data for the vials is acquired and analyzed. This 
table also contains information about each sample, including the sample 

locations on a plate1, sample names, quantification parameters, and recalibration 
parameters.

For instruments that support dual sampling (GC), an additional column Injector 
Location (with Front or Back as possible values) is displayed in the table, and the 
Dual Simultaneous Injections check box is available at the bottom:

• If you select the Dual Simultaneous Injections check box, the system combines 
runs and processes two samples simultaneously in each run. The line 
numbers are adjusted correspondingly. In this mode, you can sort the 
sequence table by Front or Back injector location.

• If you do not select this check box, one sample is processed in each run. The 
order of the runs is as displayed in the table. You can alternate using the front 
and back injector.

For a description of the columns in this table and how they interact with 
information stored with the method, see the online help reference.

Creating Sequences (Sequences and Sequence 
Templates)
Use the sequence table to specify the samples, methods, and vials to run in the 
sequence. The sequence table lists each sample in the sequence in the order it 
will be run and contains the necessary vial number or sample position, method, 
calibration information, sample amount, ISTD multipliers and other data for each 
sample.

1 New sample container types can be in defined in the Instrument Configuration or imported in the 
Control Panel
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Choosing Columns for Display

The information displayed by the Sequence table is configurable:

• Move the columns to left or right, to get the columns most relevant to your 
work up front.

• Exclude columns from the view which are not needed for your work.

To change the view and content of your sequence table, click  (Column 
Chooser) in the sequence table toolbar. Select the columns that you want to 
show within the sequence table. Depending on the installed software packages, 
additional columns will be available, for example, the Target Mass column if an 
LC/MS or CE/MS is installed.

Selection Modes

Similar to applications such as Microsoft Excel, you can select multiple cells or 
cell ranges:

• Ctrl + Click selects multiple single cells

• Shift + Click selects a cell range

Copy, Cut, Paste

• Copy: You can copy selected cells and paste them to any other application 
(for example, Microsoft Excel). The copied information includes the column 
header tags. You can view the tags by pasting the information, for example, to 
Microsoft Excel. With the help of these column header tags, the values can be 
pasted back to a ChemStation sequence table even if the columns are in a 
different order.

• Cut: If you cut entire rows, the rows will be deleted and put into the clipboard. 
If you cut only some columns or cells, the rows will be kept, and only the cell 
values will be cleared.

• Paste: If an entire row is selected, paste inserts the values from the clipboard 
as new rows. If column header tags are available in the copied content, the 
values are mapped into the appropriate columns using these column header 
tags. If only a single column is selected, then the clipboard values are pasted 
from the top row down (line by line), and populate as many columns to the 
right as there are in the clipboard buffer. If only one single cell is selected, the 
cells below and to the right of the selected cell will be filled with the values 
from the clipboard.
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Undo, Redo

The sequence table allows you to undo or redo the last operation.

Inserting, Appending, or Deleting Lines

To insert or append a new blank line, or to delete an existing line, use the 
corresponding buttons in the toolbar:

(Insert Line)

(Append Lines)

(Delete Lines)

Using the Filldown Function

If you have many samples that use the same method, you can quickly enter these 

samples into the Sequence Table using the Filldown icon . This feature copies 
information from one cell into the previously selected cells or columns. For 
sample location, sample name, and data file name incrementation rules defined 
in the Filldown Options dialog are used. For other columns this feature simply 
copies the fields (for example, the method name, number of injections per vial, 
and if specified, the sample amount, ISTD amount, multiplier, and dilution).

Excluded from the repetition are only columns with unique values such as LIMS 
IDs. Also, calibration settings are not copied to samples that are not calibration 
standards.

With the Filldown Options  dialog, you can specify different fine tuned 
behaviors for the filldown function. This dialog allows you to set rules for the 
sample location and sample naming. On well plates, the direction of increment 
patterns can be chosen, and also whether this is to be only a sub set rectangle on 
the plate.

Datafile filldown is special; it takes the complete datafile name and appends a 
counter with the form "--001". For GC, it also appends a "F" or "B", depending on 
the chosen injector for the run at the time when the filldown was done.
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New Lines Wizard

This wizard allows you to efficiently create large sequence tables. You can do 
this in different ways:

• Simple mode: Fill one line with all values which you need to duplicate. Select 

the line, and use the Insert/Filldown Wizard  to repeat the line n times. You 
can also define a rule to insert calibrations or blank runs after a given number 
of samples.

• Advanced mode: Fill several example lines to create a pattern. Then select all 
these lines, and call the Insert/Filldown Wizard. There can be alternating 
calibrations, controls, blank runs and any number of sample runs, calibration 
levels and recalibration settings.

You can also choose, for example, to have all calibrations being run from the 
same vial, and increment only sample vials. Sample positions are repeated 
with an intelligent increment of starting positions (offset for each copied 
bloc), to keep all sample position distances. If you cannot set rules in the 
dialog, values are just duplicated downwards

Excluded from the repetition are only columns with unique values such as 
LIMS IDs.

Filtering the Sequence Table

With the Filter Options , you can apply a set of conditions to display a subset 
of lines in the sequence table.

Via filtering you view the sequence table in a condensed form. You can select, for 
example, to show only certain sample types, methods, calibration levels, sample 
locations, or sample names.

This helps to quickly check for consistency, or to edit only a certain group of 
sequence lines by applying the filldown function to the filtered list. For example:

• Update the sample amount for all samples in a certain sample location.

• Change the vial or sample location for a specific calibration level.
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Reading Bar Codes

If your instrument supports reading of bar codes, click Read Bar Codes  to get 
the sample names. Select the sequence table row or sample location cell you 
want to read the barcode of. There can be one or multiple lines be selected. The 
barcode is placed in the cell of the sample name for each specified sample 
location.

Using the Custom Fields Button

If custom fields have been set up in the method(s) used in the sequence table, 

select the Custom Fields button  in order to edit the custom fields values for 
each sample (sample related custom fields) or for each compound in the method 
of a sample (compound related custom fields).

Previewing the Sequence

With Sequence Preview , a dialog opens that shows the sequence exactly as it 
will be executed, with all repeat calibrations, QC samples and blanks included in 
the correct order.
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Easy Sequence

Overview
Easy Sequence is a user interface for quick and easy setup of sequences from 
templates. The template specifies parameters that should be viewed or edited by 
the user. Calibration setup provides an easy to use drag and drop interface to 
specify calibration types and sample positions, and displays an overview of the 
sequence. With Easy Sequence users can quickly create sequences following a 
certain pattern that differ in the number of samples, but are otherwise similar.

Figure 16 Easy Sequence tab
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Using Easy Sequence Tab (Sequence)
Easy Sequence tab is used to create a sequence from the template created in the 
Easy Sequence Setup tab. Samples saved as a CSV format can also be imported.

To define a Sequence

1 From the Easy Sequence tab, open a template by clicking on the Open Easy 
Sequence Setup icon.

2 Make updates if required. This may include sample vial locations, calibrant 
vial locations, data, or sequence location. Parameters available for editing 
depend on the template configuration.

3 If the pre-filled samples do not match new sample locations, click Fill Samples 
to refill the table.

4 Click Preview/Print Sequence... to preview the Sequence

5 Save the sequence.

6 Click Save and Add to Queue to submit the Sequence to the Sequence Queue.

To import Sample Data

Sample data set can be imported into Easy Sequence. Before importing samples, 
the CSV file must be set up and formatted properly. Refer to online help for more 
information on how to create a CSV sample data file.

1 From the Easy Sequence tab, open a template by clicking the Load Easy 
Sequence Setup icon.

2 Click Import Samples...

3 Select the CSV file you want to import.

All valid fields are imported.

4 Verify the fields by reviewing the Sample List.

HINT The sequence can be edited as long as its status is Pending in the queue.

NOTE To import sample data to the Back Sample List, make sure that the Back Sample 
List is selected and displaying before pressing the Import Samples button.
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Using Easy Sequence Setup Tab (Template)
Easy Sequence Setup is used to create templates which are the starting point for 
creating sequences. There are two panels: Samples and Calibration. The Samples 
panel specifies the method, sample, data, and sequence information. The 
template is also used to specify what parameters are hidden or read-only. The 
Calibration panel provides a graphical interface to configure and view calibration 
runs. It provides an easy-to-use drag and drop interface to specify calibration 
types, cyclic and bracketed, and sample positions.

Creating an Easy Sequence template:

1 From the Easy Sequence Setup tab, select the Samples panel. Open an existing 
template or create a new template.

2 Select the Method. Dual injection options will be shown if the method's 
injection source is Dual. A back analysis method can be specified for the back 
signal. The method is the only parameter required for a template.

3 If desired, enter the estimated duration (in minutes) of a sample run. This is 
the time measured from when a sample starts to when the next sample 
starts. This parameter is used to estimate the total expected duration of your 
sequence. Leave this field blank if you do not want to use the Estimated Cycle 
Time feature.

4 Specify the Starting Vial Location, Number of Samples, and the Sample Name.

5 Select the Data Location

6 Select the Sequence Location and specify the Sequence Name.

7 Enter any comments for the template.

8 Specify which parameters are hidden or read-only. Enter a default value for 
injections/vial, sample amount, ISTD amount, injection volume, etc. This helps 
to minimize the chance for errors when creating a sequence in the Easy 
Sequence Tab.

9 Save the template.
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To define Calibrations:

Prerequisites The method used in the template should have been calibrated to the necessary 
levels.

1 From the Easy Sequence Setup tab, select the Calibration panel

2 Select Cyclic, Bracketing, or Simple Calibration from the Calibration Mode drop 
down list.

3 The Sequence Diagram has the following sections:

• Sequence Start

• Bracketing/Cyclic

• Samples/Injections

• Sequence End

4 In the Samples area for the Sequence, set the Calibration Interval based on 
number of samples or number of injections.

5 Setup the Sample type, Blank, Calibrant, or QC Sample by dragging the icon 
from the Sample Type area to the Sequence Diagram section.

6 Setup the parameters for each Sample type and set to Hide or Read-Only.

7 Verify the calibration mode in the Easy Sequence Overview.

8 Save the template.
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Working with Sequences (Sequences and 
Sequence Templates) 

Sequences (Sequences and Sequence Templates) are accessed and created 
from the Sequence menu. Sequences may be created and saved in the same way 
as methods. When you save a sequence, a file is created with a .S extension. 
When you want to edit or use the sequence again, you access it by, for example, 
using the Load Sequence item in the Sequence menu.

Data Acquisition of Single Runs
For single runs, the data file is saved directly into the respective subdirectory. 
Since only one method is employed for a single run, this method does not need to 
be copied into the subdirectory; all actions are performed directly with the master 
method. After the acquisition part of the method is completed, a copy of the 
acquisition parameters is saved into the file ACQ.txt. A copy of the data analysis 
parameters is saved into the data file directory (DA.M) after the data analysis part 
of the master method has been executed.

Data Acquisition in a Sequence 
In order to run a sequence, appropriate pre-defined methods must be available. 
These are the master methods as outlined above. Typically, master methods and 
sequence templates are worked on in the Method and Run Control view of 
ChemStation. For this reason, in Method and Run Control view, the ChemStation 
Explorer provides access to master methods and sequence templates.

The sequence template references these methods in the sequence table.

When you run a sequence with sequence template <sequence_name>.S in the 
default execution mode, and use the master method <method_name>.M, a new 
folder is created that contains all resulting files from the sequence run (“result 
set”). The location of this result set folder is determined by the settings in the 
Sequence Parameters dialog box (see Figure 12 on page 82). The name of the 
result set folder and the execution mode are determined by the settings in the 
Preferences (see “Preferences - Sequence Tab” on page 113).
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At the start of an acquisition sequence, the method specified in the sequence 
table is copied from the master methods folder into the result set. In addition, a 
copy of the sequence is created and placed with the sequence log and the batch 
(*.b) file in the result set. All updates of the method (for example, updates of the 
calibration table) are written to this sequence method in the result set. If you use 
Intelligent Reporting, the report templates you selected in the Sequence 
Parameters or in the Method Properties are also copied to the result set. All 
necessary files are now available for future data review and reprocessing, 
without changes that were applied to the master method or sequence template 
for other sequence runs.

During acquisition, the data files are stored to the result set. Within each data file 
(*.D), a copy of the sequence method is saved for this specific run. The file 
ACQ.txt contains the acquisition parameters of the sequence method, preserving 
the state of the method as it was at the time of acquisition of the specific data 
file. The folder DA.M contains a copy of the data analysis parameters used in the 
sequence method.

With these files saved in the sequence folder, all data review and reprocess 
activities can be performed without altering the master method or the sequence 
template. If needed, method changes can also be saved to the master method 
again.

NOTE The result set must always contain the complete set of all data files (*.D). If you 
delete part of the data files, uploading the result set to central data storage will 
cause problems. If you need to shorten a sequence, create a self-assembled 
result set from the reduced set of sequence lines (see “Creating a 
Self-Assembled Result Set” on page 108).
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Automatic Update of Master Methods
These functions allow you to select if and when to update the master methods 
used in the sequence. This ensures that, for example, the calibration table is kept 
up to date.

You can activate the functions in the Sequence Parameters dialog (see figure 
below):

• Update data analysis parameters only:

Select this check box if you want to update the data analysis parameters of all 
methods from the result set in the master methods folder at the end of the 
sequence.

• Full method update during sequence acquisition (instrument and data analysis 
parameters):

Mark this check box if you want to update the master method with changes to 
the instrument parameters at the end of each run. The data analysis 
parameters are updated at the same time. If the instrument parameters do 
not change, the data analysis parameters are updated at the end of the 
sequence.

The precondition for updating a master method that the corresponding master 
method (a method with the same name as the sequence method) still exists in 
the same master methods directory as at the time when it has been copied to the 
result set.

To change the check box setting and update master methods, you need the 
privileges Save method changes and Edit sequence summary. For details on user 
management and privileges refer to the OpenLab ChemStation Configuration 
Guide: User Management and Instrument Configuration (CDS_CS_configure.pdf).
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Figure 17 Update master methods option in Sequence Parameters dialog

Priority Samples 
A currently running sequence can be paused after the current method is 
completed. The sequence can be paused to allow the analysis of a priority 
sample by the same or another method. The sequence can then be resumed, 
where the sequence continues with the sample at which the sequence was 
paused.

NOTE As this function will cost performance, it is not advised to use it if you have 
sequences with hundreds of methods.
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Sequencing with Control Samples
Control samples can be specified in the Sample Type field of the sequence table. 
The method used to analyze the control sample must contain a calibration table 
where control sample limits for one of the compounds are specified. If the 
control sample limits you specified are exceeded, the sequence is stopped and a 
message is written into the logbook. If you are using one of the ChemStation 
report styles, the control sample limits are also printed on the reports generated 
for these analyses. For more information on how to define a sequence with 
control samples, see the How To section of the online help.

Sequencing with Blank Reference Samples
Reference signals are required to evaluate the signal-to-noise ratio as defined by 
European Pharmacopeia. You can specify the reference data file in the sequence 
table by choosing the sample type Blank for the corresponding samples. 

If you use multiple reference files, the order of the files is essential. ChemStation 
uses one reference file for all successive runs, until there is new reference file 
given in the sequence table. The reference file of a blank sample serves as its 
own reference. The following overview shows an example of a sequence 
containing two blank samples:

Please refer to the Reference Guide for details on the calculation of the 
signal-to-noise ratio.

Table 7 Example for a sequence with blank samples

Sample Data file Reference file

1 Sample1 DF01.D

2 Blank1 DF02.D DF02.D

3 Sample2 DF03.D DF02.D

4 Sample3 DF04.D DF02.D

5 Blank2 DF05.D DF05.D

6 Sample4 DF06.D DF05.D

7 Sample5 DF07.D DF05.D
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Running a Sequence
As soon as you submit a sequence to the queue, the sequence table changes to a 
run-by-run list. It shows the sequence exactly as it will be executed, with all repeat 
calibrations, QC samples and blanks included in the correct order. The generated 
sequence file will be stored in the result set.

Sequence lines that have already been acquired or are currently being acquired 
are locked. They cannot be edited anymore. With specific workflows, for example 
if you use a Headspace instrument or you configured Overlap injections, several 
pending runs are locked in addition.

Example: Sequence With Multiple Injections

Figure 18 Sequence template before submitting to the queue, sample with 3 injections

Figure 19 Sequence file after submitting to the queue, 3 separate lines

Example: Sequence With Cyclic Calibration

Figure 20 Sequence template before submitting to the queue, cyclic calibration with bracketing

NOTE If you add sequence lines while a sequence is already under acquisition, the 
corresponding data file names depend on the naming scheme you selected in 
the Sequence Parameters. With the Name Pattern naming schema, the data file 
name is resolved at the moment the run starts, using the given tokens.
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Figure 21 Sequence file after submitting to the queue, cyclic calibration with bracketing

Using the High-Throughput Option
Several LC and GC autosamplers offer a High-Throughput option to optimize the 
run time. With this option, the injections of a sequence overlap; the subsequent 
vial is prefetched and positioned by the sampler while the current acquisition is 
still running. This can save a considerable amount of time per run.

Pausing a Sequence 
The currently active run will be completed before the sequence pause.

During a sequence pause, the sequence table file name and the data file name 
cannot be changed. In the sequence table you can only change sequence lines 
that have not already been executed or change the vial number in the current 
sequence line. You can add, delete, and change sequence lines for future 
analyses.

For example, it may be necessary to edit an active sequence to add a new batch 
of samples. You can edit the sequence so these vials will be the next sample that 
ChemStation will process after the samples in the currently running sequence 
line.
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Stopping a Sequence 
The currently active run will be terminated immediately. However, the data 
analysis will still be executed for this run. A stopped sequence can never be 
resumed.

If you want to finish the current run before stopping the sequence, pause the 
sequence, wait for the run to be finished, and then stop the sequence.

Aborting a Sequence 
The abort function terminates a currently active sequence immediately. No Data 
Analysis is executed. The abort function is implemented as an emergency stop 
and will require a restart of the current session.

Running a Partial Sequence

Result Set Selection for Partial Acquisition

You can choose between the following options for a partial sequence acquisition:

• acquire the partial sequence into a new result set

or

• acquire the partial sequence into an already existing result set.

Acquiring the data files from a partial sequence execution into an already existing 
result set may be useful in the following scenarios:

• A single data file (or several data files) has to be overwritten, for example, 
because an incorrect vial was used in the first place.

• Only the first part of the sequence has been executed in the first place, and 
the missing samples have to be added by executing partial sequence. This 
may occur in the case of an instrument failure during sequence acquisition.

• Additional lines have been appended to the sequence template after 
acquisition of the already existing lines. The additional runs are to be added to 
the already existing data.
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Therefore, when you select Partial Sequence from the Sequence menu, a dialog 
will come up providing you the option to either select an existing result set from a 
list or to create a new result set.

Figure 22 Partial Sequence dialog

However, in order to maintain consistency of the result set (so it can be 
completely reprocessed in Data Analysis), only those result sets are offered for 
partial acquisition that fulfill certain conditions:

• The name of the sequence template (source sequence) and the name of the 
sequence *.S file in the result set (target sequence) are identical.

• Both the data path and the subdirectory have to be identical for the sequence 
files.

• The number of sequence lines in the source sequence must be equal or 
higher than the number of sequence lines in the target sequence.

• For each line in the target sequence the sample type and the number of 
injections must be identical to the values in the corresponding lines of the 
source sequence.

• The data file naming scheme must be identical for the two sequence files.

NOTE Deleting lines from or inserting lines into the already acquired part of the 
sequence template will lead to serious inconsistencies in the naming of data 
files.
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After leaving this dialog with OK (for selecting one of the existing result sets) or 
New (for creating a new result set), you can select the sequence lines to be 
executed during partial sequence.

Selection of Sequence Lines for Partial Sequence Acquisition

The system displays the Partial Sequence dialog box and allows you to select 
individual samples from the table for analysis.

A single run is shown on each line of the Partial Sequence dialog box. For each 
run, the vial, method, data file, and sample name are given. Additionally, encoded 
information about the sequence table and any calibration samples is shown in 
the Seq Tbl and Calib:RF:RT columns. See the online help for an explanation of 
these codes.

You can obtain a paper copy of the partial sequence by selecting the Print button.

With Manual update ..., you open the Update Methods dialog box, which allows you 
to manually synchronize the master methods and the methods used in the 
sequence template. With the Automatic update for selected runs option, you can 
update all sequence methods that are used in the selected runs with their 
corresponding master methods.

For example, the Partial Sequence dialog may look like the following. You can 
mark specific samples for processing.

NOTE Partial Sequence populates the data file names at the start of the sequence. As a 
consequence, the file name tokens DATE and TIME will not produce the accurate 
date and time of the injections.

NOTE Both acquisition and data analysis parameters are updated.
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Figure 23 Partial Sequence dialog box

A running partial sequence cannot be edited.

The Partial Sequence dialog does not support overlapped injections (see “Using 
the High-Throughput Option” on page 103).
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Creating a Self-Assembled Result Set
Using the Sequence >Create New Result Set command in the Data Analysis view, 
you can create a new self-assembled result set from the data currently shown in 
the Navigation Table. Self-assembled result sets are helpful, for example, in the 
following scenarios:

• You want to combine single samples, sequences, or a combination of both in 
order to reprocess them with a specific method.

• You want to shorten a sequence.

To assemble a new result set

1 Add the required data files into the Navigation Table.

2 In the Navigation Table, select all the data files that you want to include in your 
new result set.

3 Select Sequence >Create New Result Set to open the Create New Result Set 
dialog box.

4 Select a method to be associated with the new result set.

5 Specify a folder for the new result set.

6 Sort the samples.

The names of output data files are automatically updated. If required, you can 
restore the initial order of the samples using the  (Restore initial order) 
button.

Note that the position of a blank file is relevant for the evaluation of the 
signal-to-noise ratio as defined by European Pharmacopeia. See also 
“Sequencing with Blank Reference Samples” on page 101.

7 Confirm the settings to assemble the list of data files into a result set in the 
specified folder.
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Sequence Log File 

A sequence log file is produced that indicates what has happened during the 
running of the sequence. It is useful for identifying when errors occurred if the 
sequence is running unattended or overnight. The name of the logbook file 
always has the .log extension. The logbook file is located in the directory where 
the data of the sequence is stored.
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What Happens When a Sequence is Run?

Starting a Sequence

When operating in the default sequence execution mode, the system creates a 
result set based on the path definition in the sequence parameters and the 
sequence preference settings. The sequence template *.s, all methods defined in 
the sequence table belonging to this particular sequence are copied to the result 
set. If you use Intelligent Reporting, all report templates *.rdl that are defined in 
the method or in the sequence template are also copied to the result set. The 
system continues to work with these files during acquisition. Starting the 
sequence, the method of the corresponding sequence line is loaded within 
ChemStation from this result set.

For details on the execution modes, see “Sequence Execution Mode” on 
page 115.

Further Executed Steps During Sequence Execution:

The following steps will be repeated for each executed sequence line:

• If equipped with an autosampler, the ChemStation software first locates the 
sample in the autosampler according to the number entered in the vial 
column

• The instrument is loaded with the method parameters.

• The pre-run macro is executed.

• The sample is then injected into the instrument (manually or automatically).

• The data is acquired.

• The method data evaluation is done. Integration, quantification, and reporting, 
including any user specified macro. The system stores an additional methods 
DA.M during the run.

• The post-run macro is executed.

• During the entire process, ChemStation tracks the sequence’s progress in real 
time and produces a sequence log file.
ChemStation Concepts and Workflows 110



4 Automation/Sequences
What Happens When a Sequence is Run?
Figure 24 Sequence Status
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Sequence Data File Structure

Data File Structure
There is a strong link between the raw data, the method, and the result set. The 
result set folder contains all data files (*.D) acquired within a sequence.

Figure 25 Sequence Data File Structure

Each data file, whether acquired within a sequence or as a single run, has a link to 
the method that was used for data analysis.

 Result set    

 Method used in the sequence

 Batch file    

 Sequence log    

 ACAML file for    
 Intelligent Reporting    

 Report template for    
 Intelligent Reporting    

 Sequence template    

 Default data location    

 Instrument number    

 Master methods    

 Sequence templates    

 Report templates    

 List of    
 sequence methods    

NOTE The result set must always contain the complete set of all data files (*.D). If you 
delete part of the data files, uploading the result set to central data storage will 
cause problems. If you need to shorten a sequence, create a self-assembled 
result set from the reduced set of sequence lines (see “Creating a 
Self-Assembled Result Set” on page 108).
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Figure 26 Data file content

Preferences - Sequence Tab
In the Preferences dialog/Sequence tab, you define which folders and files shall 
be created during sequence runs.

The sequence data are stored in a result set using a unique result set name. You 
can specify the naming conventions (Name Pattern) for these result sets in the 
Sequence tab of the Preferences dialog box. If no name pattern is specified, a 
default sequence name pattern is used. The Sequence Tab is used only for data 
acquisition and therefore is present only for online systems.

The sequence name pattern can contain various sections. The system creates a 
name for your result set that is determined by the sequence name pattern 
sections you select. All data files, methods, the sequence logbook, the 
<sequence_name>.s file and the <sequence_name>.b file belonging to this 
particular sequence are stored in the result set. The result set is created when the 
sequence is started.

The sequence (*.s) files are used as sequence templates, and this concept allows 
you to run any sequence file multiple times without overwriting existing data or 
changing the sequence parameters. If neither counter nor time is used in the 
sequence name pattern, the system introduces a counter automatically to avoid 
overwriting data. For the second, third and all subsequent sequences using the 
same sequence template, a counter is added to the result set name.

 UV-Signal chomatograms 

 UV-Spectra    

 Logbook for run    

 Data analysis method    

 Data file    
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Figure 27 Preferences Dialog / Sequence Tab

Result Set Naming

You define the name pattern of the result set folder in the Result Set field (see 
Figure 27 on page 114). By default, the name is <SeqName> <Date> <Time>, but 
it can be configured by using tokens, or you can manually enter any name. For 
more information on using tokens, see “File Names and Tokens” on page 13. For 
the result set folder, you can use the following tokens:

• Current date

• Current time

• User name

• Instrument name

• Sequence name

• Counter

• Computer name

If the name pattern would not result in unique names for the result sets, 
ChemStation will append a counter to ensure uniqueness.

The location of the result set folder is determined by the settings in the Sequence 
Parameters dialog box (see “Sequence Parameters” on page 82).
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Default Data File Name Pattern

In the Preferences dialog, you define a default name pattern for data files that are 
created during sequence execution. This setting serves as a default value for the 
Sequence Parameters dialog (see “Sequence Parameters” on page 82). In the 
Sequence Parameters dialog, you define the actual way how data file names are 
created.

Sequence Execution Mode

If you run a sequence, all data and related files are available in one single folder. 
The data is evaluated in the context of the entire sequence. This is required, for 
example, to run a bracketed calibration, or to create a sequence summary report.

Single runs, however, offer more flexibility in editing the run queue.

ChemStation allows you to run sequences as a series of single runs. If you use 
this function, each line of the rolled-out sequence is added to the run queue as a 
single sample. In the file system, there will be no result set folder; only the data 
files (.D) for single runs are generated. The data file names follow the definition 
that you provided in the Default Data File Name Pattern field.

Under Sequence Execution Mode, choose one of the following options:

• Always run as sequence (default): Running sequences will always generate 
result set folders.

• Always run as a series of method runs: Sequences will always run as a series of 
single runs. As long as this preference is set, you cannot create any result 
sets.

• Operator chooses the execution mode: Each time you run a sequence, you can 
choose to either run it as Sequence or as Series of Runs. All Run or Add to 
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Queue commands in the ChemStation are extended by a corresponding 
option. See the following examples:

Figure 28 Run options in the sequence table

Figure 29 Queue options in the Sample Entry tab

Figure 30 Sequence button in the Single Sample display to run a sequence as series of single 
runs
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Data File Naming

Data File Naming in a Sequence

To define the names of the data files in a sequence, configure the sequence 
parameters (see “Sequence Parameters” on page 82).

Choose between the following options:

• automatic,

• manually,

• using a prefix/counter, or

• using a name pattern.

Automatic Data File Naming in a Sequence

Sample Vials in Vial Trays

For example 017-0103.D

where:

• The first three digits are the vial number, for example, 017.

• The fourth digit in liquid chromatography and capillary electrophoresis is a 
separation hyphen (-); in gas chromatography, this will be either (F) for front or 
(B) for back.

• The fifth and sixth digits are the sequence line that defines the method used, 
for example, 01 for the first sequence line.

• The seventh and eighth digits are the injection number for this vial by the 
method, for example, 03 for the third injection.

Samples in Multisampler

For example D1F-A3-0201.D

where:

• D1F: position (here: front) of sample container in drawer (here: D1)

• A3: position of sample in sample container

• 0201: sequence line 2, first injection
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Blank Runs 

For example NV--0499.D

where:

• NV stands for no vial.

• - is a separation hyphen.

• 0499 is the 99th blank run of sequence line 4.

Entering Data File Names Manually

One of the columns in the sequence table is named Datafile. When it contains no 
entry, the data file naming scheme specified in the Sequence Parameters 
(automatic, prefix-counter, or name pattern) is used to create the data file name. 
If any text is entered into the Datafile column, ChemStation uses that text as the 
data file name for the run.

If more than one injection per vial is specified on a line with a manual data file 
name, ChemStation automatically truncates characters from the end of the 
name entered by the user and appends the injection number. This prevents the 
same data file name from being reused for multiple injections.

Using a Prefix/Counter to Name Data Files

If you use the Prefix/Counter to name data files, ChemStation generates a name 
for each analysis. For an instrument that supports dual signal analysis such as 
the GC, ChemStation will generate a name for each signal.

The sequence set up allows long filenames for the prefix/counter. The data file 
name defined by prefix/counter can have up to fifteen characters plus .d 
extension, so in total seventeen characters.

Following rules apply to the prefix/counter field:

• the counter itself can have a maximum up to 6 characters

• if a prefix provides less than nine characters for prefix, the counter is 
automatically extended to 6 digits

• the number given in the counter is the start number being incremented
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Using a Name Pattern to Name Data Files

You can use the following tokens to create the data file names for each sequence 
line:

If your instrument supports different injection locations (GC with back and front 
injector, for example), you can provide different patterns for each location. For 
example, use a prefix with an indication of the injection location:

• F-<Sequence Line>-<Sample Location>-<Sample Name> for front injections, 
and

• B-<Sequence Line>-<Sample Location>- <Sample Name> for back injections.

Table 8 File names

Prefix Counter Results in file name

long 000001 long000001

longname 000001 longname000001

testwithalongna 1 testwithalongna1

Sample Name The information that has been barcoded or typed into the Sample 
Name field.

NOTE
The barcode will not be visible in the data file name. The barcode is 
evaluated at a point in time where the data file path and name have 
already been resolved.

Sample Type The type of sample: QC sample, calibration, sample.

Sample Location The vial or wellplate location of the sample.

Method The name of the method used for the sequence line.

Sequence Line The current line number of the rolled-out sequence.

Replicate Number The number of the injection from this vial.

Date The date stamp at the start of acquisition of the sample.

Time The time stamp at the start of acquisition of the sample.

NOTE The data file names are not resolved until the run starts; therefore, the sequence 
table does not contain any data file names.
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The resolved data file names are limited to 40 characters; longer file names are 
truncated. If a resolved file name is not unique, a counter is appended.

Result Set Migration
ChemStation provides a tool to migrate non-result set data to result set format. 
To successfully perform this task, it is required that the original sequence file is 
still available. It must contain all the necessary sequence lines and follow the 
original data file naming scheme to reprocess all the data files of the sequence. 
In addition, all the methods in the Method column of the sequence table have to 
be available.

To perform migration, start the Result Set Migration from the Sequence menu in 
Data Analysis view.

Result Set Migration is not supported for data from sequences that has been run 
as a series of single method runs (see “Sequence Execution Mode” on page 115).

Figure 31 Result Set Migration

Fill in the following required fields:

Select Sequence Template: Select the sequence file (*.S) that contains the 
sequence table that matches the data set to be migrated.

Select Method Path: Select the directory where the methods are located that are 
referenced in the sequence table.
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Select Source: Select the directory that contains the data files to be migrated.

Select Destination: Specify the path and name of the result set to be created. You 
may select an existing folder or create a new one.

When all fields are filled in, the migration can be started.

The following steps will be performed:

• The result set directory will be created.

• The sequence template will be copied to the result set. It will also be 
converted to a state where it is able to reprocess data files in Data Analysis 
view.

• The methods referenced in the sequence table are copied from the specified 
method path to the result set folder.

• The data files, the sequence logbook, and the batch file are copied from the 
data source directory to the destination directory.

• According to the information in the sequence table, a copy of the 
corresponding method is copied to each data file as DA.M.

When the result set migration is completed, a success message is displayed in 
the Messages and warnings field. Otherwise a warning message indicates any 
problem during migration. Details about the warning can be obtained by 
double-clicking the warning message.
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Postsequence Operation 

You can specify what happens after a sequence has finished during normal 
execution or when ChemStation encounters an error during sequence operation. 
This is done by activating the Post-Sequence command/macro check box of the 
Sequence Parameter section Shutdown. You have a selection of built-in 
commands configured for certain instrument types, for example:

• Setting the system to a STANDBY state where all lamps, pumps, thermostat, 
and sample cooler are off,

• Setting the system to a LAMPOFF state where all lamps are off,

• Setting the system to a PUMPOFF state where all pumps are off, or

• Using a default SHUTDOWN macro or modifying SHUTDOWN.MAC to 
determine specific operation.

For example, you may want to switch off your system after your sequence 
has completed. Other uses of the shutdown macro could be to set your flow 
to zero or slowly reduce your flow. The unmodified SHUTDOWN macro will 
execute the STANDBY command.

For more information about available built-in commands, see "commands" in 
the ChemStation online help.

In the Shutdown Sequence Parameter section, you may specify a custom 
command or macro. For more information about custom commands and how to 
set them up, see “Using Custom Commands or Macros in ChemStation” on 
page 26.
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Not Ready Timeout (LC and CE only)
The Not Ready Timeout in the Sequence Parameters is the length of time the 
system will wait for the instrument to become ready — after this time the system 
will shut down.

Wait Time (LC and CE only) 
Sequence Parameters allows you to specify a wait time which is executed after 
loading method and before injecting with that method. This can be useful for 
column/capillary re-equilibration when using new analysis conditions.
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Automatic Recalibration 

Calibration is often done after a change in operating conditions, for example, 
after changing a column or capillary. Automatic recalibration is usually done at 
the start of a sequence of analyses or at regular intervals during a sequence as 
part of a program to compensate for factors that affect the analytical 
performance.

While performing a recalibration, the calibration table of the used method is 
update according the defined method settings. The recalibrated methods are 
available within the result set. The calibration table of the sequence method is 
updated during that process. In addition the DA.M method of the individual data 
files contains the updated calibration used for result creation.

There are two ways to specify automatic sequence recalibration:

• explicit calibration sequences, or

• cyclic calibration sequences.

It is also possible to update the calibration table of master methods when 
running single samples or series of single samples.
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Specifying Recalibrations

The recalibration parameters for the sequence are entered directly into the 
sequence table. These parameters define how the method is recalibrated during 
a sequence.

Recalibration Parameters in the Sequence Table and 
Sample Info Dialog
The response factor (RF) and retention/migration times (RT) can be updated in 
several ways. The calibration level, update response factor and update 
retention/migration times are instructions used in the data analysis when 
recalibrating the calibration table. 

When Calibration is entered in the SampleType column of the sample table, the 
following columns become active and can be edited:

• Cal Level

• Update RT

• Update RF

• Interval

The values that can be entered into each of these columns are shown in the 
table.

Table 9 Recalibration Parameters in Sequence Table

CAL Level Update RT Update RF Interval

Calibration table Level 
# (1-999)

No update No update Cyclic recalibration interval 
# (1-999)

Average Average Blank

Replace Replace

Bracket

Delta%
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The table shows the columns in the sequence table that contain the recalibration 
parameters and the values that can be entered. The same parameters can be 
entered into the Sample Info dialog when submitting a single method run, or 
when modifying single method runs pending in the run queue.

No Update 

Does not change the response factor or retention/migration time.

Replace 

Replaces the previous retention/migration times and the response (areas or 
heights) with those from the current run only. The response is not changed for 
any peak that is not found in this recalibration run.

Average 

Averages the retention/migration times and responses (areas or heights) for 
each peak based on the original calibration run and all averaged recalibrations 
since then. If a peak is missing in one of the recalibrations, the average response 
of the peak will not suffer.

Bracket 

The samples are bracketed by pre-sample and post-sample calibrations. 
Evaluation is done when the last calibration sample of the closing bracket has 
been run. The existing calibration data is replaced by the result data of the 
calibration run of the opening bracket. The closing bracket calibrations are 
averaged to that calibration table.

Interval 

The Interval determines how often a calibration is done during a sequence. 
Calibration frequency corresponds to the number of sample injections that are 
done before the next set of calibration injections takes place. At the start of the 
analysis, a calibration is done and the results (response factors) are entered into 
the calibration table. These results are then used in subsequent quantitative 
calculations. After the specified number of injections have been done, another 
calibration is made and the results are entered into the calibration table 
overwriting the results of the previous calibration run.
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Delta%

The delta% calculation allows you to compare response factors from an analysis 
with response factors entered manually into a calibration table. The delta% is 
then applied to all of the calibrated peaks in the table. You can identify several 
internal standards, and their measured response factors are then used to 
calculate new response factors for the other peaks. You identify which internal 
standard is to be used for the delta% calculation for each peak in the calibration 
table.
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Types of Sequences

When preparing a sequence, you can use the following types of sequences:

• explicit calibration sequences,

• explicit single-level calibration sequences,

• cyclic multiple-level calibration sequences,

• explicit and cyclic calibrations together in a sequence, and

• cyclic calibration sequences with bracketed calibrations.

Explicit Calibration Sequences 
This type of sequence recalibrates at defined intervals specified by you in the 
sequence table.

For explicit calibration sequences, the calibration samples are entered in the 
sequence without an interval entry in the sequence table. A recalibration is done 
once for each calibration sample entry in the sequence table.

Cyclic Single-Level Calibration Sequences 
This type of sequence uses the same vial, that is, the calibration sample at 
regular intervals in the sequence.

The interval entry in the sequence table determines how the recalibration is done. 
For example, an interval value of 2 will recalibrate after every two sample vials in 
the sequence.

NOTE After submitting the sequence to the Run Queue, all sequences (including 
sequences with bracketed calibrations) are transformed to explicit calibration 
sequences. See “Running a Sequence” on page 102.

During the run, the sequence table simply shows the injections, run by run, as 
they are processed by the instrument. If you add a sample during the run, all 
subsequent samples (including calibration samples) will move downwards in the 
sequence table.
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Cyclic Multiple-Level Calibration Sequences 
This type of sequence uses different calibration samples to recalibrate a 
multiple-level calibrated method.

The following example describes a two-method sequence comprising method A 
and method B to analyze two groups of samples. Both methods are multiple-level 
calibration methods that will recalibrate automatically at defined intervals.

For each method the Sequence Table has three entries:

• Two calibration levels:

• Sequence lines 1 and 2 in method A.

• Sequence lines 8 and 9 in method B.

• Five entries for the samples:

• Sequence line 3 through 7 in method A.

• Sequence line 10 through 14 for method B.

The calibrations are specified at regular intervals by the recalibration interval 
entry in the Sequence Recalibration Table.

• Method A will recalibrate after every two samples.

• Method B will recalibrate after every three samples.

The Sequence Table below is truncated to simplify the example.

Table 10 Sequence Table for Method A and Method B

Line Sample 
Location

Method Name Inj/Loc Sample Type Cal 
Level

Update RF Update RT Cal 
Interval

1 1 Method A 1 Calibration 1 Average No update 2

2 2 Method A 1 Calibration 2 Average No update 2

3 10 Method A 1

4 11 Method A 1

5 12 Method A 1

6 13 Method A 1

7 14 Method A 1

8 3 Method B 1 Calibration 1 Average No update 3

9 5 Method B 2 Calibration 2 Average No update 3

10 20 Method B 1
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Method A Analysis Order

Method A is the first part of the two-method sequence.

11 21 Method B 1

12 22 Method B 1

13 23 Method B 1

14 24 Method B 1

Table 10 Sequence Table for Method A and Method B

Line Sample 
Location

Method Name Inj/Loc Sample Type Cal 
Level

Update RF Update RT Cal 
Interval

Table 11 Method A Analysis Order

Inj No. Method Vial Operation

1 Method A 1 Calibration level 1 and report

2 Method A 2 Calibration level 2 and report

3 Method A 10 Sample analysis and report

4 Method A 11 Sample analysis and report

5 Method A 1 Calibration level 1 and report

6 Method A 2 Calibration level 2 and report

7 Method A 12 Sample analysis and report

8 Method A 13 Sample analysis and report

9 Method A 1 Calibration level 1 and report

10 Method A 2 Calibration level 2 and report

11 Method A 14 Sample analysis and report
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Method B Analysis Order

Method B is the second part of the two-method sequence. Method B differs from 
Method A in that there are two injections per vial for calibration level 2. The 
Interval entry is set to 3.

Note that the results shown in Table 11 on page 130 and Table 12 on page 131 
can be obtained by using the Preview button in the Sequence Table.

Table 12 Method B Analysis Order

Inj No. Method Vial Operation

12 Method B 3 Calibration level 1 and report

13 Method B 5 Calibration level 2 and report

14 Method B 5 Calibration level 2 and report

15 Method B 20 Sample analysis and report

16 Method B 21 Sample analysis and report

17 Method B 22 Sample analysis and report

18 Method B 3 Calibration level 1 and report

19 Method B 5 Calibration level 2 and report

20 Method B 5 Calibration level 2 and report

21 Method B 23 Sample analysis and report

22 Method B 24 Sample analysis and report
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Explicit and Cyclic Calibrations Together
This type of sequence comprises explicit and cyclic calibrations in the same 
sequence.

This feature allows you to recalibrate the method completely at the beginning of 
a sequence (explicit recalibration) and then update the calibration (cyclic 
recalibration) during the sequence.

• Two calibration lines for each calibration level in the Sequence table must be 
specified.One calibration line is for the explicit recalibration entry and the other 
for the cyclic recalibration entry.

• The sequence table must have entries for each calibration line and all cyclic 
recalibration vials must appear before both the explicit recalibration and 
sample entries.

Example

The sequence table below illustrates a single-level calibrated method called 
SimpReg. It is truncated to simplify the example.

There are two entries for the single calibration level.

• The first calibration line is for the same level but averages the calibration 
parameters. The interval entry specifies that the recalibration is done after 
every three samples.

• The second entry replaces all the recalibration parameters, that is, a complete 
recalibration is done. It has no recalibration interval.

Table 13 Sequence Table for SIMPREG

Line Sample 
Location

Method Name Inj/Loc Sample Type Cal 
Level

Update RF Update RT Cal 
Interval

1 1 SimpReg 1 Calibration 1 Average Average 3

2 1 SimpReg 1 Calibration 1 Replace Replace

3 2 SimpReg 1

4 3 SimpReg 1

5 4 SimpReg 1

6 5 SimpReg 1

7 6 SimpReg 1
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Sequence
Table

The sequence table comprises seven lines. The first line specifies the cyclic 
recalibration sample. The second line specifies the explicit recalibration that is 
done only once at the beginning of the sequence. The third through seventh lines 
specify the samples to be analyzed.

The order of the entries into the sequence table is very important. All cyclic 
recalibration vial entries specifying cyclic calibration must appear before the 
sample entries or any explicit recalibration entries for the method.

SimpReg Analysis Order

The table below describes the analysis order for the SimpReg method.

Table 14 SimpReg Analysis Order

Seq Line Inj No. Method Vial Operation

2 1 SimpReg 1 Simple calibration

1 2 SimpReg 1 Regular calibration

3 3 SimpReg 2 Sample analysis

3 4 SimpReg 3 Sample analysis

4 5 SimpReg 4 Sample analysis

5 6 SimpReg 1 Regular calibration

6 7 SimpReg 5 Sample analysis

7 8 SimpReg 6 Sample analysis
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Cyclic Calibration Sequences with Bracketing
In a cyclic calibrated sequence with bracketing, the calibration table used to 
calculate the unknown quantitative results is generated by averaging the results 
of the current calibration with those of the previous calibration. This new 
calibration table is a more accurate representation of the instrument response at 
the time the sample was analyzed.

Example

Consider the following situation:

• The instrument response is drifting.

• Three injections of an identical two-component mixture are specified.

• Two injections are specified as calibration samples, and one is specified as a 
sample.

• The first and third are calibration samples.

• The second injection is a sample.

To obtain a precise quantitative result for injection two (the sample), an 
interpolation must be made between the two calibration samples; see the figure. 
This process is known as bracketing.

Figure 32 Bracketing

Time

Calibration 1 Calibration 2Sample

Instrument
drift
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Bracketed Sequence Operation 

• The first calibration vials are analyzed.

• The sample vials are analyzed.

• The next calibration vials are analyzed.

• The calibration table is produced by replacing the existing response factors by 
new ones and averaging the following calibration runs into a new calibration 
table.

• The sample vial data files are evaluated, and reports are generated.

• The sequence returns to step 2 if there are more sample vials to be analyzed.

Example

This section describes a sequence bracketing example comprising one method 
called Brack.M. The Brack.M method is a two-level internal standard method 
using cyclic calibration.

Sequence
Table

The sequence table of Brack.M (next page) is truncated to simplify the example. 
It consists of seven lines. The first two lines define the recalibration conditions 
for each level. The remaining lines define the samples to be analyzed.

More specifically, the sequence table of Brack.M method has:

• A Bracket entry in the Update Response Factor column that specifies 
bracketing of samples with calibration samples.

• A Replace entry in the Update Retention/Migration Times column which 
specifies a replacement of the retention/migration times.

• An entry of 3 in the Recalib Interval column that specifies recalibration after 
every three samples.
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Table 15 Sequence Table for BRACK-M

Line Sample 
Location

Method Name Inj/Loc Sample Type Cal 
Level

Update RF Update RT Cal 
Interval

1 1 BRACK-M 2 Calibration 1 Bracket Replace 3

2 2 BRACK-M 2 Calibration 2 Bracket Replace 3

3 10 BRACK-M 1

4 11 BRACK-M 1

5 12 BRACK-M 1

6 13 BRACK-M 1

7 14 BRACK-M 1
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Figure 33 Bracketed Sequence Analysis Order
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Cyclic Recalibration Sequences with Multiple Vials 
Containing the Same Dilution of a Standard

Cyclic Recalibration Sequence with “Round-Robin” Calibration Vial 
Usage

When running a large sequence that performs cyclic recalibrations, that is, 
performs an automatic recalibration after a fixed number of sample injections, 
there is a potential risk of emptying the volume of calibration vial during the 
course of the sequence. The ChemStation sequence table provides a means of 
using a series of vials that contain the same dilution of a standard to be used in a 
round-robin fashion.

With this capability, large sequences can be defined with automatic 
recalibrations at fixed intervals using multiple calibration vials for each level and 
each calibration vial would be consumed to the same extent.

By defining an appropriate number of calibration vials, it is even possible to 
guarantee that each calibration vial is only used once. This is an important 
requirement in cases where a fresh calibration vial is required for every 
recalibration, for example, because the analyte evaporates once the septum is 
punctured or starts degrading after getting in contact with the steel needle. The 
following section describes how the ChemStation sequence table needs to be set 
up to fulfill these requirements.

Determine the total number of calibration vials for each level based on the 
estimated calibrant usage throughout the sequence.

Set up a separate cyclic recalibration line for each calibration vial. Lines defined 
for the same calibration level must be in adjacent sequence lines and the defined 
vial positions must be adjacent, too. Choose an identical recalibration interval for 
all calibration lines. For example, if your sequence should recalibrate after every 6 
sample injections, set the recalibration interval to 6.
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The execution order is:

• Vial 1 (Cal1a)

• Vial 5 (Cal2a)

• 6 injections out of vial 10 (Sample10)

• Vial 2 (Cal1b)

• Via 6 (Cal2b)

• 6 injections out of vial 11 (Sample11)

• Vial 3 (Cal1c)

• Vial 7 (Cal2c)

• 6 injections out of vial 12 (Sample12)

• Vial 1 (Cal1a)

• Vial 5 (Cal2a)

• 6 injections out of vial 13 (Sample13)

• Vial 2 (Cal1b)

• Vial 6 (Cal2b)

• etc.

Table 16 Cyclic Recalibration Sequence with 3 Vials Defined for Each Level

Vial No. Sample Name Sample Type Method Name No. of Inj. Lvl Upd RT Upd RF Interval

1 Cal1a Calib MethodA 1 1 Avg Avg 6

2 Cal1b Calib MethodA 1 1 Avg Avg 6

3 Cal1c Calib MethodA 1 1 Avg Avg 6

5 Cal2a Calib MethodA 1 2 Avg Avg 6

6 Cal2b Calib MethodA 1 2 Avg Avg 6

7 Cal2c Calib MethodA 1 2 Avg Avg 6

10 Sample10 Sample MethodA 6

11 Sample11 Sample MethodA 6

12 Sample12 Sample MethodA 6

13 Sample13 Sample MethodA 6

14 Sample14 Sample MethodA 6
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Cyclic Recalibrations Where Each Calibration Uses a Different Vial

To ensure that every calibration vial be injected only once, the sequence must 
define a sufficient number of different calibration vials, so that the round-robin 
order described in the previous example is not applied. For example, if the 
sequence processes 80 sample vials with recalibrations required after every 10 
samples, the sequence table must contain 80/10 + 1= 9 calibration lines for each 
level.

As in the previous example, the calibration lines must be adjacent sequence lines 
that reference adjacent vial positions.

Bracketing Sequence that Uses Different Vials for Opening and Closing 
Bracket

The same capability is available for bracketing sequences. By defining the 
appropriate vial range of calibration vials, a bracketing sequence can be defined 
so that different calibration vials are used for the opening and closing brackets. In 
this case, too, calibration lines in the sequence must be adjacent just like the vial 
positions of the calibration vials.

Whether or not the bracketing calibration vials are used in round-robin mode or 
for one single injection only simply depends on the total number of calibration 
vials for each level and the number of recalibrations required by the sequence.

The following example defines 3 sample injections that are bracketed by 
calibrations. The opening bracket uses a different calibration vial than the closing 
bracket. Recalibrations are required after every sample injection. so the 
recalibration interval has to be 1. The number of calibration lines per level is the 
number of samples plus one.
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The execution order for this sequence is:

• Vial 1 (Cal1a), Opening Bracket 1

• Vial 10 (Sample10)

• Vial 2 (Cal1b), Closing Bracket 1 and Opening Bracket 2

• Vial 11 (Sample11)

• Vial 3 (Cal1c), Closing Bracket 2 and Opening Bracket 3

• Vial 12 (Sample 12)

• Vial 4 (Cal1d), Closing Bracket 3

Table 17 Different Vials Used for Opening and Closing Brackets

Vial No. Sample Name Sample Type Method Name No. of Inj. Lvl Upd RT Upd RF Interval

1 Cal1a Calib MethodA 1 1 Brkt Brkt 1

2 Cal1b Calib MethodA 1 1 Brkt Brkt 1

3 Cal1c Calib MethodA 1 1 Brkt Brkt 1

4 Cal1d Calib MethodA 1 1 Brkt Brkt 1

10 Sample10 Sample MethodA 1

11 Sample11 Sample MethodA 1

12 Sample12 Sample MethodA 1
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About the Run Queue 143

Using the Run Queue 145
Single Samples and Sequences in the Run Queue 146
Pauses in the Run Queue 147
Commands in the Run Queue 148

Using the Queue Planner 149

Schedule Commands 150
Schedule an Event 150
Scheduler Operating Mode 151

This chapter explains the concepts of Run Queue and Queue Planner. It explains 
how to add single samples, sequences, pauses, or commands to the Run Queue. 
It also describes the Command Scheduler in which you can schedule events to 
make your everyday lab work easier.
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About the Run Queue

The Run Queue is very useful when numerous samples (single samples or 
sequences) for an instrument have to be analyzed in a short time. All single 
samples or sequences created for the instrument are displayed in the Run Queue 
tab. You can add pauses or custom instrument commands to the queue (for 
examples about built-in instrument control commands, see “Postsequence 
Operation” on page 122). In this way, you can automate time-consuming tasks 
such as night or weekend jobs.

While the instrument is processing the workload displayed in the Run Queue tab, 
you can still modify the workload, such as:

• Change the position of the queued items, or add a pause (see “Pauses in the 
Run Queue” on page 147).

• Add a series of single samples and sequences to the queue (see “Single 
Samples and Sequences in the Run Queue” on page 146).

• Edit an already existing item in the Run Queue (see “To edit an existing item in 
the Run Queue” on page 147).

• Run a single sample or sequence immediately (see “Run a single sample or a 
sequence” on page 147).

• Add a built-in or custom command, for example, to shut down the system 
after the run (see “Commands in the Run Queue” on page 148).

• Add a Queue Plan with a predefined set of sequences that was created with 
the Queue Planner (see “Add a Queue Plan with a predefined set of 
sequences” on page 149).

The ChemStation status bar shows the status of the Run Queue, which can be 
Resumed, Paused, or Blocked (if the method or sequence has unsaved changes 
that would be overwritten if the run were to be started).

The History Queue of the Run Queue tab shows you which runs have been already 
executed on the current instrument.

Run Queue and Queue Planner are only available in online ChemStation sessions 
in the Method and Run Control view.
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Since the Run Queue allows long-term jobs, it is very likely that sessions will be 
taken over by other users on the same instrument while the Run Queue is being 
processed. The individual users who take over the session are noted in your 
report. The report displays the Acquisition Operator who is logged on as the 
current user and the Sample Operator who submitted the single sample or 
sequence to the Run Queue.
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Using the Run Queue

The Run Queue is available both from the Instrument Control tab or the Run Queue 
tab. In the Instrument Control tab, you can show or hide the Run Queue with the 
View >Run Queue command.

Figure 34 Run Queue dialog

You can add an item to the front or to the back of the queue. As long as the 
status of the items in the queue is pending, you can change both the execution 

order and the properties of the item. Depending on the Active Queue Options , 
the first item in the queue either starts when the data system is ready or when 
you resume the queue.

The Run Queue supports single samples, Easy Sequence templates, and classic 
ChemStation sequences. The only items that cannot be added to the Run Queue 
are Partial Sequences, Priority Samples, and Runs that are started directly from 
the instrument.

For more information on Easy Sequence, see the online help system. Easy 
Sequence Setup tutorials are available in online help.
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Single Samples and Sequences in the Run Queue

To queue a single sample

1 Select RunControl >Queue Method....

2 In the Queue Method dialog, edit the sample parameters.

3 Add the sample to the queue.

The first item added to the queue starts when the data system is ready, unless it 
is paused from the queue.

To queue a sequence or a series of single samples

1 Select RunControl >Queue Sequence....

2 Select a classic ChemStation sequence template or an Easy Sequence 
template.

3 Edit or review the sequence table and the sequence parameters. You can 
modify the sequence table and sequence parameters without changing the 
currently loaded sequence.

4 Save the settings. In the Finish Queue Sequence dialog, you can choose 
whether you want to add the sequence to the queue or save it as a new 
sequence template. Depending on the preference settings (see “Sequence 
Execution Mode” on page 115), you can also submit the sequences as a 
series of single method runs.

The Finish Queue Sequence dialog also contains the check box Delete temporary 
Sequence Template after completion. ChemStation always keeps a copy of the 
queued sequence template in a temporary directory. This temporary sequence 
template will be used to run the sequence from the queue. As the same sequence 
may be queued several times using different parameters, ChemStation needs a 
separate copy for each queued item. Depending on the status of the check box, 
this temporary sequence template will be kept or deleted when the queue 
continues with the next item.

The Delete temporary Sequence Template after completion check box is selected 
by default. All information required for reprocessing is already available in the 
result set, therefore you do not need a copy of the temporary sequence template. 
However, if you select the check box, a copy is saved by default under C:\Users\
Public\Documents\ChemStation\<instrument>\TEMP\AESEQ.
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To edit an existing item in the Run Queue

You can edit an already existing item in the Run Queue, for example, you can 
assign a different vial position to the single sample or the samples in the 
sequence, or assign a different method with modified parameters.

1 In the Run Queue, select the single sample or the sequence you want to edit.

2 In the toolbar of the Run Queue, select  Edit Selection....

Depending on whether you edit a single sample or a sequence, the Queue 
Method dialog or the Sequence Table opens.

3 Edit the parameters and confirm your entries.

Your settings will be applied to the item in the Run Queue.

Run a single sample or a sequence

To run a single sample or a sequence immediately, select the RunControl >Run 
Method or RunControl >Run Sequence command.

The single sample or sequence is first added to the Run Queue and is then 
immediately started.

If the Run Queue is currently paused, it is automatically enabled so that the item 
runs immediately. The instrument returns to the paused state after the run has 
finished.

Pauses in the Run Queue
To schedule a pause to the queue, click Add Pause to Queue in the Run Queue 
toolbar. In these pauses, ChemStation shows a customizable message and waits 
for a user confirmation.
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Commands in the Run Queue
To add built-in or custom commands to the Run Queue, use the menu Run 
Control >Queue Command.... Alternatively, configure a custom command in the 
Active Queue Options that will be executed when the instrument is idle.

All commands assigned to this instrument are displayed in the drop-down list. 
Select a command from the list, or set up your own command. To set up custom 
commands, you need the privilege Command Line.

For more information about where you can use commands, see “Using Custom 
Commands or Macros in ChemStation” on page 26.
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Using the Queue Planner

With the Queue Planner, you can prepare an ordered set of sequences 
(ChemStation sequence templates *.s or Easy Sequence template *.es ), pauses, 
or commands. The entire Queue Plan can be added either to the back or to the 
front of the Run Queue.

Figure 35 Queue Planner

Add a Queue Plan with a predefined set of sequences

With the Queue Planner you can create Queue Plans for sequences to be run and 
also integrate pauses and commands in between. To prepare a Queue Plan:

1 Select the RunControl >Queue Planner... command.

2 Prepare your queue plan and insert sequences.

3 As in the Run Queue, you can add a pause and provide your own message in 
the Details column. When the Queue reaches the pause, ChemStation stops, 
and displays the given message. A user must confirm the message before the 
queue can be resumed.

4 Save the queue plan. The queue plan is saved as a *.qpl file.

5 At the time when you want to run the Queue Plan, open the Queue Planner, 
load the Queue Plan, and add it to the Run Queue.

For more information on the user interface, see the online help system.
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Schedule Commands

Use the Command Scheduler to set up your ChemStation to automatically 
execute commands for time-based events such as:

• Turning the system on

• Resuming a paused queue to prepare an instrument for the day

• Running an MS Autotune

• Adjusting the detector offset

• Loading a method or sequence

• Starting a sequence or Run Queue

The Command Scheduler allows you to schedule these events at a specific date 
and time, and to set a recurrence interval. The following intervals are supported:

• Do once

• Do daily

• Do weekdays

• Do weekly (on the same day)

• Do monthly (on the same day)

Schedule an Event
Events are scheduled in the Command Scheduler interface. In the table, you must 
specify the command as well as the corresponding date, time, and recurrence 
mode.
ChemStation Concepts and Workflows 150



5 Run Control
Schedule Commands
The Command field offers you built-in commands in a drop-down list. The list of 
commands can be extended by user-defined commands. To set up custom 
command templates, you need the privilege Command Line. For more 
information, see “Using Custom Commands or Macros in ChemStation” on 
page 26. Non-privileged users can only select commands from the drop-down 
list.

For more information about built-in commands and macros, see "commands" 
and "macros" in the ChemStation online help.

Scheduler Operating Mode
The scheduler scans for existing commands every minute. Executed macros are 
displayed in the instrument logbook and in the OpenLab activity log. Tasks with 
an execution date more than two weeks ago, and configured as Do once are 
automatically deleted.

The execution of tasks may be delayed if ChemStation is busy at the scheduled 
time. The execution is performed when ChemStation is ready. A prerequisite for 
execution of recurring tasks is that the instrument must be running.

NOTE Tasks are instrument-specific and are associated with the instrument name. If 
an instrument is renamed, all scheduled tasks for that instrument are deleted.
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Data Analysis 153
Navigation Table Configuration 154
Data Analysis Modes 155
Recalculation Mode 156
Last Result Mode 158
Reprocessing Mode 159
Updating Methods 163
Report Viewer for Data Analysis 163
Batch Review 167

Review 171
Requirements for Intelligent Reporting 171
Data File Selection 171
Report Template Selection 172
Report Preview 173
Possible Review Workflows 173

You can analyze and review your data with ChemStation. This chapter outlines 
the ChemStation data analysis and data review options.
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Data Analysis

Once the data has been acquired, it can be analyzed in ChemStation Data Analysis 
view. When selecting the Data tab of the ChemStation Explorer, you can load all 
the runs of a sequence or all single runs in a specific folder by double-clicking the 
corresponding symbol. The corresponding data set is then available in the 
Navigation Table.

Figure 36 Loading a sequence from the ChemStation Explorer into the Navigation Table

The main body of the Navigation Table consists of a list of all runs of the set. You 
can load a run into ChemStation memory by double-clicking the relevant line in 
the Navigation Table. Additionally, right-clicking on a run offers several options, 
for example, to load or overlay specific signals from the file, to export the data, or 
to view the acquisition method parameters.

Sequence runs are (in the Reprocessing mode) loaded with the sequence method 
that has been used during acquisition or reprocessing. The name of this method 
is shown in the toolbar, and also in the Sequence Method column in the 
Navigation Table. The acquisition method name is shown in the Acq Method 
column.

Single runs are loaded with their associated analysis method. The name of this 
method is shown in the Analysis Method in the Navigation Table and in the Run 
Details. If the method is not available at the original path, an error is shown.

The acquisition method name is shown in the Acq Method column.

ChemStation allows you to specify default actions that are performed 
automatically when a data file is loaded from the Navigation Table. These include 
data analysis tasks like integrating the chromatogram directly after loading, 
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viewing a report for each single injection, or integrating and printing in one single 
step (see figure below).

Figure 37 Signal/Review options tab of the Preferences dialog

Navigation Table Configuration
The Navigation table includes standard table configuration features, such as 
sorting and drag-and-drop options to move columns to different places. It is also 
possible to select the columns that are displayed in the Navigation Table.

In addition, column-specific grouping is possible, for example, single runs of a 
particular operator can be displayed by grouping the loaded files by the column 
operator.

1
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The Navigation table offers right mouse click functions to load a signal, overlay a 
signal, export data, print reports, view the acquisition method parameters etc. 
Each Navigation Table line can be expanded by clicking the + (plus) sign at the 
left of the line to configure signal-specific options:

• Signal: Lists the acquired signals and allows you to specify the signals to be 
loaded. The signal display selection is applied to each run individually.

• General Info: Lists the header details about the run.

• Instrument curves: Allows you to select the instrument data curves to be 
displayed along with the chromatogram/electropherogram on screen and in 
the printout.

Data Analysis Modes
You can choose between the following Data Analysis modes:

• Recalculation mode

• Last Result mode

• Reprocessing mode

These modes are accessible either via the View menu or via the tool set (see 
figure below).

Figure 38 Mode selection

For each of the modes, the tool set contains specific functions. The modes and 
the respective functions are described in the following sections. In the 
Signal/Review Options tab of the Preferences dialog box, you can choose which 
mode should be active by default when you load a result set (see Figure 37 on 
page 154, marker 1).
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Recalculation Mode
Once the run is loaded, you can review it, that is, adjust data analysis parameters, 
integrate the signals and finally print a report. In this case you analyze the run as 
a single run without taking the sequence context into account or using the 
features of the sequence table. The Navigation Table for this type of data 
analysis provides the toolset shown in the figure below.

Figure 39 Recalculation toolset of the Navigation Table

With this toolset, you can jump to the beginning or end of the navigation table, 
step on to the next or previous run, automatically step through the runs, stop 
automatic stepping, recalculate a run using a specific method, or clear the 
Navigation Table.

Recalculation means analyzing on a run-per-run base. Only the runs shown in the 
Navigation Table are analyzed. If you applied a filter to the Navigation Table, only 
those runs actually shown in the table are recalculated. The sorting of the 
Navigation Table is also taken into account.

You can use recalculation in the following workflows, for example:

• You want to review the data files of a result set with a different method that is 
not currently in the result set, for example, a master method not used for 
acquisition, because your workflow employs separate acquisition and data 
analysis methods.

• You have edited a sequence method and want to review only specific runs 
using this method in order to check how well these parameters apply for 
different runs.

• You want to review a single run with a specific analysis method. In 
Recalculate mode, no analysis method is loaded along with a single data file.

Recalculate With Specific Method

With this function, you can recalculate the runs shown in the Navigation Table 
using a specific master method. You specify the required master method in the 
Recalculate With Method dialog (see figure below). If the selected master method 
uses Intelligent Reporting (see “Reporting” on page 189), you can also specify the 
report template that will be used for the single injection reports.
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Figure 40 Recalculate With Method dialog

The Browse for methods in master paths dialog and Browse for templates in master 
paths dialog offer all file locations that you specified in the Preferences.

If you select the Use reference check box, you can select a data file containing a 
reference signal. ChemStation uses this signal to calculate the signal-to-noise 
ratio as defined by European Pharmacopeia. The drop-down list offers the data 
files that you used during the current session. With the Browse button, you can 
select any data file that is also present in the Navigation Table. If want to use a 
different reference file, you must first add it to the Navigation Table.

The new reference overwrites the previous one and will be used from now on in 
signal-to-noise calculations in every report. If you select the Use reference check 
box, but do not select any file, the references are cleared for all recalculated data 
files, and no signal-to-noise values will be calculated from now on.

Each time you recalculate a sample or generate a report, the data file method 
(DA.M) is automatically updated with the data analysis parameters of the used 
method. The path to the specific method is saved as a reference in the data file.

NOTE In previous revisions of ChemStation you have been able to recalculate with a 
specific method by choosing Use current method, Use method from data file, or 
Use sequence method in the toolbar.
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Last Result Mode

Figure 41 Last Result Mode toolset of the Navigation Table

In this mode, the data file method (DA.M) for each run is loaded. DA.M is an exact 
copy of the method which was used for the last data analysis (during acquisition, 
reprocessing, or recalculation). So even if the sequence method has been 
changed in the meantime, you can reproduce the last result with the method 
originally used. In that way you can, for example, track changes done to the 
method in successive recalibration steps in a result set.

The method name in the toolbar shows DA.M, which indicates that the data file 
method is loaded. When you move the mouse pointer over this field, a tool tip 
additionally displays the full path and name of the method. In addition, the name 
of the method last used for data analysis (which was copied to DA.M) is shown in 
the Analysis Method column in the Navigation Table. The tool tip of this column 
shows the full path of this method.

In Last Result Mode, you can update the loaded master method or any master 
method with the current data analysis parameters from the DA.M, or save a 
changed DA.M method as an entirely new master method. For example, you 
loaded a data set analyzed a few weeks or months ago, and you find the data 
analysis parameters stored in the DA.M useful for your current work. You can 
then transfer the settings to a master method of your choice. For more 
information, refer to “Administrating Methods” on page 55.

NOTE The DA.M is normally read-only. You cannot manually load it, it is only loaded by 
ChemStation in the Last Result Mode for recalculation. You can edit it, but you 
cannot manually save it.

If you have changed the method, and you want to print report, a message box will 
ask you for confirmation, as this action will generate new results. If confirmed, 
the changes are saved to the last used data analysis method. A corresponding 
entry is added to the method audit trail.
ChemStation Concepts and Workflows 158



6 Data Analysis and Review Concepts
Data Analysis
Reprocessing Mode

Reprocess Mode for sequences

A different way to analyze your data is to Reprocess a complete sequence. In 
contrast to recalculation, all runs are reanalyzed in the sequence context, i.e. the 
calibration tables of the sequence methods are updated in the case of calibration 
runs, and multipliers, amounts etc. can be changed in the sequence table.

The result set includes all files needed for reprocessing: the data files, a copy of 
the sequence file, all the sequence methods and all the report templates 
originally employed with the acquisition. Thus, in order to reprocess a sequence 
you simply have to load it into the Navigation Table and select the reprocessing 
tool set.

If it becomes necessary to propagate changes in the sequence method to the 
corresponding master method as input for all future acquisition runs, you can 
achieve this conveniently by using the Update Master Method functionality (see 
“Updating DA Parameters in the Master Method” on page 58).

The DA.M is automatically updated each time you reprocess a data file.

For reprocessing sequences, the navigation table provides the following toolset:

Figure 42 Sequence Reprocessing Toolset of the Navigation Table

With this toolset, you can edit the sequence table, edit the sequence parameters, 
save the current sequence, print the current sequence, show or hide the 
sequence logbook, view the saved sequence summary report file(s), start 
sequence reprocessing, or stop the sequence.

Note that the reprocessing icons in the Navigation Table are available only for 
result sets generated with ChemStation B.02.01 and higher. Reprocessing in Data 
Analysis is not accessible for data generated prior to B.02.01, and for data 
acquired in the legacy non-unique folders mode. Such sequences need to be 
reprocessed in Method and Run Control, defining the sequence parameter Part of 
method to run as Reprocess Only. For sequences generated with ChemStation 
B.02.01 and higher, the reprocessing option in Method and Run Control has been 
removed, and the navigation table offers reprocessing as a Data Analysis Task.
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Another alternative is to add such samples or sequences to a new 
self-assembled result set. There you also assign sequence methods, and you can 
reprocess the entire sequence afterwards (see “Self-Assembled Result Set” on 
page 162).

Note the following rules with regard to reprocessing:

• When loading a result set into the Navigation Table, ChemStation also 
automatically loads the sequence file (*.S) that is located in this result set. 
This sequence file contains all the sequence lines that are related to any data 
file belonging to this result set.

• All actions are performed on the sequence methods. If changed analysis 
parameters are to be applied, you have to change the sequence methods.

• During reprocessing, the Batch (*.b) file, the sequence/single run log (*.log), 
and the Navigation Table are updated. The individual data analysis method 
(DA.M) of each processed data file is overwritten with the sequence method.

• To add new methods from one of the master method directories to the 
sequence table, use the ChemStation Explorer to copy the master method to 
the result set, or click Method >Update Methods.... You can then select the new 
sequence method in the sequence table. It is not possible to add or remove 
lines in the sequence table.

• In the Sequence Parameters dialog, only the sequence comment and the 
usage of sequence table information can be changed. All other fields have to 
be set during data acquisition or do not apply to reprocessing.

Figure 43 Sequence Parameters in Data Analysis
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Reprocess Mode for single runs

When loading a single run into the Navigation Table, ChemStation loads the 
associated analysis method. The name of this method is shown in the Analysis 
Method column. The full path can be shown via the context menu (View Run 
Details).

If the analysis method is not available at its original path, an error is shown. In 
acquisition only runs, where no analysis method was used, the acquisition 
method is loaded and used as analysis method.

For reprocessing single runs, the navigation table provides the following toolset:

Figure 44 Single run Reprocessing Toolset of the Navigation Table

With this toolset, you can step through the runs, and reprocess them with their 
associated analysis methods. In combination with the View report file after load 
option (see Figure 37 on page 154), this mode allows an easy review of multiple 
single run results without any data modification.

Treatment of Manual Integration Events

Manual integration events, for example, a manually drawn baseline, are even 
more data file specific than timed integration events. In case of complicated 
chromatograms, it is highly desirable to be able to use these events for 
reprocessing.

Therefore, in ChemStation B.04.01 and higher, manual integration events can be 
stored directly in the data file instead of the method. Whenever the data file is 
reviewed or reprocessed, the manual events in the data file are automatically 
applied. A run containing manual integration events is marked in the Navigation 
Table in the corresponding column.

NOTE Calibration data stored in the method will not update on reprocessing, even if the 
single run is a calibration sample. To recalibrate, see “Recalibration” on page 186.
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In addition to the tools for drawing a baseline and deleting a peak manually, three 
other tools are available in the user interface to:

• save manual events of the currently shown chromatograms into the data file,

• remove all events from the currently shown chromatograms

• undo the last manual integration events (this is available until the event is 
saved)

When continuing to the next data file during review in the Navigation Table, 
ChemStation will check for unsaved manual integration events and ask the user 
whether he wants to save the events.

Manual events stored in the data file during review in the Navigation Table do not 
interfere with manual integration events stored during review in the Batch mode. 
These two ways of review are completely separated with regard to the manual 
events of a data file.

In ChemStation revisions prior to B.04.01, manual integration events could only 
be stored in the method. In B.04.01, this workflow can still be used. The 
Integration menu in Data Analysis view provides the following items in order to 
handle manual integration events with the method:

Update Manual Events of Method: Save newly drawn manual events to the 
method.

Apply Manual Events from Method: Apply the manual events currently saved in the 
method to the currently loaded data file.

Remove Manual Events from Method: Delete the manual events from the method.

In order to convert manual events stored in a method to storage in the data file, 
apply the events from the method and store the results in the data file. If required, 
remove the events from the method.

If the Manual Events checkbox of the Integration Events Table of a method is 
selected, the manual events of the method are always applied when loading a 
data file using this method. If the data file contains additional manual events, the 
events in the data file are used. When the Manual Events checkbox is selected, the 
user is never asked to save the events to the data file.

Self-Assembled Result Set

In the Data Analysis view, the Navigation Table shows the contents of the single 
run or sequence that is loaded. You can load, unload, or add data files to the 
Navigation Table. Using the Sequence > Create New Result Set command, you can 
create a new self-assembled result set from the data currently shown in the 
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Navigation Table (see “To assemble a new result set” on page 108). 
Self-assembled result sets can be reprocessed the same way as automatically 
created result sets.

Unload Current Dataset

Using the Unload Current Dataset command from the context menu of the 
Navigation Table, you can revert the Navigation Table to the original empty state, 
as it is directly after launching ChemStation. If there is unsaved data, you are 
asked to save it.

Delete Selected Data File

Using the Remove selected Data Files command from the context menu of the 
Navigation Table, you can remove the selected lines from the Navigation Table. 
This only removes the reference in the Navigation Table, it does not delete the 
physical data file from the loaded result set or single run on the file system. It is 
only possible to delete the references of added/overlaid files.

Updating Methods
In the Data Analysis view, you have several options to copy methods between the 
master method directories and the result sets. For more information, refer to 
“Administrating Methods” on page 55.

Report Viewer for Data Analysis
Depending on the configuration, ChemStation automatically saves the single 
injection reports and sequence summary reports to the file system at a certain 
point in time. With the Report Viewer, you can easily view the saved report files in 
order to check the results from data acquisition, reprocessing or recalculation.
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Figure 45 Report Viewer

Using the Report Viewer has the following advantages:

• You can directly open the report files from ChemStation. You do not need to 
search for the files in the file system.

• Each report opens in a separate floating window. Therefore, you can easily 
compare different reports by placing the windows side by side.

• You can use the full screen to view the report file.

• You can use the features from Adobe Reader to view .pdf reports.

• You can search for specific text in .txt reports as well as .pdf reports.

• When you reprocess a sequence, you do not have to wait until the entire 
sequence reprocessing is completed. You can open the saved report files for 
those sequence samples that are already completed.

Starting the Report Viewer

You can open the Report Viewer via the menu, via toolbar icons, or via the context 
menu of the Navigation Table. There are different items for sequence summary 
reports and single injection reports.

To view single injection reports:

• Select the menu Report >View Report File to view the report file or files of the 
loaded signal.
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• Select the View Saved Report File(s) command from the context menu of a 
specific sample in the Navigation Table. With this command you can to load 
the report file or files of any signal, even if it is currently not loaded.

• Click the View saved Report File(s) icon from the Workspace Toolbar to view 
the report file or files of the loaded signal.

To view sequence summary reports:

• Select the menu Sequence >View Summary Report File.

• Click the View Saved Sequence Summary Report File(s) icon from the 
Navigation Toolbar (in reprocessing mode).

Configuring the Report Viewer Windows

You can configure several aspects of the Report Viewer behavior. All of these 
settings are accessible via the Options button in the Report Viewer window.

You can define the maximum number of Report Viewer windows that will be 
open in parallel. The windows are cyclically reused. When you view more report 
files than the maximum number of Report Viewer windows, the first opened 
windows are the first to change their content.

For comparing multiple reports, it may also be helpful to adjust the title bar of the 
Report Viewer windows. Various tokens are available for Report Viewer windows 
displaying sequence summary reports, single injection reports for sequence 
samples, or single injection reports for single runs. These tokens help you to 
distinguish the single Report Viewer windows.

The Report Viewer windows are always displayed on top of the ChemStation 
application. In order to work with ChemStation and the Report Viewer at the 
same time, you can resize and position both windows in such a way that you can 
see them both. When you close ChemStation, the windows' size and positions 
are saved. When you launch ChemStation the next time, the same settings will be 
used again.

NOTE If you do not need to compare multiple reports, we recommend to limit the 
number of Report Viewer windows to 1.
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Arranging the Report Viewer Windows

The Report Viewer windows are always displayed on top of the ChemStation 
application. In order to work with ChemStation and the Report Viewer at the 
same time, you can resize and position both windows in such a way that you can 
see them both and can work conveniently.

When you close ChemStation, the windows size and positions are saved. When 
you launch ChemStation the next time, the same settings will be used again.

Working with the Report Viewer

You can use the Report Viewer, for example, in the following workflows:

• You set up the method and the sequence to save PDF reports to the file 
system. After completing the sequence run, you open the report files 
(sequence summary report or single injection reports) directly from the 
ChemStation in the Report Viewer. Use the Adobe Reader features such as 
zooming or searching to check the report in detail.

• You download a sequence that already contains report files from central data 
storage.

• To look at the final result, you select the relevant sample in the Navigation 
Table and open the report file directly from the ChemStation in the Report 
Viewer.

• If required, you can change the method and reprocess the sequence. While 
the reprocessing is ongoing, you start viewing the reports of the already 
completed samples.

In the Report Viewer, you can select both old an new report from the list at 
the top left corner. You can distinguish the reports by their creation date, 
which is shown as a part of the list entry. Depending on the transfer 
settings, the data - including the new report files - may be automatically 
uploaded to central data storage after reprocessing has finished.

• You run a sequence that saves only TXT report files. You can check these 
report files as well in the Report Viewer.

• You review different reports on the same sequence samples, based on 
different report styles or templates.

First, you create a sequence with an extended performance report. You run or 
reprocess the sequence to obtain the report file. If you are satisfied with the 
results displayed in this report, you change the sequence method to create a 
shorter report (for example, select a different report template or the classic 
report style Short). Then you reprocess the sequence to obtain the shorter 
reports. When you view a report with the Report Viewer, you can switch 
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between the two different reports by selecting them from the list in the top left 
corner. The creation date of each file is shown as part of the list entry.

Batch Review

What is Batch Review?

Batch review is a capability within data analysis designed to help an analyst 
perform a “first-pass” review of the results of a sequence or a selection of runs 
quickly and easily. It will save time especially when reprocessing large numbers 
of samples. Whenever a sequence is run, a batch file (with a .b extension) is 
automatically generated and placed in the data directory along with the data files. 
This batch file contains pointers to the data files in the batch review itself. Upon 
loading a batch, the analyst need only select the method to use for the batch, and 
then individually select the desired data files to analyze in the batch. One can 
check the calibration accuracy, instrument performance and individual 
integrations before approving the results. Any chromatogram specific integration 
parameters which are modified can be stored with the data file for data 
traceability. This interactive environment provides complete access to all other 
data analysis capabilities, such as peak purity, library searching, etc., as well.

Batch review uses the same data analysis registers (ChromReg and ChromRes) 
as the standard data analysis and should therefore not be used in an online 
session that is currently performing analyses.

Batch Configuration

A batch is a user-selected series of data files that is processed using a 
user-defined method. All data files in the batch are processed using the same 
method. The processing steps carried out each time a new sample is loaded for 
review can be selected (integration, identification/quantitation, reporting).

All calibration runs in the batch are used to produce a single calibration table, 
using averaged response factors, which is then used for quantification.
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Batch Table

Runs are displayed in a user-configurable batch table:

• the number and content of the table’s columns can be specified;

• the runs can be sorted by

• run index (the order in which the runs were acquired) independent of any 
other criteria,

• sample type (control samples first, then calibration samples, then normal 
samples) then by run index within each sample type,

• method (if more than one method was used to acquire the runs) then by 
run index within each method;

• samples, calibration samples and control samples can be displayed in the 
table or hidden.

Each selected run occupies a line in the batch table. You can exclude a run in the 
batch table (e.g. from calibration) by changing its sample type to Removed.

Compound Table

The compound results are displayed in a user-configurable compounds table, but 
contents of the compounds table depends on the type of samples in the batch 
table:

• the compound list contains all compounds found in the method that was 
loaded for batch review.

• if calibration samples only are displayed in the batch table (samples and 
control samples are hidden), the compound table shows additional columns 
for calibration-related information (expected amount, relative error and 
absolute error).

• if control runs only are displayed in the batch table (samples and calibration 
samples are hidden), the compound table shows additional columns for any 
defined control limits.

For columns containing compound-specific information, you can include the 
name of the compound in the table title by adding %s to the column specification.

Batch Report

The batch report contains two tables that are generally analogous to the batch 
table and the compound table; these tables are also user-configurable.

For columns containing compound-specific information, you can include the 
name of the compound in the table title by adding %s to the column specification. 
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Multi-line headers are allowed; you insert the character ‘|’ at the point where you 
want the line to break.

User Interface

Batch review provides a choice of two user interfaces:

• the standard interface includes a button bar, with buttons mirroring most of 
the Batch menu items, together with the batch table and compound table;

• a minimal interface provides a button bar similar to the standard interface, but 
replaces the batch table and compound table with a combo box that contains 
only the information specified for the batch table. The minimal interface 
button bar does not contain batch table-related or compound table-related 
buttons.

Review Functions

Data files can be displayed in one of two ways:

• manually, by selecting a run to display from the table, 

• automatically, with a predefined interval between each data file. During 
automatic display, only those sample types displayed in the table are 
displayed; the runs are displayed in the order in which they appear in the table. 
The automatic review can be paused and later resumed, or stopped.

The standard functions provided by the ChemStation are available with batch 
review. This includes calibration, manual manipulation of chromatograms, for 
example by smoothing or manual integration. Any changes made to a data file 
can be marked and saved with the batch file. Chromatograms that have been 
reviewed are marked with an asterisk in the batch table. You can also discard 
changes made to either the current chromatogram only, or all changes to all 
chromatograms in the batch.

When a run is loaded, the selected processing options are performed; if the run 
has already been processed and the changes saved, the processed run is loaded. 
This is a faster process than loading the unprocessed run, because no 
processing needs to be done.

NOTE Batch Review allows you to save manual integration events per run. It is also 
possible to save manual events with the data file outside of Batch Review. To 
avoid conflicts with two sets of manual integrations, any manual events that 
have been stored with the data file will not be applied in Batch Review.
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Calibration in Batch Review

Calibration in batch review works independently from the recalibration settings in 
the sequence table. The first step in batch calibration always replaces both 
response and retention time entries in the calibration table. For the following 
calibration standards, both response and retention time values are averaged.

Clicking on the batch review toolbar causes the system to recalibrate with all 
calibration runs in the batch, creating a recalibrated calibration table. Clicking on 
the Batch Review toolbar then recalculates amounts for each calibrated 
compound. The amounts for all samples are calculated from the recalibrated 
calibration table.

Batch Reporting

The user-configurable “Batch Table” on page 168, can be printed directly on the 
printer, displayed on the screen or printed to a file with a user-specified prefix in 
one of the following formats:

• UNICODE text file with the extension .TXT

• Data Interchange Format with the extension .DIF

• Comma-Separated Values format with the extension .CSV

• Microsoft Excel format with the extension .XLS.

The reporting options also give the possibility of sorting the samples (by Run 
Index, Sample Type or Method) independent of the sort method in the batch 
table. The sort priorities are as for the “Batch Table” on page 168.

Batch History

Batch review maintains a log of all actions relating to the current batch. Any 
action that changes the batch (for example changing the displayed 
chromatogram, changing the sample type, loading and saving the batch) adds a 
line to the batch history with a date and time stamp, the current operator name 
and a description of the event.

You can also add your own comments to the batch history. Existing batch history 
entries cannot be edited, and the history list cannot be accessed except through 
the Batch History menu item.
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Review

In ChemStation, a view is available that covers the pure data review workflows of 
Data Analysis. In this Review view, you can generate reports for either an entire 
sequence, a subset of a sequence, or any selection of data files from different 
sequences or single samples.

In the Review view, you do not load any methods and you do not create any new 
results as in recalculation or reprocessing. The reports that you generate in the 
Review view only display the results that have already been calculated.

You can select a report template and apply it to specific selection of data files. 
The combination of template and data file selection determines the output of the 
generated report.

Since the Review view only provides a view on existing results, it is used in 
compliant workflows to present existing results without generating a new result 
version.

Requirements for Intelligent Reporting
ChemStation generates the result data in a specific format (*.ACAML) that is 
used by Intelligent Reporting. If you want to create reports for data acquired with 
a ChemStation Version A or B, you must first regenerate results using OpenLab 
ChemStation rev. LTS 01.11 (for example, recalculate the data or generate single 
injection reports in the Data Analysis view). If the results are not available in the 
required format, the generated reports in the Review view will not contain any 
data. 

Data File Selection
You can select the required data files by loading the sequences or single runs 
from the Navigation Tree in the ChemStation Explorer. All available data files are 
then shown in the Navigation Table. In the Navigation table, you select the 
specific data files for which you want to see the results in the report.

NOTE The Review view is only available if you activated Intelligent Reporting in the 
Instrument Configuration in the OpenLab Control Panel.
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Loading Data Files

You can load all data files from an entire sequence or Single Runs folder. In the 
Data tab of the ChemStation Explorer, you can either double-click the sequence or 
use the Load command from the context menu to load all included data files.

When you load the data files, the Navigation Table is automatically cleared before 
the new data files are shown. You can therefore prepare the data for either a 
Single Sample Report or for a Sequence Summary Report.

Adding Data Files

If you want to compare the results from different sequences, you can first load 
one sequence, and then add the required data files from another sequence. In the 
Data tab of the ChemStation Explorer, use the Add Data Files... command from 
the context menu to add only specific data files to the selection already loaded. A 
dialog opens in which you can select the required data files.

When you add data files, the Navigation Table appends the data files to the list of 
data files already loaded. You can therefore prepare the data, for example, for 
Cross-Sequence Reports.

Selecting Data Files for Reporting

The Navigation Table shows all data files from the sequence or single sample 
collection that you double-clicked in the ChemStation Explorer. In the Navigation 
Table, you select those data files for which you want to create the report. Only the 
selected lines will be included when you generate a report.

Report Template Selection
You can select the required report templates from the Report Templates tab in the 
ChemStation Explorer. The Navigation Tree shows all report templates in the 
REPSTYLE directory.

By default, the REPSTYLE directory is located under C:\Users\Public\
Documents\ChemStation. This path is defined during installation.

Use ChemStation menu File >Open Windows Explorer... to open the path for the 
current instrument (for example, C:\Users\Public\Documents\ChemStation\1). 
Alternatively, use the shortcut to Instrument Data in the Start menu.
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Report Preview
The resulting report is always determined by both the data selection and the 
report template. Therefore, ChemStation generates the corresponding report and 
displays the report preview once you have selected one or more data files and 
loaded a report template.

You can send the report to a printer or save it as a file (.PDF, .XLSX, .DOCX, .TXT, 
or .CSV). If you use a central data storage system, you can also upload the report 
directly to the central repository.

Possible Review Workflows
You can use the Review view for example in the following workflows:

• You load a sequence and select all data files of the sequence. You load a 
report template and generate a sequence summary report.

• After generating a sequence summary report, you load a different report 
template. You review the same data using a different report layout.

• You load a sequence and select only a subset of data files. You load a report 
template and generate a sequence summary report for only part of the 
sequence.

• After loading a subset of data files, you add other data files (from a sequence 
or from a collection of single samples). You load a report template and 
generate a cross-sample or cross-sequence report.
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This chapter explains the concepts of calibration.
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Definition of Terms 

Calibration Calibration is the process of determining response factors used to calculate 
absolute component concentrations by injecting specially prepared calibration 
samples. The calibration table is also used for identification.

Compound A chemical compound can comprise several peaks, in a multiple signal 
calibration, typically one per signal. In a single signal calibration a compound 
refers to one peak.

Calibration
Level

A calibration level comprises the calibration points for one calibration sample 
concentration. In a multisignal calibration the different compounds can be 
calibrated using different signals.

Calibration
Point

A calibration point refers to an amount/response ratio for a peak on the 
calibration curve.

Calibration
Sample

A calibration sample, also referred to as a calibration standard or a standard 
mixture, is a sample containing a known amount of the compound to quantify. In 
the software the calibration sample is referred to as an injection from the 
calibration sample vial.

Calibration samples may be purchased from chemical suppliers or they may be 
prepared using an accurately measured amount of the pure compound. The 
amount of the compound in the calibration sample is usually expressed as a 
concentration, typically in ng/µl units.
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Types of Calibration 

ChemStation offers two types of calibrations, single-level and multilevel 
calibrations.

Single-Level Calibration 
The calibration curve shown in Figure 46 on page 176 contains one point, that is, 
one level. For the single-level calibration curve, the response of the detector is 
assumed to be linear over the working range of concentrations for the samples 
of interest. The response factor for a given component peak is given by the 
inverse of the slope of the calibration curve line through the point and the origin. 
A disadvantage of single-level calibration is that the detector response to the 
sample concentration is assumed to be linear and pass through the origin on a 
concentration versus response plot. This is not always true and can lead to 
inaccurate results.

Figure 46 Single-level calibration curve

To obtain accurate quantitative results, a calibration curve should have at least 
two levels. These levels should bracket the amounts expected to be found in the 
unknown samples.
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Figure 47 Two-level calibration curve

For example, if you want to quantify a compound, and the unknown samples are 
expected to range from 1 – 10 ng/µl, then a calibration curve should have at least 
the two levels as shown in Figure 47 on page 177.

Amount Limits 

ChemStation allows you to define the valid quantification ranges in terms of 
absolute amounts for each component.

Multilevel Calibration 
Multilevel calibration can be used when it is not sufficiently accurate to assume 
that a component shows a linear response or to confirm linearity of the 
calibration range. Each calibration level corresponds to a calibration sample with 
a particular concentration of components. Calibration samples should be 
prepared so that the concentration of each component varies across the range of 
concentrations expected in the unknown samples. In this way it is possible to 
allow for a change in detector response with concentration and calculate 
response factors accordingly.

This multilevel calibration curve has three levels and shows a linear fit through 
the origin. This method of linear fit through the origin is similar to the single-point 
method calibration. The detector response to concentration is assumed to be 
linear. The difference between the two calibration types is that, with linear fit, the 
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slope of the detector response can be determined by a best fit through a number 
of points, one for each level.

Figure 48 Multi-level calibration curve with three levels

The corresponding calibration table, which is the tabulation of the information 
used to generate this curve, might look similar to the one shown in Table 18 on 
page 178.

In this example, the calibration samples that were used to generate the three 
levels had been identified as 1, 2 and 3.

Calibration Ranges
Each multilevel calibration is valid over the range of concentrations used in the 
calibration samples. Extrapolation of a calibration curve, especially if it is 
non-linear, is at best an approximation. The valid calibration range for each 
compound may be defined in the Compound Details dialog box. Each entry for 

Table 18 Calibration Table

Level Amount (ng/µl) Response (area counts)

1 1 100

2 5 500

3 10 1000

10
Concentration [ng/μl]

Response

1000
Calibration Curve

100

1 5

500
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that compound can be expressed as lower and upper limits. If these limits are 
exceeded, the report is annotated. 

Calibration Curve Fits
Various curve-fit calculations are available for use with multilevel calibration.

• Piecewise Linear

• Linear

• Log

• Power

• Exponent

• Quadratic

• Cubic

• Average (Response/Amount)

Non-Linear Fit 

In some cases, the detector response to changes in sample concentration is not 
linear. For these types of analyses, a linear regression calibration method is not 
appropriate and a multilevel calibration calculation should be used.

Origin Treatment
There are four ways to treat the origin when the response curve is plotted:

• ignore the origin,

• include the origin,

• force the origin, or

• connect the origin.

To force the origin to be included in the calibration curve the calibration points 
are mirrored about the origin from the first quadrant into the third quadrant. 
Using all points for the regression calculation ensures that the resulting 
calibration curve passes through the origin. This is also explained in Figure 49 on 
page 180.
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Figure 49 Forcing the origin to be included

For further information about calibration curve fits and origin treatment, see the 
online help file. 

Calibration Point Weighting 

When setting up your default calibration curve, you can specify the relative 
weighting (or importance) of the various calibration points used to generate the 
curve.

The following weighting options can be selected:

Weight Description

Equal All calibration points have equal weight in the curve.

Linear (Amnt) A calibration point with the amount x has the weighting 1/x normalized to the 
smallest amount so that the largest weight factor is 1. Normalization is done by 
multiplying the weight with the smallest amount. For example the weight of a 
calibration point with the amount x is (1/x) × a where a is the smallest amount of 
the calibrated compound prepared in the calibration standards.
If the origin is included it is assigned the mean of the weightings of the other 
calibration points.

Response

Calibration curve

Amount (ng/μl)

()

()

()
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Quadratic calibration point weightings, for example, can be used to adjust for a 
spread in calibration points. It makes sure that calibration points closer to the 
origin, which can normally be measured more accurately, get a higher weight 
than calibration points further away from the origin, which may be spread.

You should base your decision, which kind of calibration point weighting to use, 
on your method requirements.

Linear (Resp) A calibration point with the response y has the weighting 1/y normalized to the 
smallest response so that the largest weight factor is 1. Normalization is done 
by multiplying the weight with the smallest response. For example the weight of 
a calibration point with the amount y is (1/y) × b where b is the response 
corresponding to the smallest amount of the calibrated compound prepared in 
the calibration standards.
If the origin is included it is assigned the mean of the weightings of the other 
calibration points.

Quadratic (Amnt) A calibration point with the amount x has the weighting 1/x2normalized to the 
smallest amount so that the largest weight factor is 1. Normalization is done by 
multiplying the weight with the smallest amount. For example the weight of a 
calibration point with the amount x is (1/x²) × a² where a is the smallest amount 
of the calibrated compound prepared in the calibration standards.

Quadratic (Resp) A calibration point with the response y has the weighting 1/y2normalized to the 
smallest response so that the largest weight factor is 1. Normalization is done 
by multiplying the weight with the smallest response. For example the weight of 
a calibration point with the response y is (1/y²) × b² where b is the response 
corresponding to the smallest amount of the calibrated compound prepared in 
the calibration standards.

# Calibrations A calibration point is weighted according to the number of recalibrations of the 
point. No normalization is done.

Weight Description
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Calibration Table 

The calibration table specifies conversions of peak areas or heights into the units 
you choose according to the calculation procedure you select. It contains a list of 
retention/migration times from a calibration run. These retention/migration 
times are compared with retention/migration times of peaks from a sample run. 
Where a match occurs, the peak in the sample is assumed to represent the same 
component as that in the calibration table. During an analysis or while a report is 
being generated, the amounts entered for each peak are used to calculate the 
amounts for the calculation procedure selected for the report. The type and 
amount of information required for creating a calibration table varies with the 
type of calculation procedure desired.

The following information is needed to create a calibration table:

• the retention/migration time for each calibration mixture component peak, 
and

• the amount of each component used in making the calibration mixture, 
expressed in consistent units.
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The peak sum table is provided for certain applications in the petrochemical and 
pharmaceutical industries. Typical applications are reporting of the total 
impurities or decomposition products, or summing the areas of uncalibrated 
peaks that lie within a specific range.

The peak sum table is similar to, but distinct from the standard calibration table. 
Like the calibration table, it is associated with the current method. Peak 
Summing is not designed for multi-signal data files.

The summed up areas from a specific time range can be expressed as amounts 
by using the calibration curve of a compound from the calibration table. It is also 
possible to use a fixed response factor.

NOTE You must create a calibration table for an analysis before you can create the 
peak sum table.
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Compound Groups

Compound groups allow individual compounds from the calibration table to be 
grouped for reporting purposes. A compound can only be part of one single 
group. You create the groups in the calibration table. The calibration table 
contains only a number for each group; in a separate box, you assign a group 
name to the number and add one or more compounds. It is possible to perform a 
group amount calibration, where a total amount is assigned to the group. The 
amounts of the compounds in the group are calculated according to the 
response contribution to the total response. A common example is a mix of 
isomers where only the total amount is known, but the detector response of the 
isomers is identical.
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Unknown Samples 

An unknown sample is a sample containing an unknown amount of the 
compound to be quantified.

To find out how much of the compound is in the unknown sample, you must:

• create a calibration curve for the compound,

• inject an aliquot of your unknown sample and run the analysis in exactly the 
same way as for the calibration sample,

• determine from the signal the response, which is the area or height of the 
peak due to the unknown amount of the compound, and

• use the calibration curve to calculate the amount of the compound in the 
unknown sample.

For example, if the area of peak in the unknown sample is 500, you can determine 
that the amount in the unknown is 5 ng/µl, by using the calibration curve shown 
in Figure 50 on page 185.

Figure 50 Signal from Unknown Sample and Calibration Curve

Response

Area = 500

Response

Time (min) Amount (ng/μl)

Response of
unknown
= 500

Amount of
unknown
= ng/μl
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Recalibration

What is Recalibration?
Recalibration is the process used when you want to update a level on a 
calibration curve. When you recalibrate you run another sample that contains the 
same calibration compounds as the original, and most important, the same 
amount of these compounds. When you run the calibration sample, you obtain 
updated response factors and retention/migration times. You may also choose 
to average the response factors over a number of calibration runs so that 
response factors are weighted equally.

Why Recalibrate?
Most calibrations have a limited lifetime, due to changes in chromatography. 
Recalibration is necessary to maintain the accuracy of the analysis. For example, 
assume you have created a calibration table for the compound caffeine which 
you use whenever you are required to quantify samples containing caffeine. At 
some point you will need to replace the column/capillary. Although the 
column/capillary is replaced with exactly the same type, it will not behave in 
exactly the same way as the previous column/capillary when you first created the 
calibration table for caffeine. Therefore, to ensure consistency you should 
recalibrate the levels in the calibration table before using the new 
column/capillary to analyze samples containing unknown amounts of caffeine. 
By doing this you are quantifying samples analyzed under the same system 
conditions.

Manual Recalibration
You can enter peak calibration information manually and normalize the 
calibration table using the Manual Setup option button in the New Calibration 
Table dialog box. Typically, a new calibration method is produced by running a 
calibration standard mixture, creating a calibration table, and entering the 
amounts of all calibrated peaks to obtain response factors. This approach is 
useful for some applications, such as found in the petrochemical industry, where 
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the same compounds have been analyzed for many years and the response 
factors for various compounds and detectors are readily available.

You create the calibration table manually by entering peaks and their response 
factors into the calibration table, recalibrating the method using a standard that 
contains at least one response reference peak, and selecting Delta% update.

To reference to a specific peak for the calculation of retention time ratios, you 
can set this peak as a retention time ratio reference peak. All peaks with the 
same RT Ratio Ref # are then referenced to this peak.

Recalibrations with Peak Summing
When a recalibration is performed, the retention/migration time ranges in the 
Peaksum Table of the method will be updated before the actual recalibration is 
done. Peak Sum recalibrations are performed in this way to ensure the delta is 
incorporated into the time calculations.

Ways to Recalibrate
Recalibration can be done in two ways using the ChemStation software. You can 
recalibrate interactively or automatically during a sequence of automated 
analyses. Interactive recalibration is when you directly go through the process of 
recalibration using the ChemStation software after injecting one or more 
calibration samples. Recalibration using a sequence is where you specify when 
the recalibration occurs, but the automation software does the recalibration. For 
more information refer to “Automatic Recalibration” on page 124.

For information on how to perform recalibration using the software, see the How 
To part of the help system.

Recalibration in Case of Missing Peaks
There are three ways to recalibrate unidentified peaks.
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No Recalibration

If a compound in the calibration table cannot be identified in the integration 
results, the calibration is aborted. If this occurs in a sequence, the sequence is 
also aborted.

Partial Recalibration

This feature allows the recalibration of only the identified peaks. If peaks are 
missing, the calibration is not aborted but the report and the run log are 
annotated that peaks are missing.

Recalibration of all Retention/Migration Times

This feature allows the retention/migration time recalibration of all identified and 
unidentified peaks. This is done by using the retention/migration times of the 
identified compounds. There is no update of response factors for unidentified 
peaks.

Recalibration in Batch Review
The recalibration methodology in Batch Review differs from the recalibration in 
the original sequence.

Clicking the Update Calibration button on the batch review toolbar causes the 
system to recalibrate with all calibration runs in the batch, creating a recalibrated 
calibration table. Clicking the Start button on the Batch Review toolbar will then 
recalculate amounts for each calibrated compound. The amounts for all samples 
will be calculated from the recalibrated calibration table.
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This chapter describes the concepts of Intelligent Reporting and Classic 
Reporting.
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What Is a Report?

A report can comprise quantitative and qualitative information of the sample you 
analyze. The report can be a hardcopy printout, a display on the screen or an 
electronic file. The report can include details of the peaks detected during the run 
and plots of the signals that were acquired.

Reports for different purposes

You can specify reports that serve different purposes during data acquisition and 
data review:

• The sequence summary report is defined in the Sequence Output tab of the 
Sequence Parameters dialog. This report is automatically created by 
ChemStation after completing a sequence acquisition or reprocessing a 
sequence.

• The single injection report is defined in the Specify Report dialog. This report is 
created for each single sample during a sequence acquisition or sequence 
reprocessing.

With Intelligent Reporting, you create templates for different report types, 
depending on the purpose of a report. For more information, see “Report 
Types” on page 197.

Report destination

A report can be sent to the following destinations:

• Screen

The report (including text and graphics) is displayed on the screen in the 
report preview window, from which it can be printed.

• Printer

The report comprising text and graphics is printed on the currently selected 
printer.

• File

The report is saved to a file, for example, an Adobe PDF file.
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Consideration of time zones

When you acquire data, you can see the injection date at different places in 
ChemStation and in your results. Depending on your local time zone and your 
regional settings in Windows, the displayed injection date may be adapted to the 
local time zone or date/time formats:

• in the logbook:

This date is always shown in the local time of where data was acquired. It is 
not adapted when viewed in a different time zone, nor when printed on 
reports.

• in the File Information window of the data file:

This date is always shown in the local time of where data was acquired. It is 
not adapted when viewed in a different time zone, nor when printed on 
reports.

• in reports:

This field is adapted to local time zone and time format of the region in the 
world where the report is generated.

If data acquisition and report generation occur in the same time zone, all dates 
(logbook, data file, report) show the same time, only in different printed formats.

If you generate reports in a different time zone than the one where the data has 
been acquired: The reports will show the time of acquisition converted to the 
local time of the region.

The following example demonstrates how the acquisition date would be 
displayed at the different places in ChemStation, depending on the local time 
zone and regional Windows settings.
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Reporting Results
Two types of reports are available:

• an uncalibrated report which does not correct for detector response, and

• a calibrated report that shows results corrected for the difference in the 
detector response to various components of the sample.

Uncalibrated Reports 

The uncalibrated reports include the Area% and Height% reports. These reports 
are mainly used in the preparation of calibrated reports. They may be of value as 
a final report if the amounts of compound required to produce a unit area or 
height response for the compounds of interest are similar.

Calibrated Reports 

Calibrated reports correct for the difference in the detector response to the 
reported compounds. One or more calibration samples containing known 
amounts of the reported compounds must be run under the same conditions 
used for the unknown sample. The integration data from these calibration 
sample(s) are used to prepare a calibration table. This is a list of 

Table 19 Example: Time representations for data acquired at Coordinated Universal Time (UTC) 2021-07-30 15:00:00

Event Acquisition 
date/time 
converted to local 
format

Time format in the 
local Windows 
settings

Displayed acquisition date

Data acquisition and report 
generation in New York
time zone UTC-05:00

2021-07-30 
10:00:00

MM/dd/yyyy 
HH:mm:ss tt

Logbook: 2021-07-30 10:00:00 AM
Data file: 2021-07-30 10:00:00 AM
Classic report: 07/30/2021 10:00:00 AM
Intelligent report: 2021-07-30 10:00:00+05:00

Report regeneration in Zurich 
(UTC+01:00).

2021-07-30 
16:00:00

dd.MM.yyyy 
HH:mm:ss

Logbook: 2021-07-30 10:00:00 AM
Data file: 2021-07-30 10:00:00 AM
Classic report: 30.07.2021 16:00:00
Intelligent report: 2021-07-30 16:00:00+01:00

Second report generation in 
New York (UTC-05:00)

2021-07-30 
10:00:00

yyyy-MM-dd 
HH:mm:ss

Logbook: 2021-07-30 10:00:00 AM
Data file: 2021-07-30 10:00:00 AM
Classic report: 2021-07-30 10:00:00
Intelligent report: 2021-07-30 10:00:00 +05:00
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retention/migration times, amounts and responses which is used in the 
generation of the report. The calibrated reports are based on two calibration 
procedures called external standard and internal standard.

External Standard Report 

The ESTD report lists the results with the units of your choice or with each 
compound as a percentage of all the compounds present. One amount is used 
for all compounds in the calibration table and for the sample amount. The 
external standard procedure requires that the relative injected volume of both the 
calibration and unknown samples must be known accurately. The reliability of 
the external standard report is limited by the reproducibility of the injection and 
any other factors that might change from sample to sample.

Internal Standard Report 

The limitations of the external standard procedure can be overcome by using the 
internal standard approach. An accurately known amount (not necessarily the 
same amount) of the internal standard is added to both the calibration sample(s) 
and unknown sample. The response of each compound of interest is divided by 
the response of the internal standard to give a response ratio. The calibration 
curves are a plot of this response ratio versus the amount ratio and this 
information is used in the calculation of the reported results. In this way 
inadvertent errors in injection volume or slight changes in the 
chromatographic/electropherographic system that affect all compounds 
similarly are cancelled out. The ISTD report lists the results with units of your 
choice.

Control Charts Report

The Control Charts Report tracks a single result from multiple runs for a specific 
calibrated compound. The Control Chart feature is installed after ChemStation is 
operational. Methods that use this feature pass the tracked result to a Microsoft 
Excel work sheet after each run. Excel is then used to print the report.

Quantitative Results
The report type is identified by the name of the calculation method used to 
prepare it, for example, an ISTD report. Each type is briefly described below.

Area% provides the simplest report and requires no calibration data since no 
correction is made for the difference in detector response of sample 
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components. The Area% report is particularly useful in developing a calibration 
table for use with the other report options. This report is suitable for analyses in 
which the difference in detector response of the components is not significant.

Height% gives a report similar to the Area% report except that peak height is used 
for the calculations instead of peak area.

Norm% gives a report in which each component is reported as an amount 
percentage of all the components present.

ESTD produces a report of the actual amount of each substance. Amounts are 
calculated using a previously established calibration table. The use of an external 
standard requires that the injected volume of the calibration mixture be known. 

ESTD% produces a report of the relative amount of each substance as a 
percentage of the injected sample amount. Amounts are calculated using a 
previously established calibration table. The use of an external standard requires 
that the injected volume of the calibration mixture be known.

ISTD produces a report of the actual amount of each substance. Amounts are 
calculated using a previously established calibration curve. The use of an internal 
standard in both the sample and the calibration mixture eliminates the need to 
know and control the volume of the sample injected. This also corrects for any 
variation in instrument performance between runs.

ISTD% produces a report of the relative amount of each substance as a 
percentage of the injected sample amount. The use of an internal standard in 
both the sample and the calibration mixture eliminates the need to know and 
control the volume of sample injected. This also corrects for any variation in 
instrument performance between runs.
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Classic and Intelligent Reporting

With ChemStation, you can choose the type of reporting you want to use: Classic 
ChemStation Reporting that is unchanged compared to ChemStation B reporting, 
or Intelligent Reporting (which is shared with OpenLab CDS).

The following sections describe the two types of reporting.

Consequences of Activating Intelligent Reporting
If you want to use Intelligent Reporting, you need to enable Intelligent Reporting 
in the Instrument Configuration in the OpenLab Control Panel.

Activating Intelligent Reporting has the following consequences for ChemStation:

• The Report Layout view shows the Report Template Editor for Intelligent 
Reporting. Instead of classic report templates, you can now edit report 
templates for Intelligent Reporting in this view.

• The Review view is visible.

• In the Sequence Parameters and Specify Report dialogs, you can choose 
between Classic and Intelligent Reporting. You can still use the settings for 
Classic Reporting and use "classic" report templates that already exist for the 
instrument.
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Advantages of Intelligent Reporting
Intelligent Reporting offers you the following advantages:

• You can use the Review view.

• Most of the functionality that is available in different settings and several 
dialogs for Classic Reporting is now part of the report templates. You can 
create or edit report templates using the Report Layout view, which contains 
the new Report Template Editor for Intelligent Reporting. The Report 
Template Editor offers several powerful functions:

• You can access all result data generated by ChemStation by selecting the 
corresponding data field.

• You can create your own expressions in order to make calculations with 
the data fields. You can use any valid Microsoft Visual Basic expression.

• You can create expressions where you make calculations with the 
ChemStation Custom Fields.

• Result Flagging: You can provide expressions to highlight specific results 
depending on their value.

• Snippets: The Report Template Editor provides preconfigured report items, 
also referred to as snippets, that you can insert into your report template 
via drag and drop.

• You can use the Report Template Documentation Tool to create descriptions 
of your report templates.

• You can report the following values as defined by European Pharmacopeia 
(the peak-to-valley ratio is also available with Classic Reporting; for details on 
the required fields, refer to the Reference Guide): 

• Signal-to-noise ratio

• Relative retention

• Relative retention time
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Limitations of Intelligent Reporting
The reports generated with Intelligent Reporting are always based on the raw 
signals. Modified signals, where blank subtraction, smoothing, signal alignment, 
or background subtraction have been applied, cannot be reported.

Report Template Editor (RTE) for Intelligent 
Reporting

Report Types

You can create different types of reports. Depending on the report type, different 
data fields are available in a report template, and the report items are grouped 
differently.

The following report types are available

• Single Injection

The generated report shows the report items from the template separately for 
each injection in the current data scope. You can show the data per injection, 
but you cannot compare results from different injections in one table or 
matrix.

• Single Sequence Summary

The generated report shows the report items from the template separately for 
each of the sequences in the current data scope. You can compare results 
from different injections in one table or matrix, but not the results from 
different sequences.

• Cross-Sequence Summary

With this report type, the data is not automatically grouped. Therefore, you 
must pay more attention to the grouping of your report items, but in return you 
can create report items that compare data from different sequences.

Template Format

All report templates are based on the Report Definition Language (RDL), which is 
a standardized XML format provided by Microsoft.

RTE provides an easy-to-use interface that helps you create report templates in a 
few steps. It supports all types of report items and most of the respective 
configuration options.
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Data Fields

You can access all result data generated by ChemStation during an acquisition. 
For each value you can select the respective data field in which the value is 
stored. You can arrange the data fields in the report template according to your 
requirements. The available data fields are arranged in the following categories:

• Sequence

• Sample

• Injection

• Signal

• Compound

• Peak

• Calibration Curve

• Instrument

• File

• Project

Report Items

You can add various report items to a report template, depending on your 
requirements. For each report item you can configure several properties such as 
the font format, background color, expressions, etc. The following report items 
are available:

• Text Fields

• Data Fields

• Tables

• Matrices

• Composite Groups

• Images

• Chromatograms

• Calibration curves

• Spectra

• Charts

• Method Information
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Snippets

The Report Template Editor provides snippets, multiple preconfigured report 
items or groups of report items, which you can insert into your report template 
via drag and drop.

These snippets are, for example, preconfigured tables for compound results or 
system suitability, chromatograms for a single signal plot or multi signal plot, or 
control charts for calibration accuracy or retention time stability. You can use the 
snippets as a starting point and adjust them according to your requirements.

Custom Calculation

In the Report Template Editor, you can either display the values of the data fields 
as they were generated by ChemStation, or you can calculate new values for 
different purposes. You can create expressions using the existing data fields and 
also using the custom fields.

You can store the values as variables and access these variables from a 
subsequent report item in the template.

The Report Template Editor provides an Expression Editor that helps you to 
create valid expressions. All expressions are based on Microsoft Visual Basic.

Conditional Formatting

You can configure certain properties of a field or cell, depending on the values 
resulting from the expression. For example, if the compound amount is shown, 
you can create a condition for a red background if the amount exceeds a certain 
value.

Demo Data

When you develop a new report template in the Report Layout view, ChemStation 
provides the demo data that is shown in the Report Template Editor when you 
edit or preview a template. The demo data corresponds to the data set (sequence 
or single runs) that is currently selected in the Navigation Table of the Data 
Analysis view. If you develop a template for a sequence summary report, you 
need to load a sequence in the Data Analysis view and select a subset of 
samples. If you develop a template for a single injection report, it is sufficient if 
you select only one sample in the Data Analysis view.
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Storage of Report Templates
ChemStation provides a number of predefined report templates. These default 
templates are located in the public documents folder in the REPSTYLE directory.

By default, the REPSTYLE directory is located under C:\Users\Public\
Documents\ChemStation. This path is defined during installation. Use 
ChemStation menu File >Open Windows Explorer... to open the path in your 
system (for example, C:\Users\Public\Documents\ChemStation\1). Alternatively, 
use the shortcut to Instrument Data in the Start menu.

For sequences, the report templates used for sequence summary reports and 
single injection reports are located in the result set on the same level as the 
sequence methods. No report templates are stored on the data file level of a 
sequence.

Browse Templates Dialog

If you browse for report templates in the Sequence Parameters dialog or in the 
Specify Report dialog, you can synchronize the templates in the Default 
Templates directory and in the result set.
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Figure 51 Browse for Report Templates in Result Set dialog

1 On the left side, you see the templates in the Default Templates directory (defined during 
installation).

2 On the right side, you see the templates in the currently loaded result set.

3 For each template, you see the date when it was last saved. The tooltip of the date shows the 
template's last history entry.

4 Templates that are common for the result set and the Default Methods directory are shown 
in bold. The templates are matched only by name.

5 You can copy templates from the Default Templates Directory to the result set either by using 
Drag&Drop or by using the > button.
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Storage of Generated Reports

File Naming for Single Injection Reports

When you provide a file name for the single injection report in the Specify Report 
dialog, you can use the following tokens:

• <Date> current date

• <Time> current time

• <SeqName> sequence file name (will be “_” for a single sample)

• <ResultSet> name of result set (will be “_” for a single sample)

• <SampleName> sample name

• <LimsID> LimsID

• <InjDateTime> injection date & time

• <DataFile> data file name

• <SampleLoc> sample location

File Naming for Sequence Summary Reports

When you provide a file name for the sequence summary report in the Sequence 
Output tab of the Sequence Parameters dialog, you can use the following tokens:

• <Date> current date

• <Time> current time

• <SeqName> sequence file name

• <ResultSet> name of result set

• <LimsID> LimsID

Report Templates in Central Data Storage
If you use a central data storage system, report templates are treated as a 
separate document type. You can upload templates to central data storage, 
download templates from central data storage, or update all local report 
templates with the latest version from central data storage.
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Reporting Custom Field Values
The values of the custom fields attached to a certain sample according to its 
acquisition method can be added to the report. Sample custom fields are listed at 
the end of the report header that contains the general sample information. 
Compound custom fields appear at the end of the report.

Report Styles 
You choose to add a signal to any of the classic report styles by checking the 
appropriate box in the Specify Report dialog box.

The following report styles are available:

• None - No text will be reported. The chromatogram will be reported only if the 
Add Chromatogram Output option is selected.

• Short - Comprises quantitative text results.

• Detail - Comprises header, quantitative results, and calibration curves. The 
header is stored in a file called RPTHEAD.TXT in the method directory. You 
can change the header using a text editor to include a method specific text.

• Header + Short - Comprises file header and quantitative text results. The 
header is stored in a file called RPTHEAD.TXT in the method directory. You 
can change the header using a text editor to include a method specific text.

• GLP + Short - Comprises header, sample information, instrument conditions, 
logbook, signal, and quantitative results. The header is stored in a file called 
RPTHEAD.TXT in the method directory. You can change the header using a 
text editor to include a method specific text.

• GLP + Detail - Comprises header, sample information, instrument conditions, 
logbook, signal, quantitative results, and calibration curves. The header is 
stored in a file called RPTHEAD.TXT in the method directory. You can change 
the header using a text editor to include a method specific text.

• Full - Comprises header, sample information, instrument conditions, logbook, 
signals, and quantitative results. The header is stored in a file called 
RPTHEAD.TXT in the method directory. You can change the header using a 
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text editor to include a method specific text. For data files containing spectra 
the apex spectrum for each peak is also reported.

• Performance - Produces a report according to the limits specified in the Edit 
Performance Limits dialog box of the System Suitability menu.

For uncalibrated methods, the report parameters include the peak number, 
retention/migration time, peak area, peak height, signal description, true 
half-height peak-width (please refer to True Peak Width Wx [min] in the 
Reference Guide), symmetry, k’, efficiency (plates) and resolution for each 
peak.

For calibrated methods, the report parameters include the peak number, 
retention/migration time, compound name, amount, signal description, true 
half-height peak-width, symmetry, k’, efficiency (plates) and resolution for 
each peak.

The half-height peak calculation is not the same as the more complex peak 
width formula used by the integrator. The values of efficiency and resolution 
are based on this calculated peak width. The report header consists of all 
method relevant information, including instrument, column/capillary, sample, 
and acquisition parameters. The signal is also plotted.

• Performance + Noise- Combines the Performance report style with the noise 
calculations for the noise ranges defined in the Edit Noise Range dialog box of 
the System Suitability menu. In addition, the noise, given as six times the 
standard deviation, as peak-to-peak, and as ASTM noise.The drift and wander 
is also determined.

• Performance + Extended- Produces an extended report with all the parameters 
from the peak performance calculations and individual plots of each peak. 
The plots include the baseline, the tangents, and the peak widths at defined 
heights. This report type includes only calibrated peaks.

In addition to the parameters printed for the Performance report style, more 
Peak Performance Parameters are determined for calibrated peaks: the peak 
start and end peak times, skew, excess, peak width, USP tailing factor, time 
interval between data points, number of data points, statistical moments, 
plates, plates per meter, selectivity and resolution of each peak are printed. 
The peak width, plates, plates per meter, selectivity, and resolution are 
calculated by the true half height, 5 sigma, tangent and tailing methods 
(please refer to Performance Test Definitions in the Reference Guide for 
details).

The report header consists of all method relevant information such as 
instrument, column/capillary, sample and acquisition parameters and a plot 
of the signal. For a complete list of the peak performance parameter 
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algorithms refer to Performance Test Definitions in the Reference Guide for 
details.

The spectral report styles (Short + Spectrum, Detail + Spectrum, Performance + 
Library Search) are described in Understanding Your Spectra Module.

Adding a Customized Report to Report Styles

You can add a custom report template that you have created in the Report 
Layout view of ChemStation to the list of available report styles.

Other Report Style Parameters

Summed Peaks Table

When the report is generated, ChemStation uses the peak sum table to produce a 
peak sum report that is printed after the standard report calculations.

Report Layout for Uncalibrated Peaks

To change the report layout for uncalibrated peaks, choose one of the following 
in the Specify Report dialog box.

• Separately to report the uncalibrated peaks in a separate table if sorting by 
retention/migration time is selected, or separate tables if sorting by signal is 
selected.

• With Calibrated Peaks to report the uncalibrated peaks together with the 
calibrated peaks.

• Do Not Report to suppress the reporting of uncalibrated peaks.

NOTE All reports apart from the performance reports list the peakwidths calculated 
with a more complex formula by the integrator (for details on the peakWidth 
calculation please refer to Peak Width in the Reference Guide).
ChemStation Concepts and Workflows 205



8 Reporting
Classic Reporting
Sequence Summary Reporting

Overview

ChemStation can print a variety of standard reports for individual sample 
analyses. Sequence summary reporting is an additional way of reporting, that 
allows you to calculate and report parameters across a number of different 
analyses. It is useful, for example, to test the stability of an instrument or the 
robustness of a new method.

A sequence summary report may include:

• a title page,

• instrument configuration, including the revision numbers of the instrument 
and details of the analytical column/capillary being used,

• sequence table listings which describe what the automated sequence of 
analyses should have done,

• logbook descriptions of what the sequence actually did and any unexpected 
events which occurred during the sequence,

• method listings,

• individual reports on each sample,

• statistics on the analyses based on selected criteria—statistics are calculated 
only for calibrated compounds, and

• a table of contents with page number references to the detailed sections of 
the report.

Setting up a Sequence Summary Report

When setting up a sequence summary report, you can select any combination of 
the following nine categories by activating the appropriate check boxes and, 
where appropriate, selecting a report style from the template selections. Each 
template specifies the contents and layout of that particular section of the whole 
sequence summary report.

You can choose one of the following sequence summary report styles:

One Page Header

The GLP template prints GLP in large letters as a title page for the following 
report. It also includes the date and a place for a signature.
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Configuration

Select Configuration if you want to include the instrument configuration and 
analytical column/capillary specifications in the report.

Sequence Table

Select Sequence Table to include a list of the samples, sample quantification 
parameters and method names in the report. This list shows what the system 
should have run.

Logbook

Select Logbook for a listing of the analyses the system ran, including instrument 
conditions and any unusual events that occurred while the samples were being 
analyzed.

Methods

Select Methods to list all the analytical methods used in the series of automated 
analyses.

Analysis Reports

Select Analysis Reports to get individual analysis reports according to the report 
style set up for the method.

Individual analytical reports may be printed after each analysis according to the 
report style specified for the method in question, in addition to the report sections 
specified in Sequence Summary Reporting. See "Sequence Output" below.

Statistics for Calibrated and Sample Runs

Selecting the Statistics cal. runs will produce statistical trend analyses for 
calibration samples. Selecting the Statistics sample runs will produce statistical 
trend analyses for sample (unknown) analyses. Both selections have Standard 
Statistic and Extended Statistic template styles. Extended Statistics prints the 
statistical trends of the analyses as graphs, whereas the Standard Statistics 
selection prints only text. The selections that you make in the Items and Limits for 
Extended Statistics dialog box are used only when you choose the Extended 
Statistic option(s) in the Sequence Summary Parameters dialog box.
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If you choose the Standard Statistic option(s) in the Sequence Summary 
Parameters dialog box, then the statistics reported are:

• retention/migration time,

• area,

• height,

• amount,

• peak width (based on the report style, see “Report Styles” on page 203)

• symmetry.

The statistic calculation does not distinguish between different calibration levels 
in a sequence that uses multilevel calibration methods. This means that the 
concentration-dependent items, for example, Area, Height, Amount (see the 
dialog box for Items and Limits for Extended Statistics) are all taken together, 
regardless of the calibration level. The Statistics for Calibration Runs values are 
therefore not useful for multilevel calibration methods in sequences.

Summary

The Summary selection will print an overview of the series of samples analyzed 
and the methods used. If the Summary choice is selected together with other 
Sequence Summary selections, page numbers referring to the other parts of the 
sequence summary report are included. Two Summary styles are available:

The Sample Summary tabulates details of the sample analyses run in the 
sequence, with some sample information such as the sample name, data file 
name, method and vial number.

The Compound Summary tabulates the sample analyses with basic quantification 
results for each calibrated compound, or each peak, depending on the type of 
report specified in the method.

Sequence Output

In the Sequence Output dialog box you can define where the sequence summary 
report should be printed.

Select Report to file and enter a file name to print the report to the specified file. 
The default setting is that data are saved to the file GLPrprt.txt. In GC systems 
with dual injection the data are saved in GLPrptF.txt and GLPrptB.txt for the front 
injector and back injector respectively.

Select Report to PDF to save the report as a PDF document. The report is saved in 
the sequence folder with the name GLPrprt.PDF
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Select Report to HTM to print the report in HTML format. The report is saved into 
an HTM directory in the data subdirectory or sequence container directory. The 
HTML report consists of an index file (index.htm) and at least two other files, a 
contents file (contents.htm) and a GIF (Graphics Interchange Format) file for 
each page of the report (e.g. page1.gif). To view the html report, open the index 
file using your browser.

Select Report to printer to print the report on the system’s printer. Print individual 
reports for each run also activates printing of sample reports after each analysis. 
These reports are printed in addition to the reports specified for the sequence 
summary report which are produced at the end of the entire sequence. You can 
specify a new destination for these reports in the Sequence Output dialog or use 
the destination specified in the individual methods.

Report File Formats 
A report can be saved in different formats. Each format has a specific extension. 
It is possible to select more than one format for a report.

.TXT The report text is printed as a UNICODE text file.

.EMF Each report graphic (signal or calibration curve) is saved in a Microsoft Windows 
metafile (WMF). Several .WMF files for one report are possible. The generated file 
format adheres to the Microsoft standard metafile format as defined in the 
Windows software development documentation. These files are compatible with 
the Aldus Placeable Metafile (APM) format used by a number of proprietary 
software packages.

.DIF The tabular report data is saved in Data Interchange Format (DIF). This format is 
accepted by spreadsheet programs, for example, Microsoft Windows EXCEL. 
Independent from the report style selected, only the information contained in the 
report style Short will be saved.

.CSV The report is in Comma Separated Values (CSV) format. This is a very simple 
format for tabular data that is accepted by many spreadsheet programs and 
databases. Independent from the report style selected, only the information 
contained in the report style “Short” will be saved.

NOTE DIF files are not generated for performance reports.
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There can be several .DIF and .CSV files for a single report. For each report block, 
the first file, for example, REPORT00.CSV, contains the report header 
information. Subsequent files contain the tabular results.

If the results are sorted by retention/migration time, only one file is required for 
the complete table, for example, REPORT01.CSV.

If the results are sorted by signal, a separate table is required for each signal. In 
this case, the files are named Report01.CSV through ReportNN.CSV, where NN is 
the number of the signal.

.XLSX The report is exported to a Microsoft Excel spreadsheet in (.XLSX ) format. The 
data generally requires additional processing.

.PDF The report is printed to a .pdf file. While any ChemStation session is running, a 
ChemStation PDF printer will be listed in the Start Menu/Device and Printers. The 
option Unique pdf file name allows you to store the .pdf reports independent of 
the reports, with file names <sequence_container_name>_<data_file_name>.pdf

NOTE CSV files are not generated for performance reports.
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This chapter is relevant only if you use ChemStation to control CE instruments.
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CE Agilent ChemStation Specific Functions in 
Method and Run Control View

Vial Table

The Vial Table is a table that associates vials in the vial tray with samples, and, 
more importantly, with task specific vials such as buffers, flush vial, clean tubes 
vial, and the waste. The Vial Table is linked to the Sequence Table. When a 
sequence is loaded, the information from the Sequence Table is copied into the 
Vial Table. However, Vial Table entries are not transferred back into the Sequence 
Table. The Vial Table Advanced Settings dialog box is displayed when you choose 
the Advanced button in the Vial Table. It allows you to enable warnings of 
conflicts between the Vial Table and the method or sequence and the use of 
symbolic names. You must select Enable vial table checks and warnings to check 
for conflicts between the Vial Table and the method and sequence.

When a method or a sequence is loaded, a consistency check is made between 
the vial allocations in the Vial Table and those in the method or sequence. If there 
are any vial conflicts they can easily be resolved by using the Conflict tables.

NOTE The Vial Table functionality is available in the online ChemStation session only.

NOTE Position 49 in the vial tray is used for the needle wash vial and position 50 is left 
empty to allow the vial lift to return. These positions are not available in the Vial 
Table.
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The Used in column of the Vial Table enables the usage of the vial to be specified. 
There are five valid entries for the Used in fields:

Don’t Care No consistency check is made

Method The vial is referenced in the method

Sequence The vial is referenced in the Sequence Table

System This is a special vial belonging to the system configuration. The Name must be 
one of the following symbolic names:

• @INLET the inlet vial

• @OUTLET the outlet vial

• @FLUSH the flush vial

• @WASTE the waste vial

• @clean tubes the vial used for cleaning the replenishment tubes

• @USER X (where as X can be 1 to 10) the sequence placeholder

This option allows the specification of individual vial numbers for the 
symbolic names used in the method. This enables the user to specify 
different vials for Inlet Home, Outlet Home, Replenishment, Preconditioning, 
Postconditioning, etc. for each line in the sequence.

Not Used There is no vial in this position

Method Conflict Table
The Method Conflict Table is displayed when you load a method that has vials 
defined that conflict with the vials defined in the Vial Table. The Method Conflict 
Table has two sides; the left half contains an image of the Vial Table; the right half 
shows the conflicting vials.

To resolve the conflicts you can select to either replace (single arrow) or to move 
the vial from the method to the next free position in the Vial Table (double arrow). 
This can be done for each conflicting vial in the table.

When user-defined vials (with symbolic names @User1, @User2, etc.) are used 
the conflict test cannot be performed on these vials, because without the 
sequence information it cannot be decided whether a conflict exists or not.
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Sequence Conflict Table
The Sequence Conflict Table is displayed when you set up or load a sequence that 
has vials defined that conflict with the vials defined in the Vial Table. The 
Sequence Conflict Table has two sides; the left half contains an image of the Vial 
Table; the right half shows the conflicting vials.

To resolve the conflicts you can select to overwrite the Vial Table information 
with the information from the Sequence Table, or if the conflict is caused by a 
system entry it cannot be overwritten. You can select to close the Sequence 
Conflict Table without resolving the conflicts.

When user-defined vials (in the columns User1, User2, etc.) are used the conflict 
test cannot be performed on these vials, because without the method 
information it cannot be decided whether a conflict exists or not.
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Peak Top Type
Peak Top Type

Unlike LC, GC, or MS peaks, it is quite normal for CE peaks to be asymmetrical. 
Because of this, is very important to have the ability to select integration 
parameters that will yield the highest level of accuracy and reproducibility in your 
quantitation results.

The following peak top types are available when selecting Peak Top Type in the 
Integration drop-down menu:

Highest Point

• select when the peak is triangular, and

• when you work with different concentrations

Parabolic Interpolation

• use for tailing, unseparated peaks

Center of Gravity

• provides more accurate calculations with triangular shaped peaks

• samples with similar concentrations

Gauss Fit

• use for symmetric peaks
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Calibration Types

Standard Calibration is based on peak area or peak height. When you select 
Standard Calibration you have the option to Calculate Signals Separately or 
Calculate with Corrected Areas.

Calculate Signals Separately is selected when you want to ensure that, in the 
calculation of Norm% reports, the amount percent of separately reported signals 
add up to 100% for each signal. When Calculate signals separately is deselected, 
the amount percent of all signals add up to 100%. Selecting Calculate signals 
separately is a prerequisite for sorting by signal in the calibration table.

Select Calculate with Corrected Areas to make a correction to the peak area based 
on the migration time. In this mode, the area is divided by the migration time 
which can improve reproducibility in quantitative analysis when migration times 
are unstable.

In addition to the Standard Calibration, there are 3 capillary electrophoresis 
specific calibrations that are migration time based one signal.

The following calibrations types are available in the drop-down list for your 
Calibration Table:

• Standard Calibration

• Protein Molecular Weight Calibration

• DNA Base-Pair Calibration

• Capillary Isoelectric Focusing Calibration

For more information on the capillary electrophoresis specific calibrations, refer 
to OpenLab ChemStation Data Analysis Reference (CDS_CS_Reference.pdf).

Migration Time Based Calibrations

Using Migration Time Based Calibrations in a Sequence

Migration time-based calibrations and recalibrations can be included in a 
sequence, but only explicit calibrations and cyclic recalibrations are supported; 
bracketed recalibration is not supported. There is no Sequence Summary report 
with migration time-based calibrations.
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Report Styles for Migration Time Based Calibrations

The report styles available for migration time based calibrations are limited to 
Short (quantitative text results) and Full (header, sample information, instrument 
conditions, logbook, quantitative results and peak purity plot).

Calibration using Mobility Correction
Slight changes in buffer composition, run temperature or viscosity, as well as 
adsorption to the capillary wall, can influence the Electro Osmotic Flow (EOF) and 
cause it to be unstable. The resulting change in the EOF can create a rather high 
standard deviation of migration times. Corrections for mobility can significantly 
reduce the effect of run-to-run migration time shifts by monitoring the migration 
time of a mobility reference peak and in turn significantly increasing the 
migration time reproducibility.

The mobility reference peak should be chosen with the following priorities:

• Select peak with the highest signal

• Select the most isolated peak

• The EOF marker or internal standard can also be used as the mobility 
reference peak

• Enlarge the search window to always find the mobility reference peak

• If several peaks fall in the search window, the peak with the highest signal is 
automatically chosen as the mobility reference peak.

There are two mobility correction types available:

Effective
Mobility

Correction

Effective Mobility Correction uses the effective mobilities of all peaks and requires 
the availability of the voltage ramp data together with the electropherogram. In 
addition, working with effective mobility correction allows the true effective 
mobilities for all sample components to be determined.

Relative
Mobility

Correction

Relative Mobility Correction can operate in the absence of voltage data and would 
then assume a constant voltage for all measurements.
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CE-MS

Background Subtraction
When you select the Subtract Background (BSB) menu item, the most recently 
selected mass spectrum is subtracted from each point in the current 
electropherogram. The resulting data is saved in the same directory and with the 
same name as the original data file; however, the file extension is changed to 
.BSB.

The new data file becomes the current data file and the background subtracted 
electropherogram is displayed. A record of the number of background 
subtractions that have been performed is kept in the Operator item of the data 
file header.

If you view a tabular listing of BSB data, you may observe differences due to the 
precision of data representation.

NOTE The HELP text files in the LC/MS refer only to LC parameters and not CE. Some 
features that are available in the LC/MS software are either not available or not 
applicable to CE/MS applications but are used in LC. The function peak matching 
is not applicable for CE-MS and is therefore not active. In CE-MS, UV and MS 
detection occurs at different effective lengths of the separation capillary. 
Because of the different resolution at different effective lengths, peak matching 
is not possible.
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Method Subdirectories for different CE Modes

Methods in CE are dependent on CE mode selected. Therefore they are stored in 
different subdirectories in the Method subdirectory:

CE Stores methods for CE mode

CEC Stores methods for the CEC mode

CEp Stores methods for the CE plus pressure mode

CEMS Stores methods for the CE MS mode.

CEMSp Stores methods for the CE MS plus pressure mode.
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In This Book
In This Book

This guide describes various concepts of Agilent OpenLab ChemStation. 
It is intended to increase your understanding of how ChemStation works. 
It contains information on the following subjects:

• Basic Concepts

• Data Acquisition

• Automation/Sequences

• Run Control

• Data Analysis and Review Concepts

• Calibration

• Reporting

• CE specific Concepts and Functions
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